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LUCRAREA 1 

INTERFAŢA UTILIZATOR.  
DESCRIEREA FUNCŢIILOR ELEMENTELOR 
FERESTREI DE LUCRU 

 
 
 1.1. INTERFAŢA UTILIZATOR 
 
 Pachetele de programe pentru aplicaţii grafice pot fi 
clasificate astfel: biblioteci grafice, editoare grafice, programe grafice 
specializate, desktop publishing etc. Bibliotecile grafice sunt colecţii 
de rutine cu funcţii grafice destinate creării şi prelucrării obiectelor 
grafice prin apelul lor în programe scrise în diverse limbaje de 
programare de nivel înalt. Editoarele grafice au fost create pentru 
aplicaţii grafice inginereşti în domeniul proiectării asistate de 
calculator. Programele grafice specializate sunt destinate rezolvării 
problemelor din anumite domenii prin utilizarea unui limbaj 
adecvat domeniului. Realizarea digitală a publicaţiilor se face cu 
ajutorul programelor de tipul desktop publishing. 
 Editoarele grafice au următoarele funcţii principale:            
(1) crearea, deschiderea şi închiderea fişierelor ce conţin obiecte 
grafice; (2) alegerea mediului de lucru; (3) operaţii cu obiecte grafice, 
cum ar fi localizarea acestora, selectarea, modificarea, copierea, 
mutarea etc; (3) stabilirea valorilor diferitelor atribute şi a modului 
de vizualizare a obiectelor grafice. 

În urmă cu aproximativ 15 ani interfaţa programelor 
destinate calculatoarelor personale a suferit o transformare majoră 
prin utilizarea elementelor grafice în comunicarea utilizator-
computer. Uşurinţa în comunicare şi îmbunătăţirea dialogului a 
impulsionat dezvoltarea actuală şi apariţia elementelor 
standardizate ale interfeţelor grafice (GUI-Graphical User Interface), 
astfel încât în momentul actual marea majoritate a pachetelor de 
programe utilizează o astfel de interfaţă. 
 Interfeţele grafice utilizează spaţiul bidimensional al desktop-
ului (ecranul monitorului) calculatorului pentru afişarea de obiecte 
grafice (ferestre, butoane, casete de validare, liste, meniuri, câmpuri 
etc.) care au o funcţie binedefinită, ce facilitează transmiterea de 
comenzi sistemului. Fiecare din aceste obiecte grafice ocupă un 
anumit spaţiu al ecranului, prin activarea sa fiind declanşată 
afişarea unei noi ferestre. 
 AutoCAD-ul  este un program CAD (Computer Aided Design – 
proiectare asistată de calculator) utilizat în reprezentarea planelor 
grafice 2D şi 3D (două dimensiuni X,Y şi trei dimensiuni X,Y,Z) 
dezvoltat şi comercializat de firma Autodesk. 
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 AutoCAD este, în primul rând, un program pentru a crea 
desene tehnice (desen 2D); desenele în care măsurătorile şi precizia 
sunt importante, pentru că aceste tipuri de desene sunt folosite 
pentru a executia diferitelor piese. Desenele create cu AutoCAD 
trebuie să respecte standardele deja in vigoare ce se folosesc si la 
desenele facute direct pe hartie cu creionul. Investiţiile iniţiale 
pentru a utiliza AutoCAD sunt  cu siguranţă mai mari decât 
investiţiile necesare pentru a folosi creion şi hârtie, de asemenea şi 
curba de învăţare de invatare este mult mai abruptă. Insă motivele 
cheie pentru utilizarea AutoCAD, mai degrabă decât creionul şi 
hârtia sunt: 

1. Precizia: Cu ajutorul AutoCAD-ului, crearea de linii, cercuri, 
precum şi alte forme cu dimensiuni exacte si corecte este mai 
uşoara decât cu creionul. 

2. Posibilitatea de modificare ulterioara: Desene sunt mult mai 
uşor de modificat pe ecranul computerului decât pe hârtie. 
Modificările în programele CAD sunt mult mai curate, de 
asemenea. 

3. Eficienta: Crearea diverselor tipuri de desene este mai rapidă 
cu un program de CAD; mai ales desene care implică 
repetarea, cum ar fi gauri in piesa ce se repeta la o anumita 
distanta.  

4. Utilizarea pe masini cu comanda numerica ce executa cu 
acuratete repere folosind coordonatele salvate cu ajutorul 
fisierelor DWG specifice Autocad-ului. 

 La activarea pictogramei corespunzătoare programului, în 
concordanţă cu setările implicite de configurare, pe ecranul 
monitorului va fi afişată caseta de dialog Startup (Figura 1.1). 
Afişarea elementelor interfeţei imediat după lansarea în execuţie a 
programului poate fi modificată prin schimbarea setărilor implicite 
ale meniului Options aflat în lista opţiunilor meniului derulant 
Tools. 
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Figura 1.1. Caseta de dialog Startup: prezintă patru butoane de comutare, fiecare 
corespunzând unei liste de opţiuni care permite configurarea modului de lucru. 

 
 După apăsarea butonului OK al casetei Startup pe ecranul 
monitorului se afişează interfaţa grafică a programului (Figura 1.2), 
care este divizată în mai multe zone cu funcţii diferite. Astfel se pot 
distinge: (1) linia de stare, (2) linia de comandă, (3) bare de defilare 
orizontală şi verticală, (4) fereastra de lucru (desenare), (5) bare cu 
instrumente orizontale şi verticale, (6) bara cu meniul principal,      
(7) bara pentru proprietăţi obiecte grafice, (8) butoane de comandă 
(minimizare, maximizare, închidere fereastră). 
 Din succinta descriere a elementelor interfeţei utilizator se 
observă că aceasta are în componenţă toate elementele cunoscute 
ale interfeţelor grafice, dar adaptate specificului aplicaţiei. 
 Realizarea operaţiilor necesare creării, prelucrării şi stocării 
obiectelor grafice se face prin intermediul comenzilor, care pot fi de 
setare, de desenare, de editare, de salvare a fişierelor. Comenzile pot 
fi activate de la: (1) tastatură prin linii de comandă (în mod text),   
(2) din meniul principal (meniu derulant, în cascadă), (3) prin 
activarea icon-ului corespunzător din barele de instrumente. 

Denumirea casetei de dialog 

Butoane de comutare 

Listă de 
opţiuni 

Butoane de 
comandă 

Texte explicative 
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Figura 1.2. Elementele interfaţei grafice 

 
 

1.2. CONFIGURAREA PROGRAMULUI. DESCHIDEREA  
       UNEI NOI SESIUNI DE LUCRU 
 
Programul are o serie de setări implicite (predefinite) pentru a 

începe un nou desen, care sunt activate la lansarea în execuţie a 
programului. Caseta de dialog Startup face posibilă şi indicarea 
unor setări explicite, alese de utilizator prin intermediul asistenţilor 
(wizards, Figura 1.4).  

Caseta Startup (figura 1.3.) are patru opţiuni de deschidere a 
unei sesiuni de lucru: Open a drawing (deschiderea unui fişier 
existent), Start from Scratch (pornire de la linie cu o configurare 

Meniul principal 

Bara cu unelte standard 

Meniul principal 

Butoane de 

Fereastra de lucru 

Pictograma sistemului 
de coordonate UCS Bare de defilare 

Bare cu instrumente de 
desenare şi editare 

Bara proprietăţi 

Linia de comandă (mod text) 
Linia de stare 

Butoane de comutare 
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implicită, explicit se poate alege doar unitatea de măsură pentru 
distanţă), Use a Template (deschiderea unui fişier şablon, cu setări 
specifice), Use a Wizard (deschiderea prin alegerea unor setări 
minime sau maxime prin intermediul asistenţilor de configurare). 

 

 
 

Figura 1.3. Caseta Startup 
 
Există două opţiuni wizard (o serie de ferestre de dialog 

pentru conducerea procesului de configurare): advanced setup, 
quick setup, care diferă prin numărul ferestrelor de configurare. 

Se pot alege unităţile de măsură pentru lungime (Drawing 
units) unităţile de măsură pentru unghiuri (angle), poziţia de 
început pentru măsurarea unghiurilor şi precizia de măsurare 
(Angle measure), sensul de măsurare a unghiurilor (Angle direction) 
şi aria de desenare (Drawing area). 

 
1.3. DESCHIDEREA UNUI NOU DESEN 
 
Dacă se doreşte realizarea unui nou desen, după finalizarea 

unui desen anterior, se activează opţiunea New... din meniul File al 
meniului principal, acţiune care conduce la deschiderea ferestrei de 
dialog Create New Drawing, identică cu fereastra Startup, care 
permite utilizarea aceloraşi posibilităţi de configurare a mediului de 
desenare. 
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Figura 1.4. Asistentul de configurare Advanced setup 

 
  

 
1.4. FINALIZAREA SESIUNII DE LUCRU. 
      SALVAREA DESENULUI SUB FORMA UNUI FIŞIER 
 
Realizarea unui desen se încheie fie cu stocarea permanentă 

a desenului sub forma fişierelor memorate pe disc sau imprimate pe 
hârtie, fie prin renunţarea la desen fără stocare permanentă. 
Salvarea pe disc se face prin activarea meniului derulant 
corespunzător submeniului Save As... din meniul File al meniului 
principal. 

Activarea conduce la deschiderea unei ferestre de dialog cu 
câmpuri pentru denumirea fişierului şi extensia acestuia. 
Imprimarea desenului se face prin submeniul Plot...  din meniul File 
al meniului principal. Activarea opţiunii determină deschiderea unei 
casete de dialog cu multiple opţiuni de configurare a modului de 
imprimare. 

Sesiunea de lucru se poate încheia şi fără salvarea fişierului 
prin opţiunea Close din meniul File şi alegerea finalizării sesiunii de 
lucru fără salvarea fişierului prin alegerea răspunsului No din 
fereastra de interogare finală. 
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Exerciţiu: 
 
A. Deschiderea sesiunii de lucru 
B. Configurarea mediului de lucru cu ajutorul wizards. 
C. Deschiderea unui nou desen: 
Personalizaţi setările desenului folosind asistentul Advanced 

Setup: 
1. În bara cu instrumente Standard activaţi File şi apoi 

selectaţi New. 

 
2. În fereastra de dialog Create New Drawing activaţi butonul 

de comutare Use a Wizard. 
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3. În lista Select a Wizard selectaţi Advanced Setup şi apoi 

activaţi butonul de comandă OK. 

 
4. Se deschide fereastra de dialog Units şi selectaţi Decimal. 
5. Din lista de butoane de comutare corepunzătoare opţiunii 

Precision activaţi-l pe cel corespunzător preciziei de o sutime şi apoi 
selectaţi Next. 
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6. În fereastra Angle selectaţi Decimal Degrees, în câmpul 
Precision selectaţi 0 şi apoi selectaţi Next. 

 
 
 

7. În fereastra de dialog Angle Measure selectaţi East şi apoi 
selectaţi Next. 
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8. În fereastra de dialog Angle Direction selectaţi Counter-
Clockwise şi apoi selectaţi Next. 
 

 
 
 9. În fereastra Area tastaţi 420 pentru lăţime (Width) şi 297 
pentru lungime (Length) şi apoi selectaţi Finish. 
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 Personalizarea setărilor cu ajutorul asistentului Quick Setup 
este asemănătoare cu cea anterioară, însă există doar două ferestre 
de dialog: Units şi Area. 

 
1. 5. Fişiere model (Template) 
Personalizarea setărilor pentru folosirea individuală sau 

pentru proiecte de serviciu este o metodă eficientă de aplicare a 
standardelor. Fişierele desen de tip Template asigură o metodă de 
salvare a acestor setări şi a layerelor predefinite. Noi desene pot fi 
create folosind fişierele model de desenare. 

Termeni cheie: Fişiere desen Template 
File extension - sunt cele trei litere de la sfârşitul unui 

nume de fişier. Fişierele model au extensia DWT, iar fişierele desen 
DWG. 

Drawing template file location- reprezintă directoare în 
care se găsesc fişierele model. Acestea se pot găsi pe o staţie de 
lucru sau în reţea. Locul unde se găsesc acestea este specificat în 
fila Files din fereastra de dialog Options. 

 
Salvarea unui fişier model 
Salvarea unui fişier model, folosind fişier desen deja existent:  
1. În meniul File selectaţi Save As. 
2. În lista coborâtoare Save As Type selectaţi AutoCAD 

Drawing Template File (* .dwt). 
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3. Localizaţi directorul unde fişierul este salvat. 
4. În câmpul File Name, tastaţi template-metric apoi apăsaţi 

Save. 
 

 
 
5. În câmpul Description tastaţi Acesta este un desen model 

şi apoi selectaţi OK. 
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1.6. CREAREA LAYERELOR 
 
Fiecare entitate desenată are ca proprietate un layer, căruia îi 

aparţine.  
De cele mai multe ori entităţile pe care le desenăm au multe 

caracteristici comune. Layerele organizează obiectele în grupuri 
logice de entităţi care sunt de acelaşi tip. Ex: cote desen, linii axă, 
linii ascunse sunt 3 layere separate pe care vom desena. 

Fiecare entitate desenată, poate avea caracteristici ca: 
grosime, tip linie, culoare, afisare sau nu, culoare imprimare etc. 
Astfel pentru a folosi mai usor obiectele cu caracteristici identice se 
grupeaza pe câte un layer. Iar când vom face operaţii cu un layer, 
ex: schimbare grosime linie sau culoare, modificarile se vor 
răsfrânge asupra tuturor elementelor în acelaşi timp, nefiind 
necesară modificarea individuală pentru fiecare entitate desenată. 

Termeni cheie: Layere 
Current - layer-ul pe care sunt plasate obiectele. Există doar 

un singur layer curent. 

Freeze / Thaw  /  - face ca obiectele de pe un 
layer îngheţat să fie invizibile, respectiv - face ca layerele îngheţate 
să devină iar vizibile 

Observaţie: Layerele cu un număr mare de obiecte ar 
trebui îngheţate când informaţia nu este necesară. Acest lucru va 
îmbunătăţi performanţele sistemului. 
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Lock / unlock  / - protejează selectarea şi 
editarea obiectelor pe acest layer. 

Layer 0 - creat implicit la începerea unui nou desen. Acest 
layer are o culoare implicită de 7 (negru sau alb) şi un tip linie 
continuă. Layerul 0 nu poate fi şters sau redenumit. 

 
Layer Properties Manager 
În fereastra de dialog Layer Properties Manager se pot crea 

noi layere şi se pot modifica proprietăţile layerelor deja existente. 
 

Comanda Layer 
Controleaza layerele şi proprietăţile acestora. 
Bara cu instrumente: 
 
Object Properties > Layer 

 
Meniul: Format > Layer 
 

 
 

Linia de comandă: layer 
 

 
 

 Accesarea comenzii „layer” cu oricare din metodele de mai 
sus face posibila aparitia ferestrei Layer Properties Manager. 
În imaginea de mai jos este prezentat un exemplu de creare şi 
definire a layerelor. 
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Crearea layerelor 
Crearea de noi layere şi modificarea proprietăţilor acestora: 

1. În bara cu instrumente Object Properties selectaţi Layers.  
2. În fereastra de dialog Layer Properties Manager selectaţi 

New. În listă va apărea un nou layer numit Layer1. 
 

 
 
 
3. În listă tastaţi Cote şi apoi apăsaţi ENTER. 
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Observaţie: Puteţi crea mai multe layere dacă tastaţi o 
virgulă între numele lor. 

 

 
 

4. În listă selectaţi mostra pentru culoarea albă pentru ca 
layerul Cote să afişeze fereastra de dialog Select Color. 

5. În fereastra de dialog Select Color selectaţi culoarea 
albastra în Standard Colors şi apoi selectaţi OK. Proprietatea 
culoare este adăugată la layer. 

 
 
 

 
 

6. Creaţi un nou layer cu numele Axe. În listă, în dreptul 
layerului Axe apăsaţi numele Continuous Linetype pentru ca layerul 
Axe să afişeze fereastra de dialog Select Linetype. 
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7. În fereastra de dialog Select Linetype selectaţi Load care ne 
deschide o baza de date ce cuprinde tipurile de linii predefinite de 
programator şi apoi: 

 În lista Available Linetypes selectaţi ACAD_ISO04W100 şi 
apoi selectaţi OK. 

 În lista Loaded Linetypes selectaţi tipul de linie punct 
ACAD_ISO04W100 şi apoi selectaţi OK. Proprietatea tipul 
de linie este adăugată layer-ului. 

 

 
 

8. Apăsaţi Ok pentru a închide fereastra de dialog Layer 
Properties Manager. 

9. În bara cu instrumente Object Properties afişaţi lista Layer 
control. Layerul Axe si Cote sunt afişate. 
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Exerciţiul 2: Crearea layerelor  
Creaţi 5 noi layere potrivite pentru un proiect din domeniul 

ingineriei materialelor. 
 
1.8. Alegerea setărilor desenului 
 
Fereastra de dialog Drafting Settings include meniuri pentru 

Snap şi Grid, Polar Tracking şi Object Snaps. Aceste funcţii măresc 
viteza şi uşurează utilizarea programului. 
 

Termeni cheie: Setările desenului 
1.8.1. Snap grid - o grilă de puncte invizibile situate la 

distanţe definite de utilizator, care restricţionează deplasarea 
incrementală a cursorului  şi care asigură plasarea obiectelor în 
puncte precise.  

"SNAP:"- comanda permite activarea/dezactivarea ajutorului 
grafic "SNAP resolution", stabilirea valorii sale, a aspectului si a 
stilului. Rezoluţia SNAP are semnificaţia de valoare minimă de 
deplasare pe ecran a cursorului, exprimate în unităţi de desenare. 
Sintaxa comenzii este: 

Command: snap < 
Snap spacing or ON/OFF/ Aspect / Rotate / Style <valoare 

curenta>:..... 
- ON activează pasul de SNAP cu valoarea, stilul si aspectul 

pe valoarea curentă . 
- OFF dezactivează pasul de SNAP, fără a altera setările 

curente. Opţiunile ON/OFF sunt similare funcţiei realizate de tasta 
<F9>. 

- Aspect permite definirea unor paşi diferiţi pe orizontală si 
pe verticală. 
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- Rotate determină rotirea celor două direcţii ortogonale 
pentru măsurarea pasului de SNAP faţă de axele OX si OY ale 
sistemului curent de coordonate. Vor fi rotite şi grila precum şi 
firele reticulare ale cursorului-ecran. Punctul de bază al rotaţiei 
poate fi oricare din planul curent XY. 

- Style: alege stilul de SNAP, ortogonal ("Standard"); sau 
izometric.  

- <valoarea curenta>: indică pasul de SNAP actual. Dacă au 
fost setaţi paşi diferiţi pe cele doua direcţii, în locul valorii curente, 
AutoCAD afişează <A>. 
 

1.8.2. Grid - puncte aflate la egală distanţă pe suprafaţa de 
desenare care ajută la plasarea obiectelor. Grila de puncte serveşte 
ca referinţă vizuală. 

„GRID”:- comanda defineşte ajutorul grafic de tip reţea de 
puncte, numit "grila". Sintaxa comenzii este: 

Commamd: grid < 
Grid spacing (X) or ON/OFF /Snap/Aspect <valoare 

curenta>:........  
- ON activează afişarea reţelei de puncte pe ecran, cu toate 

setările curente. 
- OFF are efect opus opţiunii anterioare. 
- Aspect permite distanţarea diferită a punctelor pe verticală 
şi pe orizontală.  
- Snap setează distanţa dintre punctele reţelei pe valoarea 
pasului de SNAP. 
- <valoare curentă>: indică distanţa actuală dintre puncte; 

dacă ea este diferită pe cele două direcţii, AutoCAD afişează <A>. 
Pentru a indica o valoare relativă a pasului de grilă, raportată 

la pasul actual se tastează "{valoare nouă}X". Dacă valoarea nouă 
nu este urmată de "X", pasul de grilă este exprimat în unităţi de 
desenare. 
 

1.8.3. Alegerea setărilor desenului 
Selectarea setărilor snap şi grid din fereastra de dialog 

Drafting Settings: 
1. În meniul Tools selectaţi Drafting Settings pentru a afişa 

fereastra de dialog Drafting Settings. 
2. În submeniul Snap And Grid selectaţi Snap On şi apoi: 
 În câmpul Snap X Spacing tastaţi 10 
 Apăsaţi tasta TAB pentru a muta cursorul în câmpul 

Snap Y Spacing. Această operaţie are ca rezultat setarea 
de valori egale pentru valorile snap-ului pe X şi pe Y. 
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3. Selectaţi Grid On. 
 

 
 

4.Dacă setările implicite în Snap Type And Style sunt 
acceptabile, atunci selectaţi OK. Punctele de grid afişate cu o 
distanţă de 10 unităţi, iar cursorul se va deplasa în paşi de 10. 
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Observaţie: Pentru a deschide fereastra de dialog 
Drafting Settings putem apăsa, în bara de stare, cu butonul din 
dreapta al mouse-ului pe SNAP sau GRID şi apoi apăsaţi Settings. 

 
1.8.4. Utilizarea osnap-ului (salturilor orientate pe 

obiecte) pentru a localiza puncte 
 
Salturile orientate pe obiecte (osnap) sunt folosite pentru a 

localiza rapid şi eficient punctele relativ la geometria existentă. 
Folosiţi salturile orientate pe obiecte pentru a desena precis, fără a 
trebui să introduceţi coordonate sau să realizaţi calcule obositoare. 

Când salturile orientate pe obiecte sunt activate, un marcaj 
apare când cursorul este lângă poziţia punctului de agăţare. Poziţia 
exactă a marcajului, are prioritate faţă de poziţia cursorului, şi este 
introdusă prin apăsare când un marcaj este vizibil. 

 
 
Salturile orientate pe obiecte 
Single Point (override) mode - Saltul orientat pe obiecte 

specificat este activ pentru următorul punct selectat. Este folositor 
atunci când un salt orientat pe obiecte este necesar ocazional. 

Running mode - Salturile orientate pe obiecte sunt active 
pentru toate punctele. Câteva tipuri de puncte snap pot fi activate 
într-un anumit moment. Activarea salturilor orientate pe obiecte 
este folosită când acestea sunt des folosite. 
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Marker - un simbol care este afişat la poziţia punctului de 
agăţare. O formă unică este folosită pentru fiecare tip de punct 
snap. 

Tooltip - textul afişat pentru a identifica tipul saltului 
orientat pe obiecte. 

Magnet - forţează cursorul să rămână blocat pe un punct 
snap atunci când acesta se află în apropierea punctului. 

Aperture box - înconjură cursorul (reticulul în cruce) şi 
defineşte o zonă în care AutoCAD evaluează obiectele pentru 
salturile orientate pe obiecte. 

Autosnaps - un instrument de vizualizare care foloseşte 
marcaje şi indicatoare de salt pentru a indica tipul de punct snap. 

 
În imaginea de mai jos semnificaţia punctelor cheie dintr-un 

desen este următoarea iar abrevierile sunt trecute în paranteză: 
-Endpoint (END)-capătul obiectelor 
-Midpoint (MID)-mijlocul obiectelor 
-Intersection (INT)-intersecţia obiectelor 
-Center (CEN)-centrul cercurilor, arcelor şi elipselor 
-Tangent (TAN)-punct pe un cerc sau un arc ce formează o 

tangentă la obiect 
-Quadrant (QUA)-Cadranul arcelor, cercurilor, elipselor 
-Perpendicular (PER)-Puncte ce formează un unghi de 900 
-Extension (EXT)-Cale de extensie a obiectelor 
-None (NON)-Dezactivează punctele snap pentru următoarea 

selecţie de puncte 
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Setarea modului Running Object Snap 
Setarea multiplă a modurilor Running Object Snap: 
1. În bara de stare, apăsaţi pe butonul din dreapta al mouse-

ului pe Osnap, apoi selectaţi Settings. Este afişată fereastra de 
dialog Drafting Settings. 

2. Dacă comutatorul Object Snap On nu este setat, selectaţi-l 
pentru a activa salturile orientate pe obiecte. 

3. Marcaţi toate tipurile de salturi necesare. 
4. Selectaţi OK. 

Observaţie: După setarea modului Running Object Snap, 
apăsaţi butonul Osnap din bara de stare pentru a le activa sau 
dezactiva pe toate. 
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Folosirea salturilor orientate pe obiecte pentru un punct 
singular 

Folosirea unui salt orientat pe obiecte pentru a specifica 
corect poziţia unui punct:  

1. Începeţi o comandă care necesită introducerea unui punct. 
2. Când comanda cere introducerea unui punct, selectaţi un 

tip de salt orientat pe obiecte folosind una din următoarele metode: 
 Apăsaţi un buton, din secţiunea Object Snap din bara cu 

instrumente Standard sau din bara cu instrumente Object 
Snap. 

 Ţineţi apăsată, tasta butonul drept al mouse-ului în zona 
de desenare, apoi selectaţi un salt orientat pe obiecte din 
meniul cursor. 

 Tastati abrevierea unui salt orientat pe obiecte în linia de 
comandă. 

3. Mutaţi cursorul peste poziţia punctului de agăţare. Când 
apare marcajul, apăsaţi pentru a accepta poziţia marcajului. 

 
Notă: După apăsarea punctului, saltul orientat pe obiect nu 

mai este activat. Pentru a folosi un salt orientat pe obiect pentru 
următorul punct, repetaţi procedura de mai sus. 

 
Activarea salturilor orientate pe obiecte 
Utilizarea unui salt orientat pe obiecte necesită selectarea 

tipului de salt pentru fiecare punct în parte. Activarea salturilor 
orientate pe obiecte face ca acestea să rămână mereu în funcţiune.  

Pot fi active câteva tipuri de salt la un moment dat, dacă 
modul Running Object Snap este activat. Pe măsură ce cursorul 
este mişcat în desen peste obiecte, cel mai potrivit tip de salt este 
arătat, bazându-se pe tipul de obiect şi pe poziţia cursorului 
raportată la obiect. Marcajele şi indicatoarele de salt uşurează 
observarea tipului de salt folosit atunci când se alege o poziţie. 
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1.10. Moduri de selectare a obiectelor 
 
Utilizatorul trebuie să specifice asupra căror obiecte 

intenţionează să opereze o anumită modificare, ceea ce implică o 
metodă de selecţie a acestora. Cererea este formulată prin 
prompter-ul “Select objects”. AutoCAD demarează alcătuirea unei 
colecţii de obiecte selectate, într-unul sau mai mulţi paşi, iar 
cursorul-ecran devine un pătrăţel selector. 

 Inţierea se face prin apăsarea tastei ENTER.  
Actiunile ce pot fi efectuate sunt: 
Enter:  AutoCAD încheie procesul de selectare. 
un punct: Se selectează obiectul care trece prin punctul 

respectiv. Dacă mai multe obiecte trec prin punctul precizat, 
selecţia este în primă fază aleatoare: se selectează unul din obiecte. 
Apăsând tasta <Ctrl>, programul ciclează în selecţie, considerând 
pe rând toate obiectele care trec prin punctul specificat. Utilizatorul 
poate opri ciclarea la obiectul dorit. 

Window (W): Sunt selectate obiectele dispuse în întregime, 
strict în interiorul ferestrei specificate; pentru indicarea ferestrei, 
programul solicită două puncte diagonal opuse. 

Crossing (C): Sunt selectate obiectele dispuse total sau 
parţial în interiorul ferestrei specificate; pentru indicarea ferestrei, 
programul solicită două puncte diagonal opuse, ca şi în cazul 
selecţiei de tip “Window”. 

WPolygon (WP): Este similară cu “Window”, dar conturul 
de selecţie est un poligon neregulat, precizat prin indicarea 
succesivă a vârfurilor sale. AutoCAD închide automat conturul 
poligonal la tastarea unui răspuns nul (doar <>). 

CPolygon (CP): Este similară cu “Crossing”, dar 
conturul de selecţie est un poligon neregulat, precizat prin indicarea 
succesivă a vârfurilor sale. AutoCAD închide automat conturul 
poligonal la tastarea unui răspuns nul (doar <>). 

Multiple (M): Permite mai multe specificaţii de selectare, fără 
ca programul să caute obiectele selectabile; opţiunea măreşte viteza 
de lucru; se încheie printr-un apăsarea tastei Enter. 

Fence (F): Este similară cu “CPolygon”, dar nu închide 
automat conturul poligonal de selecţie; ca urmare, prin “fence” sunt 
selectate numai acele obiecte care intersectează efectiv conturul 
poligonal. 

Box (BOX): Deschide o fereastră de selectare de tip 
“Window” sau “Crossing”, după cum al doilea colţ de descriere a 
ferestrei este la dreapta, respectiv la stânga primului colţ.  

Auto (AU): Îmbină automat modurile de selecţie “punct” şi 
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“box”; dacă prin punctul specificat trec obiecte, se aplică modul 
“punct”, iar în caz contrar modul “box”. Primul punct precizat 
crează condiţiile pentru indicarea unei ferestre de tip “Window” sau 
“Crossing”, după aceeaşi regulă ca şi la selecţia de tip “box”. Acest 
mod de selecţie se aplică automat la punctarea cu ajutorul 
cursorului-ecran, dacă utilizatorul nu a optat explicit pentru un alt 
mod. 

All (ALL): Selectează toate obiectele din desen, 
exceptându-le pe cele aflate în layer-e îngheţate. 

Last (L): Selectează ultimul obiect creat, vizibil 
momentan şi neşters din desen. Dacă ultimul obiect create nu face 
parte din zona de vizibilitate curentă, sau dacă aparţine unui layer 
îngheţat, nu este luat în considerare în selecţie. 

Previous (P): Reselectează acelaşi set de obiecte specificat la 
precedenta comandă de editare, cu condiţia să nu fi fost aplicată 
între timp comanda UNDO. 

Remove (R): Comută prompter-ul de selectare în “Remove 
objects”, iar modul de alcătuire a colecţiei de obiecte selectate 
devine exclusiv: obiectele indicate vor fi excluse din colecţie. 

Add (A): Are utilitate după folosirea opţiunii “Remove” în 
selectare, pentru a reveni la prompter-ul de selectare “Select 
objects” şi la modul de selecţie prin adăugare de obiecte în colecţia 
alcătuită. 

Single (SI): Impune programului încheierea automată a 
procesului de selectare după un singur pas, cu condiţia selectării 
cel puţin a unui obiect; în cazul în care nici un obiect nu a putut fi 
selectat în primul pas, prompter-ul de selecţie se repetă. 

Undo (U): Anulează ultimul pas de selectare. 
În continuare sunt prezentate modalităţile de selecţie cel mai 

adesea folosite la învăţarea elementelor de bază în Autocad 
Aceasta comandă nu are nevoie de comanda de la tastatură 

pentru iniţializare, aflându-se în modul aşteptare odată ce a fost 
deschis fişierul. 

 Aceasta este modul de selecţie Box ce deschide o fereastră de 
selectare de tip “Window” sau “Crossing”, după cum al doilea colţ 
de descriere a ferestrei este la dreapta, respectiv la stânga primului 
colţ astfel: dacă al doilea colţ al dreptunghiului de selectare este la 
dreapta primului, AutoCAD va efectua o selecţie de tip "Window" şi 
entităţile ce sunt complet incluse în fereastra de selecţie vor fi 
marcate (supraluminate), iar dacă acest al doilea colţ este la stânga 
primului, selecţia va fi de tip "Crossing", în setul de selecţie vor fi 
incluse toate obiectele aflate total sau parţial în interiorul unui 
dreptunghi de selecţie. 
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Definirea ferestrei de selectare la modul de selecţie „Window” 
 

 
Supraluminarea obiectelor selectate 
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Definirea ferestrei de selectare la modul de selecţie „Crossing” 
 

 
 

Supraluminarea obiectelor selectate 
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1.11 Convenţii de reprezentare 
1.11.1 Reprezentarea liniilor 
 
Proiecţiile formelor geometrice din spaţiu sunt obţinute din 

forme geometrice realizate din linii. Tipurile şi clasele de grosime 
sunt stabilite convenţional prin STAS 103-84. 

Clase de grosime: - b  linie groasă (0.5, 0.7, 1, 1.4, 2, 2.5, 
3.5, 5); 

    - b/2 sau b/3 linie subţire. 
 
Linii utilizate în reprezentările grafice (STAS 103 – 84) 

Identificarea liniei 
Simbol Denumire si 

aspect 

Cazuri de utilizare (exemple) 

A Linie continuă 
groasă 
 
 

A1 Contururi reale vizibile 
A2 Muchii reale vizibile 

B Linie continuă 
subţire 

B1 Muchii fictive vizibile 
B2 Linii de cotă 
B3 Linii ajutătoare 
B4 Linii de indicaţie 
B5 Haşuri 
B6 Conturul secţiunilor suprapuse 
B7 Linii de axă scurte 
B8 Linii de fund la filete vizibile 
B9 Linii teoretice de îndoire la 
reprezentările desfăşurate 

C 
 
D 

Linie continuă 
subţire* 
 - ondulată 

 
în zigzag** 

 

C1, D1  Linii de ruptură pentru 
delimitarea vederilor şi secţiunilor, 
numai dacă linia respectivă nu este o 
linie de axă 

E 
 
F 

Linie 
întreruptă  
 - groasă 
 
subţire 
 
 

E1 Contururi acoperite 
E2 Muchii acoperite 
F1 Contururi acoperite 
F2 Muchii acoperite 
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G Linie punct 
subţire *** 

G1 Linii de axă de revoluţie 
G2 Traseele planelor de secţiune 
G3 Traiectorii 
G4 Suprafaţa de rostogolire pentru 
roţi dinţate 

H Linie punct 
mixtă *** 
 
 

H1 Traseele planelor de secţionare 

J Linie punct 
groasă *** 
 
 

J1 Indicarea liniilor sau suprafeţelor 
cu prescripţii speciale (tratamente 
termice, de suprafaţă etc.) 

K Linie două 
puncte subţire 
 

K1 Conturul pieselor învecinate 
K2 Poziţii intermediare şi extreme de 
mişcare ale pieselor mobile 
K3 Liniile centrelor de greutate, când 
acestea nu coincid cu liniile de axă 
K4 Conturul iniţial al pieselor înainte 
de fasonare 
K5 Părţi situate în faţa planului de 
secţionare 

Observaţii: 
* Pe un desen, chiar dacă se compune din mai multe planşe, 

cât şi pe desenele componente ale aceleiaşi documentaţii tehnice, se 
utilizează un singur tip de linie; 

 
** Se utilizează în cazul desenelor executate automatizat; 
 
*** Punctul poate fi înlocuit cu o linie scurtă. 
 
1.11.2 Reprezentarea formatelor 
 
Formate (SR ISO 5457:1994) 
 

Formate 
preferenţiale 

Formate alungite 
speciale 

Formate alungite 
excepţionale 

Sim
bol 

a x b Simbol a x b Simb
ol 

a x b 

A0 841x1189 A3x3 420x891 A0x2 1189x1682 
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A1 594x841 A3x4 420x1189 A0x3 1189x2523 
A2 420x594 A4x3 297x630 A1x3 841x1783 
A3 297x420 A4x4 297x841 A1x4 841x2378 
A4 210x297 A4x5 297x1051 A2x3 594x1261 

A2x4 594x1682 
A2x5 594x2102 
A3x5 420x1486 
A3x6 420x1783 
A3x7 420x2080 
A4x6 297x1261 
A4x7 297x1471 
A4x8 297x1682 

b

A0
A1

A2
A3

A
4

A
4

 
A4x9 297x1892 

 
 
 

indicator

A3

420
20

h

h

h

h

 

A4
29

7

20

h

indicator

210
h

h
h

 
 Zona neutră, cuprinsă între marginile formatului finit şi 

chenarul care delimitează câmpul desenului, trebuie prevăzută 
pentru toate formatele. 

 Se recomandă ca această zonă să aibă o lăţime minimă de 
h=20mm pentru formatele A0 şi A1 şi o lăţime minimă de h=10mm 
pentru formatele A2, A3 şi A4. 

 
1.11.3 Reprezentarea indicatorului 
 
Indicatorul (SR ISO 7200:1994) 
 Orice desen tehnic trebuie prevăzut cu un indicator. Acesta 

este amplasat în colţul din dreapta jos al formatului, lipit de chenar. 
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Indicatorul trebuie alcătuit, de preferinţă, din unul sau mai multe 
dreptunghiuri alăturate. Acestea pot fi subdivizate în rubrici în care 
sunt prezentate informaţiile specifice, grupate în zonele 
dreptunghiulare după cum urmează: zona de identificare şi zona de 
informaţii suplimentare. 

a
b
c c

b
a

b

a

c

max. 170 max. 170 max. 170
 

 
 Zona de identificare cuprinde: 
 a) numărul de înregistrare sau de identificare a desenului; 
 b) denumirea desenului; 
 c) numele proprietarului legal al desenului. 
 Deasupra sau în stânga zonei de identificare se amplasează 

zona de informaţii suplimentare, care cuprinde: 
 d) simbolul care indică metoda de proiectare; 
 e) scara principală a desenului; 
 f) unitatea pentru exprimarea dimensiunilor liniare; 
 g) metoda de indicare a stării suprafeţei; 
 h) metoda de indicare a toleranţelor geometrice; 
 i) formatul planşei de desen; 
 j) data primei ediţii a desenului. 
În figura de mai jos este prezentată o variantă de indicator, 

care cuprinde elementele de identificare obligatorii, precum şi unele 
elemente suplimentare.  
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LUCRAREA 2 DESENAREA OBIECTELOR 

 
 

2.1. Desenarea liniilor 
 
Regula de bază pentru crearea desenelor şi modelelor CAD 

este că ele trebuie realizate la mărimea lor reală. Baza de date CAD 
conţine toate definiţiile entităţilor geometrice, iar proiectul este 
considerat ca un obiect virtual la aceleaşi dimensiuni cu cel real, 
astfel încât numai când acesta este copiat pe hârtie se controlează 
scara la care este tipărit. Etapele necesare pentru realizarea 
desenului unii obiect sunt prezentate în continuare. 

O linie poate fi formată dintr-un singur segment sau o serie 
de segmente conectate. În ambele cazuri, fiecare segment este un 
obiect separat. 

O serie de linii poate fi deschisă sau închisă pentru a realiza 
un contur închis. 

 
Comanda Line 
Bara cu instrumente: Draw > Line  

 
 

Meniul: Draw > Line 

 
 
Linia de comandă: Line 
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Crearea liniilor 

1. În bara cu instrumente Draw selectaţi Line.  
2. Specificaţi punctul de început. 
3. Specificaţi punctul de sfârşit. 
4. Continuaţi specificarea punctelor de sfârşit după cerere, 

apoi: 
 Apăsaţi ENTER pentru a termina linia. 

sau 
 Tastaţi c şi apoi apăsaţi ENTER pentru a termina linia. 
Notă: Dacă linia este închisă, un segment adiţional este 

automat trasat de la ultimul punct la primul. 

Observaţie: Dacă un punct este introdus greşit, tastaţi u 
pentru a anula punctul şi apoi introduceţi poziţia corectă. 

 
2.2. Specificarea coordonatelor 
 
2.2.1. Specificarea coordonatelor absolute 
Folosiţi coordonatele absolute X,Y cînd valorile precise X,Y 

ale localizării sunt cunoscute. 
Pentru a specifica coordonatele absolute tastaţi X, Y unde X 

şi Y sunt coordonate absolute raportate la originea curentă.  
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Introducere: Folosirea coordonatelor absolute  
Folosiţi coordonatele absolute pentru a desena o figura de 

mai sus: 

1. În bara cu instrumente Draw selectaţi Line.   
2. Tastaţi 3.5,1 apoi apăsaţi ENTER pentru specifica punctul 

de început. 
3. Specificaţi punctele rămase: 
 Tastaţi 7,1 şi apoi apăsaţi ENTER. 
 Tastaţi 7,2 şi apoi apăsaţi ENTER. 
 Tastaţi 8.5,2 şi apoi apăsaţi ENTER. 
 Tastaţi 8.5,1 şi apoi apăsaţi ENTER. 
 Tastaţi 10,1 şi apoi apăsaţi ENTER. 
 Tastaţi 10,8 şi apoi apăsaţi ENTER. 
 Tastaţi 7,8 şi apoi apăsaţi ENTER. 
 Tastaţi 1,9.5 şi apoi apăsaţi ENTER. 
 Tastaţi c şi apoi apăsaţi ENTER pentru a închide figura. 

Nota: Introducerea valorior X si Y se face prin 
separare cu virgulă, iar separarea între partea intreaga si cea 
zecimală a valorilor lui X si Y se face cu punct. 

Mihai
Note
7,10
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2.2.2. Specificarea coordonatelor relative 
Coordonatele relative sunt cel mai folosit mod de a specifica 

poziţia în desene. Folosiţi coordonatele relative X,Y când poziţia 
unui punct în relaţia cu punctul anterior este cunoscută. 

Pentru specificarea coordonatelor relative, tastaţi @dX,dY, 
unde: 

 Semnul @ indică o distanţă relativă. 
 dX este distanţa de-a lungul axei X de la poziţia curentă. 
 dY este distanţa de-a lungul axei Y de la poziţia curentă. 

 
Folosirea coordonatelor relative 
Folosiţi coordonatele relative pentru a desena o figură simplă: 
1. În bara cu instrumente Draw selectaţi Line. 
2. Selectaţi un punct oriunde în desen pentru a specifica 

colţul din stânga jos. 
3. Specificaţi punctele rămase: 
 Tastaţi @6,0 apoi apăsaţi ENTER. 
 Tastaţi @2,2 apoi apăsaţi ENTER. 
 Tastaţi @0,2 apoi apăsaţi ENTER. 
 Tastaţi @-4,2 apoi apăsaţi ENTER. 
 Tastaţi @-2,-1 apoi apăsaţi ENTER. 
 Tastaţi @-2,0 apoi apăsaţi ENTER. 
 Tastaţi @0,-2 apoi apăsaţi ENTER 
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 Tastaţi @1,-2 apoi apăsaţi ENTER. 
 Tastaţi c apoi apăsaţi ENTER pentru a închide figura. 
 
Exerciţiul 2.1.: Desenarea liniilor folosind coordonatele 
relative şi absolute 
În acest exerciţiu, creaţi o vedere a piesei numită furcă. 

Desenati conturul inchis al furcii, plasând colţul din stânga jos la 
10,10 şi localizaţi celelalte puncte folosind coordonatele relative. 

 

 
 
1. Începeţi un nou desen folosind Use a Wizard apoi Quick 

Setup 
2. În bara cu instrumente Draw selectaţi Line. 
3. În linia de comandă tastaţi 10,10 apoi apăsaţi ENTER 

pentru a specifica punctul de început. 
4. În linia de comandă tastaţi următoarele coordonate pentru 

a termina partea inferioară a furcii. 
 Tastaţi @20,0 apoi apăsaţi ENTER. 
 Tastaţi @20,10 apoi apăsaţi ENTER. 
 Tastaţi @50,0 apoi apăsaţi ENTER. 
 Tastaţi @0,-10 apoi apăsaţi ENTER. 
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Observaţie: Dacă se face vreo greşeală în introducerea 
coordonatelor, tastaţi u pentru a anula punctul şi apoi introduceţi 
poziţia corectă. 

5. Desenaţi capătul din dreapta. 
 Tastaţi @10,0 apoi apăsaţi ENTER. 
 Tastaţi @0,60 apoi apăsaţi ENTER. 
 Tastaţi @-10,0 apoi apăsaţi ENTER. 
 Tastaţi @0,-10 apoi apăsaţi ENTER. 
6. Desenaţi vârful. 
 Tastaţi @-50,0 apoi apăsaţi ENTER. 
 Tastaţi @-20,10 apoi apăsaţi ENTER. 
 Tastaţi @-20,0 apoi apăsaţi ENTER. 
7. Terminaţi furca. 
 Tastaţi @0,-10 apoi apăsaţi ENTER. 
 Tastaţi @20,0 apoi apăsaţi ENTER. 
 Tastaţi @20,-10 apoi apăsaţi ENTER. 
 Tastaţi @0,-20 apoi apăsaţi ENTER. 
 Tastaţi @-20,-10 apoi apăsaţi ENTER. 
 Tastaţi @-20,0 apoi apăsaţi ENTER. 
 Tastaţi c apoi apăsaţi ENTER pentru a termina figura. 
8. Salvaţi desenul ca exercise 2.1. 
 
2.2.3. Introducerea coordonatelor polare 
Folosim coordonatele polare pentru specificarea 

coordonatelor unui punct in raport cu un alt punct atunci cand: 
sunt specificate distanţa şi unghiul dintre dreapta ce uneste cele 
două puncte si axa OX. 

Pentru a specifica coordonatele polare tastaţi: 
 Distance<Angle (Distanţa<Unghi) pentru a specifica 

poziţia faţă de origine. 
 @Distance<Angle (Distanţa<Unghi) pentru a specifica 

poziţia relativă faţă de ultimul punct. 
unde: 

 Distance este distanţa până la următorul punct  
 Angle este unghiul măsurat de la 0 grade 
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 Semnul < indică faptul că al doilea număr reprezintă 
măsura unui unghi. 

Observatie: Implicit, unghiurile se măsoară, de la 00 de-a 
lungul axei pozitive X şi mărimea creşte invers sensului acelor de 
ceasornic. 

 
Folosirea coordonatelor polare 
Introduceţi coordonatele polare pentru a desena exemplul de 

mai jos: 
1. În bara cu instrumente Draw selectaţi Line. 
2. Selectaţi un punct de coordonate 20,20 în desen pentru a 
specifica primul punct. 
3. Specificaţi punctele rămase: 
 Tastaţi @50<0 apoi apăsaţi ENTER. 
 Tastaţi @28.28<45 apoi apăsaţi ENTER. 
 Tastaţi @28.28<135 apoi apăsaţi ENTER. 
 Tastaţi @50<180 apoi apăsaţi ENTER. 
 Tastaţi @28.28<-45 apoi apăsaţi ENTER. 
 Apăsaţi c apoi ENTER pentru a încheia comanda Line. 
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2.3. Desenarea punctelor 
 
Obiectele de tip puncte pot fi folositoare ca puncte de 

referinţă pentru plasare de obiecte sau pentru operaţii de offset. 
Punctele pot fi plasate fie câte unul fie pot fi plasate de-a lungul 
obiectelor existente. Atât forma, reprezentarea cât şi mărimea 
punctelor pot fi specificate. Mărimea este specificată în unităţi 
absolute sau relative la mărimea ecranului. 

 
Comanda Point 
Bara cu instrumente: Draw> Point  
 

 
 
Meniu: Draw> Point 

 
 
Linia de comandă: Point 
 
Crearea punctelor singulare 
1. În bara cu instrumente Draw selectaţi Point. 
2. Specificaţi poziţia punctului. 
3. Specificaţi poziţia punctelor adiţionale. 
4. Apăsaţi ESC pentru a nu mai plasa puncte. 
 
Mărimea şi forma de reprezentare a punctelor 
Schimbarea mărimii şi formei de reprezentare a punctelor: 
 
1. În meniul Format selectaţi Point Style 
2. În fereastra de dialog Point Style selectaţi un stil de punct.  
3. În câmpul Point Size tastaţi o valoare. 
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4. Selectaţi un mod de calcul al mărimii de reprezentare: 
 Dacă mărimea este relativă la ecran, punctele rămân de 

aceeaşi mărime, în ciuda măririi sau micşorării.  
 Dacă mărimea este absolută, punctele sunt desenate la 

mărimea specificată. 
5. Selectaţi OK. 
 

Notă: Stilul şi mărimea punctelor curente vor fi aplicate 
tuturor punctelor din desen, incluzând şi punctele care au fost 
create anterior. 

 
 

2.4. User coordinate system (UCS) 
 
Autocad stocheaza toate datele privind poziţionarea obiectelor 

sub forma coordonatelor carteziene tridimensionale (3D) în world 
coordinate system (WCS), sistemul de coordonate universal. WCS 
defineşte originea, punctul (0,0,0) şi orientarea axelor OX, OY, OZ. 
Asadar WCS este sistemul de coordonate implicit la inceperea unui 
nou desen axa OX este poziţionată orizontal in partea de jos a 
ecranului, axa OY vertical in stânga ecranului, iar OZ perpendicular 
pe ecran “ieşind” din acesta către utilizator. 
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Cel mai frecvent utilizat plan de desenare în Autocad pentru 
obiecte bidimensionale (2D) este planul XY (Z=0). 

Atunci când este utilă modificarea punctului (0,0) în desen se 
utilizeaza un sistem de coordonate particular UCS, a cărei origini 
poate fi oriunde în planul XY al sistemului de coordonate universal 
WCS. După mutarea originii în desen, noile coordonate introduse se 
vor raporta la sistemul de coordonate UCS modificat. 

Modificarea şi folosirea UCS este foarte utilă la construcţiile 
3D ce se pot realiza cu ajutorul Autocad-ului. 

 
Comanda UCS 
Bara cu instrumente: Standard>UCS 
 

 
 
Meniu: Tools>Move UCS 
 

 
 

Linia de comandă: UCS 
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2.5. Desenarea cercurilor 
 
„Circle” crează entităţi 2D de tip cerc. Linia de trasare are 

lăţimea nulă. Cercurile pot fi create prin 6 metode: 
 Specificarea centrului şi a razei metoda implicită. (Pentru 

aceasta metodă, opţiunea apare între paranteze 
unghiulare). 

 Specificarea centrului şi a diametrului. 
 Definirea diametrului prin două puncte. 
 Definirea circumferinţei prin trei puncte. 
 Crearea cercului tangent la trei obiecte existente. 
 Crearea cercului tangent la două obiecte şi specificarea 

razei. 
 
Comanda Circle 
Bara cu instrumente: Draw>Circle 
 

 
 
 
Meniu: Draw>Circle 
 

 
 
Linia de comandă: Circle 
 
Introducere: Desenarea cercurilor 
Desenarea unui cerc prin specificarea unui punct de centru 

şi a unui diametru: 
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1.În bara cu instrumente Draw selectaţi Circle. 
2. Selectaţi un punct oarecare în desen pentru a specifica 

centrul cercului. 
3. În linia de comandă tastaţi d şi apăsaţi ENTER pentru a 

specifica varianta diametru. 
4. În linia de comandă tastaţi 40 şi apoi apăsaţi ENTER 

pentru a specifica diametrul. 
 

 
 
 
Exerciţiul 2.3. : Desenarea cercurilor 
Folosiţi cercurile pentru a desena o flanşă. 
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1.Începeţi un nou desen folosind Use a Wizard apoi Quick 

Setup 
2. Desenaţi cercul exterior: 

 În bara cu instrumente Draw selectaţi Circle.   
 Selectaţi un punct oarecare în desen pentru a specifica 

centrul cercului. 
 În linia de comandă tastaţi 100 şi apoi apăsaţi ENTER 

pentru a specifica raza. 
3. Desenati cercul interior: 
 Apăsaţi ENTER pentru a repeta comanda Circle. 
 În linia de comandă tastaţi @ şi apoi apăsaţi ENTER 

pentru a specifica centrul cercului. 
 În linia de comandă tastaţi 70 şi apoi apăsaţi ENTER 

pentru a specifica raza. 
4. Desenaţi cercul din dreapta: 
 Apăsaţi ENTER pentru a repeta comanda Circle. 
 În linia de comandă tastaţi @85,0 şi apoi apăsaţi ENTER 

pentru a specifica centrul cercului. 
 În linia de comandă tastaţi 5 şi apoi apăsaţi ENTER 

pentru a specifica raza. 
5. Desenaţi cercul superior:  
 Apăsaţi ENTER pentru a repeta comanda Circle.  
 În linia de comandă tastaţi @-85,85 şi apoi apăsaţi ENTER 

pentru a specifica centrul cercului. 
 Apăsaţi ENTER pentru a accepta raza implicită. 
6. Desenaţi cercul din stânga: 
 Apăsaţi ENTER pentru a repeta comanda Circle. 
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 În linia de comandă tastaţi @-85,-85, şi apoi apăsaţi 
ENTER pentru a specifica centrul cercului.  

 Apăsaţi ENTER pentru a accepta raza implicită. 
7. Desenaţi cercul inferior: 
 Apăsaţi ENTER pentru a repeta comanda Circle. 
 În linia de comandă tastaţi @85,-85 şi apoi apăsaţi ENTER 

pentru a specifica centrul cercului. 
 Apăsaţi ENTER pentru a accepta raza implicită. 
8. Salvaţi desenul ca exercise 2.3. 
 
2. 6. Desenarea arcelor 
 
Arcele pot fi create prin mai multe metode, funcţie de poziţia 

şi modul de dimensionare al acestora. Pentru desenarea unui arc 
sunt necesare punctul de început şi alţi doi parametri aleşi dintre 
următoarele variante: 

 Punctul de centru 
 Punctul de sfârşit 
 Un punct intermediar 
 Unghiul inclus 
 Lungimea corzii (coarda unui arc este o linie dreaptă ce 

uneşte capetele acestuia) 
 Direcţia 
 Lungimea arcului 
 Raza 
 
Comanda Arc 
Bara cu instrumente: Draw>Arc 

 
Meniu: Draw> Arc 
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Linia de comandă: Arc 
 
"ARC"- traseaza arce de cerc în planul curent X-Y. Lăţimea 

arcelor este nulă. AutoCAD nu poate trasa arce de 3600 !' 
Atunci când programul trebuie sa decidă, este ales totdeauna 

sensul pozitiv de măsurare a unghiurilor, pentru descrierea arcului. 
Exista 8 metode de construcţie a arcului de cerc în AutoCAD: 

 prin 3 puncte: Start point, Second point, End point; este 
metoda implicită; 

 S,C,A: Start point, Center, Angle; adică punct de start, 
centru şi unghi; 

 S,C,E: Start point, Center, End point, adică punct de 
start, centru si capăt; AutoCAD desenează arcul numai în 
sensul pozitiv de măsurare. 

 S,C,L: Start point, End Point, Length of chord, adică 
puncte de capăt şi lungime de coardă; implicit, AutoCAD 
alege şi în acest caz sensul pozitiv de desenare. Există 
două arce care încep din punctul S, au centrul în punctul 
C, sunt subîntinse de aceeaşi coardă şi sunt parcurse în 
sens pozitiv. 

 S, E, R: Start point, End Point, Radius, puncte de capăt şi 
raza; şi în acest caz, arcul este trasat în sens pozitiv; sunt 
posibile două construcţii şi anume: pentru raza pozitivă 
este desenat arcul mic, iar pentru raza negativă arcul 
mare. 

 S, E, A: Start point, End point, Direction of tangent, adică 
puncte de capăt şi direcţia tangentei în punctul de start. 

 Continue: noul arc pleacă tangent la precedenta entitate 
de tip linie sau de tip arc, AutoCAD având nevoie numai 
de coordonatele punctului de început al arcului nou. 

 
Metoda implicită constă în specificarea a trei puncte: un 

punct de început, un al doilea punct de pe arc şi un punct de 
sfârşit. 
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Opţiunile comenzii arc din meniul Draw 
 

 
Variante de desenare a arcelor 

 
Notă: Implicit, arcele sunt desenate în sens invers acelor 

ceasornicului. Dacă este necesară desenarea unui arc în sensul 
acelor de ceasornic, folosiţi o opţiune de trei puncte sau specificaţi 
un unghi negativ. 

Observaţie: Comanda Fillet desenează arce aflate între 
două obiecte existente. În multe situaţii, este cea mai eficientă 
metodă de a plasa arce. Despre comanda Fillet aflaţi mai multe în 
laboratorul 9. 

 
 
Introducere: Desenarea arcelor 

 Desenarea unui arc prin specificarea a trei puncte: 
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1. În bara cu instrumente Draw selectaţi Arc.  
2. Specificaţi punctul de început. 
3. Specificaţi un al doilea punct de pe arc.  
4. Specificaţi punctul de sfârşit. 
Notă: Opţiunea 3-point desenează arce, atât în sensul cât şi 

în sens contrar arcelor ceasornic. 
 

 Desenarea unui arc prin specificarea punctelor de 
inceput şi sfârşit şi a unghiului. 

 

1. În bara cu instrumente Draw selectaţi Arc.  
2. Specificaţi punctul de început. 
3. Tastaţi e (punctul de sfârşit) 
4. Specificaţi punctul de sfârşit.  
5. Tastaţi a (Angle-unghi) 
6. Tastaţi 90 

 
 Desenarea unui arc prin specificarea punctului de 

început, centrul şi unghiul de deschidere al arcului. 
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1. În bara cu instrumente Draw selectaţi Arc.  
2. Specificaţi punctul de început. 
3. Tastaţi c (centrul) 
4. Specificaţi punctul de centru.  
5. Tastaţi a (Angle-unghi) 
6. Tastaţi 90 

 
Exerciţiul 2.4.: Desenarea arcelor 
În acest exerciţiu veţi folosi arce şi linii pentru a desena tăblia 

de capăt a unui pat. 

 
2. În bara cu instrumente Draw selectaţi Line. 
3. Selectaţi un punct oarecare în aria de desenare pentru a 

specifica colţul din stânga-jos a conturului.  
4. Tastaţi @100,0 şi apăsaţi ENTER pentru a specifica 

punctul de sfârşit şi apoi apăsaţi ENTER pentru a încheia comanda 
Line. 

5. Desenaţi arcul: 
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 În meniul Draw selectaţi Arc> Start, Center, Angle. 
 Tastaţi @ şi apoi apăsaţi ENTER pentru a specifica 

punctul de început al arcului drept ultimul punct 
introdus, respectiv capătul liniei. 

 Tastaţi @50,0 şi apoi apăsaţi ENTER pentru a specifica 
centrul arcului. 

 Tastaţi -90 si apoi apăsaţi ENTER pentru a specifica 
unghiul. 

 

Observaţie: Puteţi folosi una din scurtături pentru a 
specifica începutul unei linii sau arc:  

 
 Tastaţi @ şi apăsaţi ENTER când următorul element începe 

la sfârşitul elementului anterior (@ este echivalent cu 
@0,0).  

 Apăsaţi ENTER când următorul element începe la sfârşitul 
elementului anterior şi este tangent la elementului 
anterior.  

6. Desenaţi următoarea linie: 
 În bara cu instrumente Draw selectaţi Line. 
 Apăsaţi ENTER pentru a specifica punctul de început al 

unei linii. Acest lucru arată că linia este tangentă la 
capătul arcului. 

 Tastaţi @450,0 şi apăsaţi ENTER pentru a specifica 
sfârşitul liniei 

7. Desenaţi următorul arc: 
 În bara cu instrumente Draw selectaţi Arc. 
 Apăsaţi ENTER pentru a specifica punctul de început. Aţi 

specificat astfel că arcul începe de la punctul de sfârşit al 
liniei şi este tangent la această linie. 

 Tastaţi @50,-50 şi apăsaţi ENTER pentru a specifica 
punctul de sfârşit. 

8. Desenaţi următoarele două linii: 
 În bara cu instrumente Draw selectaţi Linie. 
 Tastaţi @ şi apăsaţi ENTER pentru a specifica punctul de 

început drept punctul de sfârşit al arcului precedent. 
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 Tastaţi @100,0 şi apăsaţi ENTER pentru a specifica 
sfârşitul liniei. 

 Tastaţi @0,350 şi apăsaţi ENTER pentru a specifica 
următorul, punct de sfârşit. 

 Apăsaţi ENTER pentru a încheia comanda Line. 
 

 
 
9. Desenaţi arcul de deasupra folosind 3 puncte: 
 În bara cu instrumente Draw selectaţi Arc. 
 Tastaţi @ şi apăsaţi ENTER pentru a specifica punctul de 

început drept punctul de sfârşit al arcului precedent. 
 Tastaţi @-375,100 şi apăsaţi ENTER pentru a specifica 

punctul de mijloc al arcului, relativ la punctul de început 
al acestuia. 

 Tastaţi @-375,-100 şi apăsaţi ENTER pentru a specifica 
punctul de sfârşit al arcului, relativ la punctul de mijloc 
definit anterior.  

 
10. Desenaţi ultima linie:  
 În bara cu instrumente Draw selectaţi Line. 
 Tastaţi @ şi apăsaţi ENTER pentru a specifica punctul de 

început drept punctul de sfârşit al arcului precedent. 
 Tastaţi @0,-350 şi apăsaţi ENTER pentru a specifica 

punctul de sfârşit. 
 Apăsaţi ENTER pentru a încheia comanda Line. 
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11. Salvaţi desenul drept exercise 2.4 
 

 
Exerciţiul 2.5.  
Să se realizeze desenul piesei de mai jos, folosind comanda 

Line şi Circle, lucrând cu diferite moduri de specificare a punctelor. 
Incepeţi cu punctul A si continuaţi in ordinea notării, arcele de cerc 
se vor executa la sfarşit. 

 

 
 

1.Începeţi un nou desen folosind Use a Wizard apoi Quick 
Setup 

2. Din meniul bară Tools alegeţi Drafting Settings şi din 
caseta de dialog respectivă se vor seta ajutoarele grafice Snap şi 
Grid. Ca efect, pe ecran va apare reţeaua de puncte, iar cursorul se 
va deplasa din 10 în 10 (se va folosi şi comanda Zoom cu opţiunea 
AII). De pe ferastra Object Snap selectaţi si Endpoint. 

3. In cazul in care ati pierdut reperul pentru ultimul punt 
introdus sau aveti nevoie de alt sistem de axe de coordonate folosiţi 
comanda UCS. 

4. Se lansează de la prompter-ul "Command: ", comanda Line 
sau se acţionează butonul specific din toolbar-ul Draw. Pentru 
desenarea cercului, se va folosi comanda Circle lansată prin aceleaşi 
metode. În continuare, succesiunea de comenzi este următoarea: 
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Folosirea coordonatelor carteziene absolute 
Command: line (sau I) 
Specify first point: 0,0 (punctul A) 
Specify next point or [Undo]: 70,0 (B) 
Specify next point or [Undo]: 90,20 (C)  
Specify next point or [Close/Undo]: 90,50 (D) 
Specify next point or [Close/Undo]: 70,70 (E)  
Specify next point or [Close/Undo]: 50,50 (F)  
Specify next point or [Close/Undo]: 30,70 (G) 
Specify next point or [Close/Undo]: 10,50 (H)  
Specify next point or [Close/Undo]: 0,50 (I)  
Specify next point or [Close/Undo]: 0,0 (A)  
Specify next point or [Close/Undo]: Enter 
 
Command: circle (sau c) 
Specify center point for circle or [3P/2P/Ttr]: 50,20  
Specify radius of circle or [Diameter]: 10 (raza cercului) 
 
Command: arc (sau a) 
Activati comanda OSNAP (object snap) de pe status bar. 
Specify start point for arc or [CEnter]: C  
Specify start point for arc: click pe colţul din dreapta sus a 

desenului la capătul segmentelor- când apare marcajul Endpoint 
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Specify start point for arc: click pe celălalt capăt al 
segmetului în partea stanga jos - când apare marcajul Endpoint 

 
Specify end point of arc or[Angle/chord Length]: deplasaţi 

mouse-ul catre dreapta, celălat capat al arcului de cerc si apasati 
click când apare marcajul Endpoint 

 

 
 
Command: arc (sau a) 
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Repetaţi aceiaşi paşi ca şi pentru arcul de cerc de la etapa 
anterioară pentru a desena arcul dinpartea stângă. 

 
Folosirea coordonatelor carteziene relative 
Command: line 
Specify first point: 0,0 (punctul A) 
Specify next point or [Undo]: @70,0 (B) 
Specify next point or [Undo]: @20,20 (C) 
Specify next point or [Close/Undo]: @0,30 (D) 
Specify next point or [Close/Undo]: @-20,20 (E) 
Specify next point or [Close/Undo]: @-20,-20 (F) 
Specify next point or [Close/Undo]: @-20,20 (G)  
Specify next point or [Close/Undo]: @-20,-20 (H)  
Specify next point or [Close/Undo]: @-10,0 (I)  
Specify next point or [Close/Undo]: @0,-50 (A)  
Specify next point or [Close/Undo]: Enter 
 
Cercul şi arcele de cerc se trasează în acelaşi mod ca în 

varianta de mai sus. 
 
 
Folosirea coordonatelor polare relative 
Command: line 
Specify first point: 0,0 (punctul A) 
Specify next point or [Undo]: @70<0 (B) 
Specify next point or [Undo]: @20,20 (C)  
Specify next point or [Close/Undo]: @30<90 (D) 
Specify next point or [Close/Undo]: @27.85<135 (E) 
Specify next point or [Close/Undo]: @27.85<225 (F) 
Specify next point or [Close/Undo]: @27.85<135 (G)  
Specify next point or [Close/Undo]: @27.85<225 (H) 
Specify next point or [Close/Undo]: @10<180 (I)  
Specify next point or [Close/Undo]: @50<-90 (A)  
Specify next point or [Close/Undo]: Enter 
Cercul şi arcele de cerc se trasează în acelaşi mod ca în 

variantele de mai sus. 
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Oservatie: Nu toate punctele de pe acest desen sunt 
corect definite prin coordonatele polare relative (datorita preciziei 
limitate de setări cu care se lucrează – de asemenea nici nu se 
folosesc in practică) de aceea coordonatele unor puncte sunt 
introduse cu ajutorul coordonatelor carteziene relative. 

 
 
Exerciţiul 2.6. Realizaţi desenul din figura de mai jos. 

 
 

Exerciţiul 2.7. Realizaţi desenul din figura de mai jos. 
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2.7. Vederi 
2.7.1. Reprezentarea în proiecţie ortogonală 
 
Redarea entitaţilor tridimensionale cu ajutorul vederilor este 

cel mai raspandit mod de redare a  formei şi  dimensiunilor 
obiectelor  în desenul tehnic şi  constă  în utilizarea mai multor 
reprezentări  ale obiectului, obţinute ca proiecţii ortogonale  
pe mai multe plane de proiecţii. 

A proiecta ortogonal un obiect pe un plan de proiecţie 
înseamnă a duce prin punctele caracteristice ale obiectului linii 
drepte paralele între ele (drepte proiectante) şi perpendiculare faţă 
de plan care la intersecţie cu planul   respectiv,  determină 
proiecţiile punctelor  din spaţiu pe acest plan. Astfel,  unui punct 
din spaţiu îi corespunde o singură proiecţie pe planul de proiecţie. 
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Proiecţia ortogonală a punctului 

 
O singură proiecţie însă nu determină univoc poziţia 

punctului în spaţiu.  Astfel,  pentru a determina această poziţie 
sunt  necesare proiecţiile pe două plane: planul orizontal H şi  
planul vertical V, care se intersectează de-a lungul axei Ox. 

Numeroase piese tehnice sunt deosebit de complexe şi, 
pentru determinarea precisă a formei şi dimensiunilor, necesită 
utilizarea şi planului de profil de proiecţie W. 

Planele  H,  V, W sunt  reciproc perpendiculare, formând un 
triedru de proiecţie având axele Ox, Oy, Oz şi originea în punctul O. 
Trecerea de la spaţiu la plan se face prin rotirea planului H în jurul 
axei Ox la 90° şi a planului W în jurul axei Oz la 90°, obţinându-se 
astfel desfăşurarea planelor de proiecţie într-un singur plan. 
Punctul A este proiectat ortogonal pe cele trei plane, obţinându-se 
proiecţiile AH, AV, şi AW. Coordonata XA se numeşte abscisa 
punctului; YA – ordonata, ZA – cota. 

 
Trecerea de la spaţiu (3D) la plan (2D) 
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2.7.2. Amplasarea proiecţiilor în plan 
Regulile privind amplasarea, denumirea şi alegerea 

proiecţiilor sunt standardizate  
În cazul pieselor cu configuraţie  complicată nu poate fi 

determinată forma şi dimensiunile pe două sau trei plane de 
proiecţie  şi se  recurge în locul triedrului la un cub de proiecţie.  

Obiectul se aşează imaginar în interiorul cubului, iar 
proiecţiile se obţin pe feţele interioare ale cubului, presupunând că 
obiectul este situat între observator şi planul de proiecţie (sistemul 
european de proiectare). Prin desfăşurarea cubului se obţin 6 
proiecţii, denumite astfel: 
1. vedere din faţă (principală) – proiecţia pe planul V; 
2. vedere de sus – proiecţia pe planul H; 
3. vedere din stânga – proiecţia pe planul W; 
4. vedere din dreapta; 
5. vedere de jos; 
6. vedere din spate. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 

2 

3 



Desenarea obiectelor 

 67 

Din figura de mai sus se observă:  
 proiecţiile se execută în strictă corespondenţă dintre 

acestea 
 muchiile vizibile sunt trasate cu linie groasă, iar cele 

invizibile cu linie întreruptă subţire. Reprezentarea 
muchiilor acoperite este necesară numai în cazul în 
care duce la înlesnirea citirii desenului sau micşorarea 
numărului de reprezentări; 

Proiecţia principală se alege astfel, încât aceasta să conţină 
cât mai multă informaţie privind forma şi dimensiunile elementelor 
obiectului proiectat şi un număr minim de muchii acoperite. 

Numărul de proiecţii se limitează la minimul necesar pentru  
reprezentarea clară a obiectului, redarea completă a formei şi  
dimensiunilor acestuia. 
 

2.7.3. Clasificarea vederilor 
În funcţie de gradul de complexitate al obiectelor 

determinarea grafică a acestora se realizează prin utilizarea 
vederilor sau secţiunilor, regulile de clasificare şi reprezentare fiind 
stabilite de colectii de normative. 

Vederea este reprezentarea în proiecţie ortogonală pe un plan 
a obiectului nesecţionat. În funcţie de direcţia de proiectare vederile 
se clasifică în: 

 vedere de bază, dacă direcţia de proiectare este 
perpendiculară pe una din cele şase feţe ale cubului de 
proiecţie,  

 vedere  suplimentară, dacă este obţinută după alte direcţii de 
proiectare decât cele menţionate anterior. Indiferent de 
poziţia ocupată pe desen, vederile suplimentare se notează, 
iar direcţia de proiectare se indică. 

 
Exemplu de vedere suplimentară 
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După proporţia în care se face reprezentarea obiectului, 
deosebim: 

 vedere completă, dacă în proiecţia respectivă obiectul este 
reprezentat integral; 

 vedere parţială, dacă în proiecţia respectivă este 
reprezentată numai o parte a obiectului, limitată prin linie 
de ruptură. De exemplu, în figura de mai sus vederea 
suplimentară completă A poate fi înlocuită cu vederea 
parţială A de mai jos, fără că desenul să cedeze în 
explicitate. 

 vedere  locală, dacă în proiecţia respectivă este reprezentat 
un element al obiectului, fără linii de ruptură  

 

 
Exemplu de vedere parţială (a) şi locală (b) 

 
Exerciţiu recapitulativ: 
Reprezentarea axonometrică şi proiecţiile ortogonale ale 

piesei: a) 1este direcţia vederii din faţă,  
b) poziţionată în partea din stanga sus a proiecţiilor 
ortogonale 

a)     b) 

1 
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Exerciţiul 2.8. Realizaţi desenul bridei din figura de mai jos. 

 

 

Reţineţi: 
- cercul este o entitate plană dispunând de 6 moduri de 

construcţie. 
- arcul este o entitate 2D, ce poate fi desenata prin 8 metode. 
- AutoCAD nu poate închide complet cercul prin comanda 

"ARC". 
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LUCRAREA 3 DESENAREA POLILINIILOR. PROPRIETĂŢI 

 
 

3.1. Desenarea poliliniilor 
 
Polilinia este o entitate complexă formată dintr-o serie de 

segmente de linie dreaptă sau arce de cerc conectate între ele. Spre 
deosebire de alte entităţi, polilinia poate avea o grosime deosebită de 
grosimea stratului (layer-ului) în care a fost creată şi această 
grosime poate fi atât constantă, cât şi  variabilă pe lungimea liniei 
(lucru util, de exemplu, la desenarea săgeţilor). 

 
Cu toate că o polilinie este reprezentată ca o succesiune de 

segmente, totuşi, o polilinie reprezintă un singur obiect faţă de o 
linie care este formată dintr-un număr de obiecte separate. 
Avantajele utilizării unei polilinii sunt: 

 O polilinie poate fi manipulată ca o singură entitate. 
 O întreagă polilinie poate fi selectată printr-o singură 

apăsare. 
 O polilinie poate avea grosime variabilă. 
 Lungimea şi zona închisă a poliliniei pot fi uşor calculate. 
 O polilinie consumă mai puţin spaţiu pe disk şi mai 

puţină memorie decât segmente individuale. 
 
Comanda Pline: 
Bara cu instrumente: Draw> Polyline 
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Meniu: Draw> Polyline 
 

 
 

Linia de comandă: pline. 
 
"PLINE:" crează o entitate 2D de tip "polyline” (polilinie), o 

linie complexă construită dintr-o succesiune de segmente de 
dreaptă şi arce de cerc; în orice număr şi în orice combinaţie, de 
lăţime diferită de 0. Laţimea poate varia de la o subentitate la alta 
sau chiar pentru aceeaşi subentitate. În particular, poate fi si nulă. 
Sintaxa comenzii conţine două şiruri de cuvinte-cheie, unul pentru 
modul de lucru "linie", în care se pot trasa segmente de dreaptă si 
unul pentru mod de lucru „arc”, în care se desenează arce de cerc. 
Partea comună în oricare din modurile de lucru si respectiv şirul de 
cuvinte-cheie pentru modul de lucru "linie" din sintaxa sunt: 

 
Command: PLINE 
From point {Punct}> 
Current line width is <valoare curentă; iniţial, 0.0000>  
Arc/Close/Halfwidth/Length/Undo/width/ <Endpoint of 

line>: .... 
- Arc: comută în modul de lucru "arc", fără a se ieşi din 

comanda curentă. 
- Close: închide automat polilinia cu segment de dreaptă, cu 

condiţia ca închiderea, să fie geometric posibilă. AutoCAD revine pe 
prompterul "Command". 

-Halfwidth: permite setarea semilăţimii pentru subentitatea 
următoare; se cere valoarea la start şi valoarea la capăt. Pot fi 
indicate valori diferite la cele două extremităţi. 

- Length: AutoCAD va cere lungimea segmentului următor 
din polilinie, construindu-l exact în prelungirea precedentului 
segment, sau tangent la precedentul arc din aceeaşi polilinie; 
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- Undo: anulează ultima subentitate fără a părăsi comanda. 
Opţiunea este similară cu cea de la comanda "LINE". Se poate 
reveni pas cu pas până la punctul de start. 

- Width: permite setarea lăţimii pentru veriga următoare. Se 
poate opta pentru valori diferite la start si la capăt (''Starting width" 
si "Ending width"). Implicit, AutoCAD setează a doua lăţime pe o 
valoare egală cu prima. Lăţimea poate fi şi 0. 

- End point of line: lăţimea iniţială fiind acceptată, opţiunea 
implicită a comenzii ''PLINE:'' cere punctul de capăt al segmentului 
următor. 

Desenarea poliliniilor cu segmente de arc 
Poliliniile liniare au fost prezentate mai sus. Acestea pot 

include, de asemenea, segmente de arc. 
 
 

 
 
 
Punctul de început al unui arc este punctul de sfârşit al 

segmentului sau arcului precedent. Parametri rămaşi sunt 
asemănători comenzii Arc. 

 
Şirul de cuvinte - cheie pentru modulul de lucru „arc” este: 
Angle/Center/Close/Direction/Halfwidth/Line/Radius/Secon

dpoint/Undo/Width/< Endpoint of arc>: 
 
-Angle: se indică deschiderea unghiulară a subentităţii de tip 

arc; valoarea poate fi pozitivă sau negativă. 
- CEnter: se indică centrul subentităţii de tip arc. 
- CLose: închide polilinia cu un arc, în aceleaşi condiţii ca şi 

în modul de lucru linie; arcul de închidere pleacă racordat la 
subentitatea anterioară. Comanda se încheie automat. 

- Direction: AutoCAD cere direcţia tangentei la plecare, 
pentru arcul aflat în construcţie în cadrul poliliniei; 

Sesizaţi şirul de majuscule "CE", respectiv "CL" pentru cele 
două opţiuni anterioare; prima literă nu este suficientă pentru a le 
diferenţia. 

- Halfwidth: permite setarea semilăţimii următorului arc din 
polilini. Consideraţiile privind definirea acesteia în modul de lucru 
linie sunt valabile şi în acest caz. 
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- Line: comută în modul de lucru "linie", fără părăsirea 
comenzii curente. 

- Radius: AutoCAD solicită raza arcului din polilinie. 
- Second point: opţiunea este similară cu cea din comanda 

"ARC". 
- Undo: anulează ultima subentitate din polilinie, fără a 

părăsi comanda. 
- Width: similară cu opţiunea din modul de lucru "linie". 
- <End point of arc>: AutoCAD solicită punctul de capăt al 

arcului de polilinie aflat în construcţie. Este opţiunea implicită de 
construcţie în modul de lucru "arc". 

Ieşirea din comandă se poate obţine dând răspuns nul în 
oricare din modurile de lucru. 

 
TOATE SUBENTITĂŢILE CONSTRUITE IN CADRUL 

ACELEIAŞI COMENZI "PLINE" FORMEAZA O SINGURĂ 
ENTITATE; 

 
Exerciţii Crearea poliliniilor 
Exerciţiul 3.1. Folosiţi o entitate grafică de tip polilinie 

pentru a desena figura următoare. 
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1. Din meniul Draw selectaţi Polyline.  

 
2. Selectaţi un punct oriunde în aria de desenare pentru a 

specifica punctul de început. 
3. Specificaţi punctul de sfârşit al fiecărui segment de 

polilinie: 
 Tastaţi @40,0 apoi apăsaţi ENTER. 
 Tastaţi @0,l0 apoi apăsaţi ENTER. 
 Tastaţi @-30,0 apoi apăsaţi ENTER. 
 Tastaţi @0,20 apoi apăsaţi ENTER. 
 Tastaţi @20,0 apoi apăsaţi ENTER. 
 Tastaţi @0,10 apoi apăsaţi ENTER. 
 Tastaţi@-20,0 apoi apăsaţi ENTER. 
 Tastaţi @0,20 apoi apăsaţi ENTER. 
 Tastaţi @30,0 apoi apăsaţi ENTER. 
 Tastaţi @0,10 apoi apăsaţi ENTER.  
 Tastaţi @-40,0 apoi apăsaţi ENTER. 
 Tastaţi c apoi apăsaţi ENTER pentru a închide figura. 
 
Notă: Comenzi adiţionale legate de polilinii sunt prezentate 

dezvoltat în continuare: 
 Explode - converteşte o polilinie în segmente individuale 

de linie. 
 Pedit - editează o polilinie sau converteşte o serie de linii 

legate într-o polilinie. 
 
Exerciţiul 3.2. Realizaţi desenul de mai jos folosind polilinii 

cu grosime diferită.  
1.Începeţi un nou desen folosind Use a Wizard apoi Quick 

Setup 

2.În bara cu instrumente Draw selectaţi Polyline.  
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3.În linia de comandă, tastaţi 0,0 apoi apăsaţi ENTER pentru 
a specifica punctul din stânga jos al dreptunghiului. 

4.Specificaţi grosimea: 
 Apăsaţi pe butonul din dreapta la mouse-ului apoi 

selectaţi Width. 
 În linia de comandă tastaţi 2, apoi apăsaţi ENTER pentru 

a specifica grosimea de început. 
 Apăsaţi ENTER pentru a accepta grosimea de încheiere 

implicită. 
5.Tastaţi coordonatele de mai jos pentru a desena 
dreptunghiul. 
 Tastaţi @150,0 apoi apăsaţi ENTER. 
 Tastaţi @0,80 apoi apăsaţi ENTER. 
 Tastaţi @-150,0 apoi apăsaţi ENTER. 
 Apăsaţi pe butonul din dreapta al mouse-ului în desen 

apoi selectaţi Close. 
 

 
6. În bara cu instrumente Draw selectaţi Polyline. 
7. În linia de comandă tastaţi 10,40 apoi apăsaţi ENTER 
pentru a începe piesa. 
8. Specificaţi grosimea: 
 Apăsaţi pe butonul din dreapta al mouse-ului în desen, 

apoi selectaţi Width. 
 În linia de comandă tastaţi 0, apoi apăsaţi ENTER pentru 

a specifica grosimea de început. 
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 În linia de comandă tastaţi 30, apoi apăsaţi ENTER pentru 
a specifica grosimea de sfârşit. 

 În linia de comandă tastaţi @20,0 apoi apăsaţi ENTER 
pentru a realiza primul segment. 

 Apăsaţi pe butonul din dreapta al mouse-ului în desen, 
apoi selectaţi Width. 

 În linia de comandă tastaţi 10, apoi apăsaţi ENTER pentru 
a specifica grosimea de început. 

 În linia de comandă tastaţi 10, apoi apăsaţi ENTER pentru 
a specifica grosimea de sfârşit. 

 În linia de comandă tastaţi @20,0 apoi apăsaţi ENTER 
pentru a realiza al doilea segment. 

 Apăsaţi pe butonul din dreapta al mouse-ului în desen, 
apoi selectaţi Width. 

 În linia de comandă tastaţi 20, apoi apăsaţi ENTER pentru 
a specifica grosimea de început. 

 În linia de comandă tastaţi 20, apoi apăsaţi ENTER pentru 
a specifica grosimea de sfârşit. 

 În linia de comandă tastaţi @20,0 apoi apăsaţi ENTER 
pentru a realiza al treilea segment. 

 Apăsaţi pe butonul din dreapta al mouse-ului în desen, 
apoi selectaţi Width. 

 În linia de comandă tastaţi 10, apoi apăsaţi ENTER pentru 
a specifica grosimea de început. 

 În linia de comandă tastaţi 10, apoi apăsaţi ENTER pentru 
a specifica grosimea de sfârşit. 

 În linia de comandă tastaţi @20,0 apoi apăsaţi ENTER 
pentru a realiza al patrulea segment. 

 Apăsaţi pe butonul din dreapta al mouse-ului în desen, 
apoi selectaţi Width. 

 În linia de comandă tastaţi 10, apoi apăsaţi ENTER pentru 
a specifica grosimea de început. 

 În linia de comandă tastaţi 0, apoi apăsaţi ENTER pentru 
a specifica grosimea de sfârşit. 

 În linia de comandă tastaţi @30,0 apoi apăsaţi ENTER 
pentru a realiza al cincilea segment. 

9.Salvaţi desenul. 
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Exerciţiul 3.3. Desenarea poliliniilor cu ajutorul arcelor 
 

 
 

1. În bara cu instrumente Draw selectaţi Polyline . 
2. Selectaţi un punct oarecare în desen pentru a specifica 

punctul A. 
3. Tastaţi @20,0 pentru a specifica punctul de sfârşit al 

segmentului de linie. 
4. Apăsaţi cu butonul din dreapta al mouse-ului în desen şi 

selectaţi ARC pentru a schimba în modul Arc. 
5. Desenaţi primul arc  
 Tastaţi litera a pentru a alege comanda angle, ce 

stabileşte unghiul la centru al arcului şi apăsaţi Enter; 
 Tastaţi 180 şi apasaţi Enter; 
 Tastaţi R pentru a alege comanda Radius şi apăsaţi Enter; 
 Tastaţi 10 şi apăsaţi Enter; 
 Tastaţi 90 pentru direcţia corzii subîntinse de arc şi 

apăsaţi Enter; 
6. Apăsaţi pe butonul din dreapta al mouse-ului în desen şi 

selectaţi Line pentru a schimba în modul Line. 
7. Tastaţi @-20,0 pentru a specifica punctul de sfârşit al celui 

de al doilea segment de linie. 
8. Desenaţi al doilea arc. 
 Click dreapta si selectaţi modul ARC 
 Tastaţi litera a pentru a alege comanda angle, ce 

stabileşte unghiul la centru al arcului şi apăsaţi Enter; 
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 Tastaţi 180 şi apasaţi Enter; 
 Tastaţi ce pentru a alege comanda CEnter şi apăsaţi 

Enter; 
 Tastaţi @-10,0 şi apăsaţi Enter; 
9. Apăsaţi cu butonul din dreapta al mouse-ului în desen şi 

selectaţi Line pentru a schimba în modul Line. 
10. Tastaţi @-20,0 pentru a specifica punctul de sfârşit al 

celui de al treilea segment de linie. 
11. Desenaţi al treilea arc  
 Click dreapta si selectaţi modul ARC; 
 Tastaţi litera a pentru a alege comanda angle, ce 

stabileşte unghiul la centru al arcului şi apăsaţi Enter; 
 Tastaţi 180 şi apasaţi Enter; 
 Click dreapta si alegeti Radius;  
 Tastaţi 10 şi apăsaţi Enter; 
 Tastaţi 270 pentru direcţia corzii subîntinse de arc şi 

apăsaţi Enter; 
12. Apăsaţi pe butonul din dreapta al mouse-ului în desen şi 

selectaţi Line pentru a schimba în modul Line. 
13. Tastaţi @20,0 pentru a specifica punctul de sfârşit al 

celui de al patrulea segment de linie. 
14. Desenaţi al patrulea arc  
 Tastaţi litera a pentru a alege comanda angle, ce 

stabileşte unghiul la centru al arcului şi apăsaţi Enter; 
 Tastaţi -180 (semnul “-“ are rolul de a desena arcul de 

cerc in sens invers trigonometric) şi apasaţi Enter; 
 Tastaţi R pentru a alege comanda Radius şi apăsaţi Enter; 
 Tastaţi 10 şi apăsaţi Enter; 
 Tastaţi 0 pentru direcţia corzii subîntinse de arc şi apăsaţi 

Enter; 
15. Inchideţi comanada pline si salvaţi desenul. 
 
Exerciţiul 3.4. Desenaţi piesa sub formă de cruce din figura 

următoare.  
Piesa este o placă subţire; de grosime uniformă, deci se 

reprezintă într-o singură proiecţie ortogonală. Forma si 
dimensiunile ei permit utilizarea scării de reprezentare 1:1. La 
această scară, desenul poate fi executat pe format A4. Creaţi după 
algoritm condiţiile iniţiale de lucru (limite, tipuri de linii, factor de 
scală pentru linii, ajutoare grafice). 
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Ca punct de referinţă pentru începutul desenului, vom alege 
punctul A de pe model. 

 

 
 
Vom desena contururile, începând cu segmental AB folosind 

o polilinie de lăţime 0.75 unităţi şi constantă. Vom începe cu 
segmentul AB, de la stânga la dreapta, de lungime 20 unităţi, apoi 
arcul de + 1800 racordat cu un nou segment, cel vertical de lungime 
20, apoi continuam desenarea, element cu element, in sensul 
prezentat de sageata desenat punctat.  

Raza cercului ce reprezinta sageata este de 60. Toate arcele  
din desenul piesei au raza de 10.  

 
 Observaţie: Atenţie la stabilirea direcţiei corzii subîntinse de 

respectivele arce de cerc. 
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In acest caz toate unghiurile la centru ale arcelor de cerc vor 
avea valoare pozitivă. 
 

Exerciţiul 3.5. 
Desenaţi în vedere frontală piuliţa hexagonală M24, STAS 

4071-80, redată în figură. Arcul ce reprezintă fundul filetului are o 
deschidere de 270°. 

 
 
 
3.2. Comanda "PEDIT” 
 
“PEDIT” permite editarea poliliniilor. Comanda dispune de 

două şiruri de cuvinte-cheie. Primul corespunde unor operaţii de 
editare globale, iar cel de-al doilea unor modificări asupra 
vertexurilor din polilinie. Sintaxa debutează cu cererea de selectare 
a poliliniei, afişând apoi primul şir de opţiuni: 

 
Comanda „Pedit” 
Bara de intrumente: Modify II > Edit polyline 
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Meniul: Modify > Polyline 

 
 

Linia de comanda: Pedit 
 
 
Command pedit< 
Select polyline: {selectare polilinie}< 
Cose (open)/ Join/ Width/ Edit vertex/ Fit curve/ Spline 

curve/ Decurve/ Undo/eXit <X>:.... 
 
 Vertex reprezintă un punct, parte componentă a unei 

polilinii; 
 "Close" închide automat o polilinie deschisă, dacă 

geometric închiderea este posibilă; aplicată pe o polilinie 
închisă, comanda oferă opţiunea complementară „Open”. 

 "Join" uneşte două sau mai multe polilinii care se ating 
pe capete; 

 "Width” modifică lăţimea la toate subentităţile, 
componente ale poliliniei; 

 "Edit vertex” comută în editarea individuală a fiecărui 
punct; 

 "Fit curve" si "Spline curve" interpolează o polilinie 
formată din segmente, iar "Decurve" anulează efectul 
celor două opţiuni; 

 "Undo" revine un pas înapoi în operaţia de editare a 
polilinie, fără a părăsi comanda; 

 "eXit" asigură încheierea comenzii. 
 
Şirul de cuvinte-cheie aferente modificării in puncte este: 
Next/ Previous/ Break/ Insert/ Move/ Regen/ Straighten 

/Tangent/ Width/ eXit <N>: 
 “Next” trece la editarea poliliniei din următorul punct; 
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 “Previous” trece la editarea poliliniei din punctul anterior; 
 “Break” crează o discontinuitate a poliliniei in punctul 

respectiv; 
 “Insert” introduce un punct nou între două puncte ce 

aparţin aceleaşi polilinii; 
 “Move” modifică poziţia unui punct; 
 “Regen” regenerează un punct; 
 „Width” modifică lăţimea unui segment, component al 

unei polilinii, incepend cu punctul in care este facuta 
selectia; 

 "eXit" asigură încheierea editării unui punct. 
Este afişat un marcator în formă de X pe punctul curent. 

Prima poziţionare a acestuia este pe primul punct din desenarea 
poliliniei.  

 
Observaţie:  
Editarea se face de fiecare dată din punctul curent în sensul 

în care a fost desenata polilinia. 
 
3.3. Comanda "CHPROP" 
 
“Chprop” permite modificarea proprietăţilor unui grup de 

entităţi: culoare tip de linie, layer, grosime. AutoCAD solicită setul 
de obiecte supus editării specificarea proprietăţii ce se va modifica 
si în final noua ei valoare. 

Într-o aceeaşi comandă, pot fi modificate succesiv mai multe 
proprietăţi ale obiectelor selectate. Sintaxa comenzii este: 

 
Command: chprop < 
Select objects: (selectare obiecte) 
Select objects: < 
Change what property (Color/ LAyer/ LType/ Thickness) ? 
C sau LA sau LT sau T < 
New {nume proprietate} <valoare curenta>: {valoare noua)< 

Change what property (Color/ LAyer/ Ltype /Thickness)? ... 
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Pot fi incluse în set obiecte cu valori eterogene ale proprietăţii 
vizate, după modificare, proprietatea având aceeaşi valoare pentru 
întregul set. 

 
Exerciţiu 3.6.  
Să se modifice proprietăţile piesei sub formă de cruce de mai 

sus modificând lăţimea arcelor la valoarea de 1 unitate şi a 
segmentelor la o valoare de 3 unităţi. Aceste operaţii se pot face 
pentru fiecare vertex în parte sau pentru toate de odată la valoarea 
de 1 unitate ca apoi să modificăm numai lăţimile segmentelor. 

Cu comanda “Decurve” faceţi dreaptă coada săgeţii. 
Salvaţi desenul care va arăta ca în figura următoare. 
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Exerciţiu 3.7.  
Desenaţi în vedere frontală piesa de mai jos. 
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LUCRAREA 4 
DESENAREA POLILINIILOR. CAZURI PARTICULARE 
DE POLILINII 

 
 

4.1. Desenarea dreptunghiurilor 
 
Comanda RECTANGLE trasează un dreptunghi. 
Datele care îl descriu sunt două puncte care desemnează 

colţuri opuse ale dreptunghiului. După ce a fost generat, 
dreptunghiul este tratat şi se comportă ca o polilinie. Linia de 
opţiuni este următoarea:  

Specify first corner point or [Chamfer/ Elevation/ Fillet/ 
Thickness/ Width]:  

Chamfer  – permite construcţia unui dreptunghi cu colţurile 
teşite (pentru detalii, vezi comanda omonimă).  

Elevation – trasează dreptunghiul într-un plan paralel cu 
XOY curent, la cota indicată de utilizator.  

Fillet  - permite construcţia unui dreptunghi cu colţurile 
racordate (pentru detalii, vezi comanda omonimă).  

Thickness - asociază înălţime liniei cu care este trasat 
dreptunghiul (înălţimea este orientată de-a lungul axei OZ  

curente).  
Width – asociază grosime liniei cu care este trasat 

dreptunghiul. 

 
 
Comanda Rectangle 
Bara cu instrumente: Draw> Rectangle  
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Meniu: Draw> Rectangle 
 

 
 
Linia de comandă: rectangle 
 
Desenarea dreptunghiurilor 

1. În bara cu instrumente Draw selectaţi Rectangle . 
2. Specificaţi punctul corespunzător primului colţ. Alternativ, 

introduceţi unul din următoarele: 
 C (Chamfer) pentru a selecta mărimea teşiturii pentru 

fiecare colţ al dreptunghiului. 
sau 

 F (Fillet) pentru a selecta raza de racordare pentru fiecare 
colţ al dreptunghiului. 

sau 
 W (Width) pentru a seta grosimea tuturor segmentelor. 
3. Specificaţi punctul colţului opus. 
Notă: Folosiţi coordonatele relative pentru a specifica punctul 

colţului opus utilizând @lungime, lăţime. 
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Exerciţiul 4.1: Desenarea dreptunghiurilor 
 
În acest exerciţiu, desenaţi panoul frontal al unui cuptor 

folosind dreptunghiuri. 
 

 
 

1.Începeţi un nou desen folosind Use a Wizard apoi Quick 
Setup 

În bara cu instrumente Draw selectaţi Rectangle pentru a 
începe desenarea dreptunghiului exterior. 

3. Specificaţi raza colţului: 
 Tastaţi f apoi apăsaţi ENTER. 
 Tastaţi 4 apoi apăsaţi ENTER pentru a specifica raza. 
4. Specificaţi punctele colţurilor: 
 Tastaţi 0,0 apoi apăsaţi, ENTER pentru a specifica colţul 

din stânga jos. 
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 Tastaţi @140,110 apoi apăsaţi ENTER pentru a specifica 
colţul din dreapta sus. 

5. În bara cu instrumente Draw selectaţi Rectangle pentru a 
începe desenarea dreptunghiului interior. 

6. Specificaţi teşitura colţului: 
 Tastaţi c apoi apăsaţi ENTER. 
 Tastaţi 4 apoi apăsaţi ENTER pentru a specifica prima 

distanţă de teşire. 
 Tastaţi 4 apoi apăsaţi ENTER pentru a specifica a doua 

distanţă de teşire. 
7. Specificaţi grosimea: 
 Tastaţi w apoi apăsaţi ENTER. 
 Tastaţi 2 apoi apăsaţi ENTER. 
8. Specificaţi punctele colţurilor:  
 Tastaţi 20,20 apoi apăsaţi, ENTER pentru a specifica 

colţul din stânga jos. 
 Tastaţi 120,90 apoi apăsaţi ENTER pentru a specifica 

colţul din dreapta sus. 
9.Desenaţi butoanele televizorului 
 În bara cu instrumente Draw selectaţi Rectangle pentru a 

începe desenarea dreptunghiului interior. 
11. Specificaţi punctele colţurilor:  
 Tastaţi 20,10 apoi apăsaţi, ENTER pentru a specifica 

colţul din stânga sus. 
 Tastaţi @4,-3 apoi apăsaţi ENTER pentru a specifica colţul 

din dreapta jos. 
12. Repetaţi construcţia butoanelor la distanţele specificate. 
13.Salvaţi desenul. 
 
4.2. Desenarea poligoanelor 
 
Poligoanele sunt polilinii închise cu cel puţin 3 şi până la 

1024 laturi egale. 
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Mărimea poligonului este specificată folosind una din 
următoarele metode: 

 Înscrierea poligonului într-un cerc imaginar. 
 Circumscrierea poligonului unui cerc imaginar. 
 Specificarea capătului uneia dintre laturi. 

 

 
Utilizaţi poligoane înscrise când distanţa dintre centrul 

poligonului şi fiecare vârf este cunoscută. Utilizaţi poligoane 
circumscrise când distanţa dintre centrul poligonului şi mijlocul 
fiecărei laturi este cunoscută. 
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Comanda Polygon 
Bara cu instrumente: Draw> Polygon 
 

 
 
Meniu: Draw> Polygon 

 
 
Linia de comandă: polygon 
 
Desenarea poligoanelor 
Desenarea unui poligon circumscris la cerc: 

 

1. În bara cu instrumente Draw selectaţi Polygon . 
2. În linia de comandă tastaţi 7 apoi apăsaţi ENTER pentru a 

specifica numărul de laturi. 
3. Specificaţi punctul de centru al poligonului. 
4. În linia de comandă tastaţi c apoi apăsaţi ENTER pentru a 

specifica un poligon circumscris. 
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5. În linia de comandă tastaţi 50 pentru a specifica raza apoi 
apăsaţi ENTER. 

 
Exerciţiul 4.2.: Desenarea poligoanelor 
 
În acest exerciţiu, folosiţi poligoane şi cercuri pentru a 

desena cele şase şuruburi. 
1.Începeţi un nou desen folosind Use a Wizard apoi Quick 

Setup 
2. Desenaţi hexagonul din stânga jos: 
 În bara cu instrumente Draw selectaţi Polygon. 
 În linia de comandă tastaţi 6 apoi apăsaţi ENTER pentru a 

specifica numărul de laturi. 
 Selectaţi punctul 0,0 pentru a specifica punctul de 

centru. 
 În linia de comandă tastaţi c apoi apăsaţi ENTER pentru a 

specifica un poligon circumscris. 
 În linia de comandă tastaţi 20 pentru a specifica raza apoi 

apăsaţi ENTER. 
 3. Desenaţi cercul din stânga jos: 
 În bara cu instrumente Draw selectaţi Circle. 
 În linia de comandă tastaţi @ apoi apăsaţi ENTER pentru 

a specifica centrul cercului. 
 În linia de comandă tastaţi 20 pentru a specifica raza apoi 

apăsaţi ENTER. 
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Notă: Scurtătura @ (echivalentă cu @0,0) a fost folosită 
pentru a specifica poziţia centrului cercului. Acest lucru specifică o 
poziţie, aceeaşi cu poziţia anterioară centrul hexagonului. 

 
4. Desenaţi hexagonul din mijloc jos: 
 În bara cu instrumente Draw selectaţi Polygon. 
 În linia de comandă tastaţi 6 apoi apăsaţi ENTER pentru a 

specifica numărul de laturi. 
 În linia de comandă tastaţi 60,0 pentru a specifica 

punctul de centru. 
 În linia de comandă tastaţi c apoi apăsaţi ENTER pentru a 

specifica un poligon circumscris. 
 În linia de comandă tastaţi 20 pentru a specifica raza apoi 

apăsaţi ENTER. 
5. Desenaţi cercul din mijloc jos: 
 În bara cu instrumente Draw selectaţi Circle. 
 În linia de comandă tastaţi @ apoi apăsaţi ENTER pentru 

a specifica centrul cercului. 
 În linia de comandă tastaţi 20 pentru a specifica raza apoi 

apăsaţi ENTER. 
6. Desenaţi hexagonul din dreapta jos: 
 În bara cu instrumente Draw selectaţi Polygon. 
 Apăsaţi ENTER pentru a accepta numărul implicit de 

laturi. 
 În linia de comandă tastaţi 120,0 pentru a specifica 

punctul de centru. 
 Apăsaţi ENTER pentru a accepta modul implicit 

(circumscris). 
 În linia de comandă tastaţi 20 apoi apăsaţi ENTER pentru 

a specifica raza. 
7. Desenaţi cercul din dreapta jos: 
 În bara cu instrumente Draw selectaţi Circle. 
 În linia de comandă tastaţi @ apoi apăsaţi ENTER pentru 

a specifica centrul cercului. 
 Apăsaţi ENTER pentru a accepta raza implicită de 20. 
8. Desenaţi hexagonul din stânga sus: 
 În bara cu instrumente Draw selectaţi Polygon. 
 În linia de comandă tastaţi 6 apoi apăsaţi ENTER pentru a 

specifica numărul de laturi. 
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 Selectaţi punctual 0,50 pentru a specifica punctul de 
centru. 

 În linia de comandă tastaţi c apoi apăsaţi ENTER pentru a 
specifica un poligon circumscris. 

 În linia de comandă tastaţi 20 pentru a specifica raza apoi 
apăsaţi ENTER. 

9. Desenaţi cercul din stânga sus: 
 În bara cu instrumente Draw selectaţi Circle. 
 În linia de comandă tastaţi @ apoi apăsaţi ENTER pentru 

a specifica centrul cercului. 
 În linia de comandă tastaţi 20 pentru a specifica raza apoi 

apăsaţi ENTER. 
10. Desenaţi hexagonul din mijloc sus: 
 În bara cu instrumente Draw selectaţi Polygon. 
 În linia de comandă tastaţi 6 apoi apăsaţi ENTER pentru a 

specifica numărul de laturi. 
 În linia de comandă tastaţi 60,50 pentru a specifica 

punctul de centru. 
 În linia de comandă tastaţi c apoi apăsaţi ENTER pentru a 

specifica un poligon circumscris. 
 În linia de comandă tastaţi 20 pentru a specifica raza apoi 

apăsaţi ENTER. 
11. Desenaţi cercul din mijloc sus: 
 În bara cu instrumente Draw selectaţi Circle. 
 În linia de comandă tastaţi @ apoi apăsaţi ENTER pentru 

a specifica centrul cercului. 
 În linia de comandă tastaţi 20 pentru a specifica raza apoi 

apăsaţi ENTER. 
12. Desenaţi hexagonul din dreapta sus: 
 În bara cu instrumente Draw selectaţi Polygon. 
 Apăsaţi ENTER pentru a accepta numărul implicit de 

laturi. 
 În linia de comandă tastaţi 120,50 pentru a specifica 

punctul de centru. 
 Apăsaţi ENTER pentru a accepta modul implicit 

(circumscris). 
 În linia de comandă tastaţi 20 apoi apăsaţi ENTER pentru 

a specifica raza. 
13. Desenaţi cercul din dreapta sus: 
 În bara cu instrumente Draw selectaţi Circle. 
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 În linia de comandă tastaţi @ apoi apăsaţi ENTER pentru 
a specifica centrul cercului. 

 Apăsaţi ENTER pentru a accepta raza implicită de 20. 
14. Trasaţi axele de simetrie cu comanda Line 
15. Creaţi un nou layer cu tipul de linie întreruptă. 
16. Plasaţi axele de simetrie în acest layer nou. 
17. Salvaţi desenul. 
 
4.4. Desenarea elipselor 
Elipsa este un obiect plan. în construcţia elipselor, AutoCAD 

foloseşte fie extremităţile axelor, fie centrul şi valorile semiaxelor; 
elipsa mai poate fi definită ca proiecţie pe planul XY a unui cerc 
înclinat faţă de plan, caz în care se specifică axa mare a elipsei 
(egală cu diametrul cercului vizat) şi ughiul dintre planul cercului şi 
planul XY. 
Comanda ELlipse trasează o elipsă. Descrierea acesteia se poate face pornind de la centrul 
ei  şi indicându-i axele sau semiaxele, sau ca fiind un cerc rotit în jurul unui diametru cu un 
anumit unghi (opţiunea Rotate). Aceasta este foarte utilă cu precădere atunci când trebuie 
trasate în proiecţie ortogonală cercuri care sunt plasate pe plane înclinate. 

Elipsele şi arcurile eliptice pot fi create, ambele fiind 
reprezentări matematice exacte ale ecuaţiilor elipsei. 

Metoda implicită de desenare a unei elipse este de a specifica 
punctele de sfârşit ale primei axe şi distanţa, care este jumătate din 
lungimea celei de-a doua axe. 
 

 
 

Punctele axei lungi (P1 şi P2) şi distanţa (D) adică jumătatea 
axei mici. 
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Centru, şi cele două jumătăţi ale axelor  

 
Comanda Ellipse 
Bara cu instrumente: Draw>Ellipse 

 
Meniu: Draw> Ellipse 

 
Linia de comandă: ellipse 
 
Desenarea elipselor 
Desenarea elipselor folosind puncte de sfârşit şi distanţe: 
1.În bara cu instrumente Draw selectaţi Ellipse. 
2. Specificaţi primul punct de capăt al primei axe. 
3. Specificaţi al doilea punct de capăt al primei axe. 
4. Specificaţi jumătate din lungimea celei de-a doua axe. 
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 Deplasaţi cursorul faţă de punctul de mijloc al primei axe 
şi selectaţi un punct. 

sau 
 Tastaţi o distanţă în linia de comandă 

 
Exerciţiul 4.3. Desenarea elipselor  
1.Începeţi un nou desen folosind Use a Wizard apoi Quick 

Setup 
1. Desenaţi elipsa mare: 
 În bara cu instrumente Draw selectaţi Ellipse. 
 Tastaţi punctul de coordonate 20,80 şi apoi apăsaţi 

ENTER. 
 Tastaţi punctul din dreapta al elipsei, de coordonate, 

170,80 şi apoi apăsaţi ENTER. 
În linia de comandă, tastaţi 60 şi apăsaţi ENTER pentru a 

specifica jumătate din lungimea axei verticale. 
 

 
2. Desenaţi elipsa din stânga sus: 
 În bara cu instrumente Draw selectaţi Ellipse. 
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 Tastaţi punctul de coordonate 40,100 şi apoi apăsaţi 
ENTER. 

 Tastaţi punctul din dreapta al elipsei, de coordonate, 
90,100 şi apoi apăsaţi ENTER. 

 În linia de comandă, tastaţi 20 şi apăsaţi ENTER pentru a 
specifica jumătate din lungimea axei verticale. 

3. Desenaţi elipsa din dreapta sus: 
 Apăsaţi ENTER pentru a iniţia comanda Ellipse. 
 Tastaţi punctul de coordonate 100,100 şi apoi apăsaţi 

ENTER. 
 Tastaţi punctul din dreapta al elipsei, de coordonate, 

150,100 şi apoi apăsaţi ENTER. 
 În linia de comandă, tastaţi 20 şi apăsaţi ENTER pentru a 

specifica jumătate din lungimea axei verticale. 
4. Desenaţi elipsa de jos: 
 În bara cu instrumente Draw selectaţi Ellipse. 
 Tastaţi punctul de coordonate 60,50 şi apoi apăsaţi 

ENTER. 
 Tastaţi punctul din dreapta al elipsei, de coordonate, 

130,50 şi apoi apăsaţi ENTER. 
 În linia de comandă, tastaţi 20 şi apăsaţi ENTER pentru a 

specifica jumătate din lungimea axei verticale. 
5. Salvaţi desenul. 
 
4.5. Desenarea curbelor spline 
 
O curbă spline este o curbă netedă care interpolează sau 

aproximează un set de puncte specificate. Curbele spline pot fi 
folosite pentru crearea curbelor neregulate care nu pot fi realizate 
uşor cu ajutorul arcelor, de asemeni este folosit şi ca instrument de 
desenare cu mâna liberă (freehand drawing). 
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Termeni cheie: Splines  
NURB (Non-Uniform Rational B-Spline) - o definiţie 

matematică pentru o formă particulară de curbă netedă. 
Control Point - O curbă NURB este definită de o serie de 

puncte de control şi ponderi. Curba trece prin punctele control de 
început şi de sfârşit şi ghidată de punctele intermediare de control. 

Weight (pondere) - Specifică cât de este împinsă curba 
spline către un particular de control. Fiecare punct de control poate 
avea asignată o anumită pondere, diferită de a celorlalte. 

Tagency (tangenţă) - Specifică direcţia curbei în punctele de 
început şi de sfârşit.  

Order - Specifică cât de multe puncte de control sunt date. 
Mai multe puncte de control dau un mai bun control al formei 
curbei. 

 

 

 
Curbe spline cu aceleaşi puncte de definiţie dar ordine de continuitate 

diferite 
 
Comanda Spline 
Bara cu instrumente: Draw>Spline 
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Meniu: Draw>Spline 

 
 
Linia de comandă: spline 
 
Desenarea curbelor spline 

1. În bara cu instrumente Draw selectaţi Spline . 
2. Specificaţi punctul de început al curbei spline. 
3. Specificaţi punctele rămase pentru a desena curba spline, 

apoi apăsaţi ENTER.  
4. Specificaţi tangenta de început. În general apăsaţi ENTER 

pentru a accepta setările implicite. 
5. Specificaţi tangenta de sfârşit. În general apăsaţi ENTER 

pentru a accepta setările implicite. 
 
Exerciţiul 4.4. Desenarea curbelor spline 
Desenaţi o camă folosind o curbă spline. 
Desenaţi cama în jurul punctului de coordonate 0,0 folosind 

coordonate polare absolute. 
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Distanţa de la centrul cercului de bază la profilul camei este 

dată în tabelul de mai jos: 
 
Unghiul (grade) Cursa (mm) Cursa+cercul de bază 

(mm) 
0 0 40 
30 3 43 
60 6 46 
90 15 55 

120 22 62 
150 35 75 
180 49 89 
210 26 66 
240 19 59 
270 10 50 
300 6 46 
330 3 43 

 
1.Începeţi un nou desen folosind Use a Wizard apoi Quick 

Setup 
2. Desenaţi cercul de bază. În bara cu instrumente Draw, 

selectaţi Circle. 
 În linia de comandă tastaţi 0,0 şi apoi apăsaţi. ENTER 

pentru a specifica centrul. 
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 În linia de comandă tastaţi 40 şi apoi apăsaţi ENTER 
pentru a specifica raza. 

3. Măriţi desenul (folosind comanda Zoom) astfel încât cercul 
să fie pe mijlocul ecranului şi să ocupe aproximativ o jumătate din 
suprafaţa de desenare. 

4. În bara cu instrumente Draw, selectaţi Spline. 
5. În linia de comandă tastaţi următoarele coordonate, 

apăsând ENTER după fiecare: 
40<0 
43<30 
46<60 
55<90 
62<120 
75<150 
89<180 
66<210 
59<240 
50<270 
46<300 
43<330 
40<360 
6. Tastaţi c apoi apăsaţi ENTER pentru a închide curba 

spline. 
7. Apăsaţi ENTER pentru a accepta valoarea implicită a 

tangentei. 
8. Salvaţi exerciţiul. 
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LUCRAREA 5 COMENZI DE AFIŞARE. SCRIEREA UNUI TEXT 

 
 

5.1. Controlul afişării 
 
Folosiţi comanda Zoom fie pentru a mări fie pentru a micşora 

imaginea afişată a obiectelor, precum şi pentru a observa detaliile 
sau a afişa întregul desen. Comanda PAN este utilă pentru 
deplasarea cu valori incrementale a imaginii afişate. 

 
Termeni cheie: Zoom şi Pan Zoom – utilizaţi pentru a mări 

sau pentru a micşora imaginea afişată a obiectelor, operaţie 
efectuată în vederea vizualizării. 

Display Magnification - o măsură a cât de mult s-a mărit 
sau micşorat imaginea obiectului. 

Pan - pentru a deplasa desenul fără a schimba mărimea 
afişării acestuia. 

Realtime Zoom and Pan - metodă interactivă de a schimba 
afişarea desenului. 

Extents - zona rectangulară imaginară care cuprinde toate 
obiectele desenului. 

IntelliMouse - un mouse cu două butoane cu o mică rotiţă 
aflată între acestea. Rotiţa poate fi folosită pentru comenzile Zoom şi 
Pan într-un desen fără utilizarea vreunei comenzi AutoCAD. 

 
Comanda Zoom 
În bara cu instrumente: Standard 
Meniul: View>Zoom> Real Time 
Linia de comandă: zoom 
 
Comanda Pan 
În bara cu instrumente: Standard 
Meniul: View> Pan> Real Time 
Linia de comandă: pan 
 
Folosirea comenzii Realtime Zoom 
Schimbarea afişării (scalarea imaginii afişate pe ecran) unui 

desen: 
1.În bara cu instrumente selectaţi Zoom Realtime. 
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Observaţie: Cursorul este afişat acum ca o lupă. 
2. Pentru a mări desenul, deplasaţi cursorul vertical în sus 

pe ecran, ţinând apăsată tasta stângă a mouse-ului. 
3. Pentru a micşora desenul, deplasaţi cursorul vertical în jos 

pe ecran, ţinând apăsată tasta stânga a mouse-ului. 
4. Apăsaţi butonul din dreapta al mouse-ului în zona de 

desenare şi apoi selectaţi Exit pentru a sfârşi comanda. 
 
Folosirea comenzii Realtime Pan 
Schimbarea afişării unui desen prin deplasare de-a lungul 

desenului: 
1. În bara cu instrumente Standard selectaţi Pan Realtime. 
Observaţie: Cursorul este afişat acum ca o mână. 
2. Trageţi cursorul de-a lungul ecranului pentru a deplasa 
desenul. 
3. Apăsaţi butonul din dreapta al mouse-ului în zona de 

desenare şi apoi selectaţi Exit pentru a sfârşi comanda. 
 
Alte opţiuni ale comenzii Zoom 
Celelalte opţiuni pentru a schimba afişarea sunt: 
 

 
Folosirea IntelliMouse-ului (scroll-ul mouse-ului) 
Comanda Zoom -  Pentru a mări viteza de lucru cel mai des se 

foloseşte scroll-ul (rotiţa mouse-ului). Astfel prin rotire înainte şi 
înapoi se apropie, respectiv de îndepărtează desenul. 

Comanda Pan Realtime se poate accesa prin altă funcţie a 
scroll-ului astfel: se deplasează indicatorul mouse-ului pe ecran 
acolo unde dorim sa poziţionăm cursorul de Pan Realtime după care 
apăsăm pe rotiţa de scroll pentru a deplasa desenul. In momentul 
apăsării scroll-ului cursorul îşi modifică forma din sageată în mâna 
(palmă). 

Pentru mai multe informaţii apelaţi la Help - IntelliMouse. 
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Zoom Window 
1. În bara cu instrumente Standard selectaţi Pan Realtime. 
2. Apăsaţi butonul din dreapta al mouse-ului în zona de 

desenare şi apoi selectaţi Zoom Window. 
3. Încadraţi într-o fereastră rectangulară o zonă din desen. 

Imaginea obiectelor incluse în fereastra selectată din desen sunt 
mărite pentru a umple zona definită. 

Observaţie: Zona selectată s-ar putea să nu se 
potrivească ferestrei. 

 
Zoom Extents 
Apăsaţi butonul din dreapta al mouse-ului în zona de 

desenare şi apoi selectaţi Zoom Extents. 
Zoom Extents vă arată toate obiectele vizibile existente în 

desen. 
 
Zoom Original 
Apăsaţi butonul din dreapta al mouse-ului în zona de 

desenare şi apoi selectaţi Zoom Original. Zoom Original arată vederea 
iniţială bazată pe comanda de vizualizare curentă. 

După deplasare şi zoom (mărire şi micşorare) într-o zona 
specifică vă reîntoarceţi la vederea originală apăsând pe Zoom 
Original. 

Pentru mai multe informaţii despre comanda Zoom folosiţi 
Help. 

 
Exerciţiul 5.1: Folosirea comenzilor Zoom şi Pan 
 
Schimbaţi afişarea unui desen folosind zoom şi pan. 
1. Deschideţi un desen cu extensia .dwg. 
2. În bara cu instrumente Standard selectaţi Zoom Realtime. 
3. Pentru a mări desenul, deplasaţi cursorul vertical în sus 

pe ecran, ţinând apăsată tasta stânga a mouse-ului şi apoi eliberaţi 
butonul. 
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4. Pentru a micşora. desenul, deplasaţi cursorul vertical în 
jos, pe ecran ţinând apăsată tasta stânga a mouse-ului şi apoi 
eliberaţi butonul. 

Observaţie: Obiectele de pe ecran sunt afişate în 
dimensiuni din ce în ce mai mici pe măsură ce cursorul se 
deplasează în josul ecranului. 

5. Apăsaţi butonul din dreapta al mouse-ului în zona de 
desenare şi apoi selectaţi Zoom Extents. Acest lucru vă va afişa 
întreg desenul. 

6. Apăsaţi butonul din dreapta al mouse-ului în zona de 
desenare şi apoi selectaţi Zoom Window. 

7. Definiţi o fereastră într-o mică zonă a desenului: 
Apăsaţi şi ţineţi pentru primul colţ al ferestrei pe care o 

vizionaţi. 
Trageţi cursorul şi eliberaţi pentru a defini fereastra. 
8. Apăsaţi butonul din dreapta al mouse-ului în zona de 

desenare şi apoi selectaţi Pan. Trageţi cursorul de-a lungul 
ecranului pentru a vă mişca de jur împrejurul desenului. 

9. Apăsaţi butonul din dreapta al mouse-ului în zona de 
desenare şi apoi selectaţi Exit. 

10.Salvaţi desenul. 
 
 
Alte opţiuni de control a sistemului de afişare 
Controlarea acurateţei reprezentării arcelor şi cercurilor în 

afişarea dumneavoastră se face prin setarea Display Resolution. O 
valoare mai mare va fi vizibilă prin cercuri reprezentate mai exact, 
cu toate că aceasta va micşora viteza sistemului. View Resolution 
este setată prin comanda Viewres. 

Observaţie: Toate cercurile şi arcele apar corect la 
tipărire, indiferent de valoarea setarii pentru Display Resolution. 
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Desenele din AutoCAD se regenerează automat când 
Regenauto este activat (On). Când lucraţi la un desen mai mare, 
dezactivaţi Regenauto (Off) pentru a economisi timp. 

 
Termeni cheie: Comenzi de control a afişării 
View Resolution - un număr de segmente de dreaptă scurte, 

folosite pentru a aproxima reprezentarea obiectelor curbe de tip 
elipse, cercuri şi arce pe ecran. Rezoluţia înaltă face curbele să 
apară fine, dar, poate micşora performanţele sistemului. 

 
Comanda Viewres 
Meniul: Tools>Options> Display 
Linia de comandă: viewers 
 
Comanda Regenauto 
Linia de comandă: regenauto 
 
Rezoluţia de afişare 
Controlarea gradului de acurateţe al arcelor cercurilor şi 

elipselor de pe ecran: 
1. În meniul Tools selectaţi Options. 
2. În fereastra de dialog Options selectaţi Display Tab. 
3. Sub Display Resolution tastaţi pentru a seta Arc and Circle 

Smoothness. 
4. Selectaţi Apply. Desenul se va regenera. 
5. Selectaţi OK pentru a închide fereastra de dialog. 
 
5.2. Folosirea stilurilor de text 
 
Un stil de text dat stabileşte proprietăţile textului, ca font 

(tipul de literă), grosime şi caracteristici generale. Poate de 
asemenea stabili înălţimea textului şi poate aplica diferite efecte 
acestuia. Puteţi defini mai multe stiluri de text într-un desen şi 
puteţi folosi diferite stiluri pentru diferite situaţii. 

 
Termeni cheie: Stiluri de text 
Text Style - o colecţie de setări salvată sub un nume, care 

stabileşte înfăţişarea textului, incluzând fontul, mărimea, grosimea 
şi alte efecte. 
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Special Characters - caractere speciale cum ar fi simbolurile 
pentru diametru sau grad. 

Character Set – numerale şi caractere speciale. 
Font File - defineşte formele carterelor textului într-un set de 

caractere. 
Text Height - O valoare diferită de 0 predefineşte înălţimea 

textului pentru stil. Dacă valoare este 0, înălţimea este setată la 
introducerea textului. 

Width Factor - raportul dintre grosimea textului şi înălţimea 
sa. O valoare mai mare decât 1 lăţeşte textul; iar o valoare mai mică 
decât 1 îl condensează. 

 
Comanda Text Style 
Meniu: Format>Text Style 
 

 
Linia de comandă: text style 
 
Definirea stilurilor de text  
Folosiţi comanda Text Style pentru a defini un nou stil de 

text: 
1. În meniul Format selectaţi Text Style. 
2. Sub Style Name selectaţi New. Tastaţi Title şi selectaţi OK. 
3. Sub Font selectaţi din listă fontul Times New Roman. 

Acesta este un font TrueType. 
4. La Font Style selectaţi Bold. 
5. În câmpul Height tastaţi 3.5 pentru a seta o valoare pentru 

înălţimea textului. 
6. În câmpul Width tastaţi 0.8 pentru a seta o valoare pentru 

raportul de grosime. 
7. Verificaţi în zona de previzualizare Preview pentru a vedea 

cum va apare textul în desen. 
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8. Selectaţi Close. Noul stil de text este acum stilul curent 
folosit la introducerea de text în desen. 

 
Observaţie: Folosiţi AutoCAD DesignCenter pentru a importa 

stiluri de text din alte desene.  
 
Editarea stilurilor de text 
1. În meniul Format selectaţi Text Style. 
2. Selectaţi stilul de editat. Schimbaţi oricare din setările 

stilului. 
3. Selectaţi Apply. 
 

 
Observaţie: Când editaţi un stil, tot textul introdus cu acel 

stil va fi modificat pentru a se potrivi noilor caracteristici. 
Schimbările sunt plasate în coadă de aşteptare şi intră în vigoare la 
următoarea regenerare. 

 
Mărimea textului 
Obiectele AutoCAD sunt desenate la mărimea lor reală, fără a 

lua în consideraţie dacă obiectele sunt mari sau mici. Dacă un nou 
text este adăugat desenului, dacă acesta este prea mare sau prea 
mic, s-ar putea să fie indescifrabil. 

Există standarde, care specifică înălţimea necesară a textului 
pentru textul imprimat. 

Multe desene trebuie scalate pentru a fi imprimate, astfel 
încât să se potrivească mărimilor standardizate ale foilor de hârtie. 

Înălţimea textului pentru adnotări trebuie să fie ajustată 
pentru a permite scalarea. 

Ajustarea înălţimii textului va asigura un raport bun între 
text şi mărimea desenului, pentru o vizualizare mai uşoară pe 
ecran, chiar dacă desenul nu este imprimat. 
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Observaţie: Mărimea textului este o problemă atunci când 

atât textul, cât şi desenul sunt plasate în model space. Adnotările 
por fi plasate în paper space fără ajustări.  

 
Determinarea mărimii textului 
Determinarea mărimii necesare a textului pentru a fi în 

concordanţă cu standardele industriale şi de proiect: 
1. Verificaţi mărimea textului printat. Pentru adnotările 

generale, mărimea textului printat ar trebui să fie de 3 mm. 
2. Determinaţi scara la care va fi printat desenul. De 

exemplu, se consideră că desenul va fi printat la o scară de 1: 100. 
3. Multiplicaţi înălţimea textului printat prin inversul scării 

de printare. Înălţimea cerută a textului este de 3 x 100 = 300. 
4. Plasaţi adnotări1e generale cu o înălţime de text de 300. 

Când printaţi la o scară de 1: 100, va avea o înălţime de 3 unităţi. 
Observaţie: Înălţimea dorită a textului poate fi setată cu 

ajutorul următoarelor tehnici: 
 Folosiţi un stil de text cu o înălţime definită de text de 0 şi 

specificaţi înălţimea când plasaţi textul. 
sau 

 Editaţi înălţimea textului pentru un stil de text existent la 
valoarea cerută. 

sau 
 Creaţi un stil de text cu înălţimea de printare cerută. 

Plasaţi textul şi folosiţi comanda Scale pentru a scala 
textul prin inversarea scării de printare. Această tehnică 
este folositoare în cazul utilizării textului existent în 
indicatoare. 

 
Crearea unui singur rând de text 
Un rând de text indică caracteristici ca note, legende, liste de 

materiale, etichete, poziţii, subtitluri, revizii într-un desen. 
Folosiţi coduri de control pentru a insera caractere speciale 

pentru diametru, grad şi simboluri pentru toleranţă. 
 



Lucarea 5 

 110

Termeni cheie: Linie de text 
Single Line Text - fiecare linie a unui text este un obiect 

separat al AutoCAD-ului. 
Text Justification - alinierea textului bazată pe punctul de 

inserare al textului şi metoda de aliniere. 
 
Comanda Text 
Meniu: Draw>Text>Single Line Text 

 
Linia de comandă: text (sau dtext) 
 
Crearea unei singure linii de text 
Crearea unei linii de text cu aliniere la stânga: 
1. În meniul Draw selectaţi Text, apoi selectaţi Single Line 

Text. 
2. Selectaţi un punct în desen. 
3. În linia de comandă tastaţi 5, apoi apăsaţi ENTER pentru a 

introduce înălţimea textului. 

 
Observaţie: Dacă înălţimea este setată în stilul de text, 

atunci aceasta este utilizată şi nu mai apare cerere pentru înălţime. 
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4. Apăsaţi ENTER pentru a accepta unghiul de rotaţie 
implicit. 

5. În linia de comandă tastaţi PARTIAL TOP VIEW, apoi 
apăsaţi ENTER. 

 
Observaţie: Folosiţi comenzile Windows cut/copy şi paste 

pentru a copia un text dintr-o altă aplicaţie. 
6. În linia de comandă tastaţi OF PART 1 ONLY, apoi apăsaţi 

ENTER. 
7. Apăsaţi ENTER din nou pentru a încheia comanda Text. 
 
Alinierea textului  
Controlarea poziţionării unui text relativ la un punct de 

început: 
1. În meniul Draw selectaţi Text, apoi selectaţi Single Line 

Text. 
2. În linia de comandă tastaţi j apoi apăsaţi ENTER. Implicit, 

textul este aliniat la stânga. Există alte 14 opţiuni de aliniere. De 
exemplu folosiţi Center pentru a centra textul faţă de punctul de 
înserare. 

3. În linia de comandă tastaţi mc, apoi apăsaţi ENTER pentru 
aliniere mijloc-centru. 

4. Selectaţi un punct în desen pentru a specifica mijocul 
textului. 

5. Apăsaţi ENTER de două ori pentru a accepta înălţimea 
implicită şi unghiul de rotaţie implicit. 

6. În linia de comandă tastaţi FRONT VIEW, apoi apăsaţi 
ENTER. 

7. Apăsaţi ENTER din nou pentru a încheia comanda. 

 
Observaţie: Textul apare aliniat la stânga până când 

încheiaţi comanda de text. 
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Observaţie: Pentru mai multe informaţii legate de alinierea 
textului, vedeţi Help- Text Justification. 

 
Caractere speciale 
Introduceţi următoarele coduri de control pentru a insera 

caractere speciale într-o singură linie de text: 
%%d - Simbolul pentru grad (0) 
%%p - Simbolul plus/minus pentru toleranţă ( ) 
%%c - Simbolul pentru diametrul cercului (Ø) 
 
Exerciţiul 5.3: Adăugarea stilurilor de text-şi a rândurilor 

singulare de text 
Definiţi un nou stil de text. Adăugaţi rânduri singulare de 

text pentru a adnota anumite părţi din desen. 
Adăugarea unui nou stil de text: 
1. Deschideţi un fişier model. 
2. În meniul Format selectaţi Text Style. 
3. Sub Style Name selectaţi New. Tastaţi numele TITLE. 

Selectaţi OK. 
4. Sub Font selectaţi Arial Narrow. 
5. Selectaţi Apply, apoi selectaţi Close. 
Introducerea textului 
1. Setaţi modul Object Snap pe Node. 
2. În meniul Draw selectaţi Text, apoi selectaţi Single Line 

Text. 
3. Tastaţi j, apoi apăsaţi ENTER. Tastaţi bc pentru aliniere 

jos-centru şi apoi apăsaţi ENTER. 
4.Pentru punctul de jos-centru selectaţi punctul marcat cu X. 
5. Tastaţi o înălţime de text de 0.2, apoi apăsaţi ENTER. 
6. Apăsaţi ENTER pentru a accepta unghiul de rotaţie. 
7. Tastaţi North-South Section. 
8. Apăsaţi ENTER de două ori. 
 
Adăugarea adnotărilor la axe 
1. În meniul Format selectaţi Text Style. 
2. Selectaţi pentru Style Name, ROMANC. 
3. Selectaţi Close pentru a închide fereastra de dialog. 
4. În, meniul Draw selectaţi Text, apoi selectaţi Single Line 

Text. 
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5. Tastaţi j, apoi apăsaţi ENTER. Tastaţi mc pentru aliniere 
mijloc-centru şi apoi apăsaţi ENTER. 

6. Selectaţi un punct de-a lungul axei verticale din stânga a 
profilelor. 

7. Tastaţi 0.1 şi apăsaţi ENTER pentru a seta înălţimea. 
8. Tastaţi 90 şi apoi apăsaţi ENTER pentru a seta unghiul de 

rotaţie. 
9. Tastaţi textul DEPTH. 
10. Apăsaţi ENTER de două ori. 
11. Repetaţi paşii de la 4 la 10 pentru a plasa textul şi de-a 

lungul celeilalte axe. 
12. Ştergeţi punctul marcat prin X. 
13. Salvaţi desenul. 
 
Crearea textului multilinie 
Textul multilinie se găseşte plasat într-un cadru, cunoscut 

sub numele de fereastra limită a textului multilinie, şi acceptă 
operaţii sofisticate de formatare cum ar fi posibilitatea de a schimba 
fontul, culoarea şi spaţiul dintre linii. Folosiţi textul multilinie 
pentru notele desenului, adnotările legendei, sau descrieri mai 
detaliate ale desenului. 

 
Termeni cheie: Textul multilinie 
Boundary Box - o fereastră neprintabilă care limitează 

grosimea unei coloane a textului. Textul poate depăşi partea 
superioară şi inferioară a ferestrei de limitare în funcţie de aliniere. 

Multiline Or Paragraph Text – paragrafe separate de text 
create cu un editor de text cu funcţionalitate de procesoare de text. 
Caracterele pot fi formatate cu diferite fonturi inălţime de text, 
culoare şi alte proprietăţi. 

 
Comanda Mtext 
Bara cu instrumente: Draw 

 
 

Meniu: Draw>Text>Multiline Text  
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Linia de comandă: mtext 
 
Crearea textului multilinie 
Crearea paragrafelor 
 de text formatat: 
1. În bara cu instrumente Draw, selectaţi Multiline Text. 
2. Selectaţi un punct pentru colţul din stânga sus şi alt 

punct pentru colţul din dreapta jos a ferestrei de text. 
3. Tastaţi textul în fereastra Multiline Text Editor. 
Observaţie: Selectaţi Import Text pentru a importa un text 

dintr-un fişier extern sau folosiţi comenzile Windows cut/copy şi 
paste pentru a copia un text din alte aplicaţii. 

4. Formataţi textul. 
5. Selectaţi OK pentru a închide fereastra Multiline Text 

Editor. 
 
Formatarea textului multilinie 
Setarea şi editarea textului multilinie, formatarea în fereastra 

Multiline Text Editor şi introducerea textului în fereastra de dialog: 
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Opţiunea Line Spacing setează spaţiul dintre rândurile unui 
text multilinie. 

At Least - spaţiul dintre rânduri bazat pe caracterul cel mai 
mare (setare implicită). 

Exactly - spaţiu dintre rânduri, acelaşi pentru toate 
rândurile. 

Single - spaţiu dintre rânduri egal cu distanţa verticală 
dintre partea inferioară a unui rând şi partea inferioară a rândului 
următor. Spaţiul de tip single este egal cu 1.66 înmulţit cu 
înălţimea caracterelor textului. 

 
Other Spacing - selectaţi o opţiune sau tastaţi un număr 

urmat de x pentru un multiplu al spaţiului de tip single. Introduceţi 
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1 pentru o spaţiere de 1.0 unităţi, fără a se lua în consideraţie 
înălţimea textului. 

 
Fila Find /Replace 
Găseşte şi înlocuieşte secvenţe de caractere definite de 

utilizator, folosind aceleaşi tehnici ca un procesor de text. 

 
Adăugarea caracterelor speciale  
Caracterele speciale precum simbolul diametrului ( ), 

simbolul gradului (°) şi simbolul plus/minus ( ) pot fi introduse 
folosind aplicaţia Character Map, lista Symbol din fereastra Multiline 
Text Editor sau prin introducerea de la tastatură. 

 
Introducerea de la tastatură 
Introduceţi caractere speciale cu ajutorul tastaturii în textul 

multilinie. Codurile sunt asemenea celor de la textul de tip Single 
Line. 

Observaţie: Simbolul diametrului apare în fereastra Multiline 
Text Editor sub forma %%c, dar este convertit în caracterul special 
necesar la revenirea în desen. 

Folosirea simbolurilor din Character Map  
Introducerea caracterelor speciale folosind aplicaţia Character 

Map: 
1. În bara cu instrumente Draw, selectaţi Multiline Text. 
2. Pozitionaţi un nou dreptunghi pentru text. 
3. În fereastra de dialog Multiline Text Editor selectaţi Symbol. 
4. Selectaţi Other. Aplicaţia Character Map este afişată. 
5. Alegeţi un simbol şi apoi Select. 
6. Alegeţi mai multe simboluri dacă este necesar. Când aţi 

terminat, selectaţi Close. 
7. Selectaţi Close pentru a încheia aplicaţia Character Map. 
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8. În fereastra Multiline Text Editor plasaţi cursorul de text 
unde doriţi să poziţionaţi simbolurile. Apoi apăsaţi butonul din 
dreapta al mouse-ului şi alegeţi Paste din meniul cursor. 

9. Selectaţi OK pentru a închide fereastra Multiline Text 
Editor. 

Observaţie: Puteţi de asemenea selecta simboluri pentru 
caractere speciale din lista Symbol. 

 

 
 
Exerciţiul 5.4: Crearea şi formatarea textului multilinie 
 
Crearea textului multilinie 
1. Deschideţi un fişier model. 
2. În bara cu instrumente Draw selectaţi Multiline Text pentru 

a adăuga textul în indicatorul gol. 
3. Selectaţi colţul din stânga sus şi cel din dreapta jos al 

ferestrei de text pentru a defini fereastra limită a textului. 
4. În fereastra Multiline Text Editor selectaţi Import Text - şi 

deschideţi un fişier tip .txt. 
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5. Selectaţi opţiunea Character pentru a vă asigura că este 
curentă. 

6. Apăsaţi pe butonul din dreapta al mouse-ului în fereastra 
de editare a textului şi selectaţi Select All din meniul cursor. 

7. În câmpul Text Hight. tastaţi 0.075 pentru a seta înălţimea 
textului, iar din lista Color selectaţi Black. 

8. Selectaţi o parte a textului. 
Din lista de fonturi selectaţi fontul Dutch801 Rm BT. 
În câmpul Text Hight tastaţi 0,1 pentru a seta înălţimea 

textului selectat. 
9. Selectaţi restul textului şi aplicaţi fontul Stylus BT. 
 
Aranjarea alinierii şi a spaţierii 
1. Selectaţi opţiunea Properties. 
2. Din lista Justification selectaţi Tap Center. 
3. Selectaţi opţiunea Line Spacing. 
4. Setaţi Line Spacing la Exactly şi Single (l.0x). 
5. Selectaţi OK pentru a închide fereastra Multiline Text 

Editor. 
6. Salvaţi desenul. 
 
Editarea textului 
Poziţia textului poate fi schimbată folosind manipulatoarele şi 

alte comenzi precum Move, Copy, Rotate şi Erase. Textul poate fi 
editat folosind comanda Ddedit. 

 
Comanda Ddedit 
Bara cu instrumente: Modify II  
Meniu: Modify>Text 
Linia de comandă: ddedit 
Editarea valorilor textului 
Schimbarea conţinutului unei singure linii de text şi a unui 

text multilinie: 
1. În bara cu instrumente Modify II selectaţi Edit Text. 
2. În secţiunea Notes a indicatorului selectaţi rândul de text 

notat cu numărul 1. 
3. Schimbaţi textul TEE în VEE selectaţi OK. 
4. Selectaţi rândul Cad NO. i392346b şi schimbaţi-l în 

i392346c. 
5. Selectaţi OK şi apoi ENTER pentru a încheia comanda. 
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Editarea proprietăţilor textului 
Schimbarea proprietăţilor textului multilinie: 
1. În bara cu instrumente Modify II selectaţi Edit Text. 
2. Selectaţi textul multilinie care începe cu 3" CAUSTIC. 
3. Schimbaţi textul 3" CAUSTIC în. .3" - CAUSTIC. 
4. Selectaţi liniile care încep cu From şi To: 
În submeniul Character selectaţi fontul RomanS. 
În câmpul Text Height tastaţi 1 pentru a seta înălţimea 

textului la 1". 
5. Selectaţi OK şi apoi ENTER pentru a încheia comanda. 
 
Modificarea proprietăţilor unui text 
Schimbarea proprietăţilor unei singure linii de text şi a unui 

text multilinie: 
1. Selectaţi un obiect de tip Single Line. 
2. În bara cu instrumente Standard selectaţi Properties. Este 

afişată fereastra Properties. 
3. Editaţi textul din câmpul Contents. Schimbările sunt 

implementate când selectaţi un alt câmp. 
4. Apăsaţi ESC de două ori pentru a deselecta obiectul text.  
5. Selectaţi un obiect de tip multilinie. 
6. Selectaţi Contents şi apoi selectaţi elipticul (...) pentru a 

deschide fereastra Multiline Text Editor. 
7. Selectaţi Justify şi apoi selectaţi o altă aliniere din listă 

pentru a schimba alinierea textului. 
 
Verificarea ortografiei 
Ortografia unei singure linii de text, a unui text multilinie 

sau a unui text de cotare poate fi verificată într-un desen. Puteţi 
încărca dicţionare personalizate şi puteţi adăuga ortografia şi 
termenii speciali, utilizaţi de dumneavoastră. 
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Comanda Spell 
Meniu: Tools>Spelling 
Linia de comandă: spell 
 
Introducere pentru verificarea ortografiei 
Verificarea ortografiei unui text selectat şi a textului de 

cotare: 
1. În meniul Tools selectaţi Spelling; 
2. Selectaţi textul din desen a cărui ortografie trebuie 

verificată;  
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3. Selectaţi Ignore sau Change pentru fiecare cuvânt care nu 
este în dicţionar. 

 

 
Observaţie: Selectaţi Change Dictionary pentru a folosi un alt 

dicţionar. 
4. Când verificarea ortografiei s-a încheiat, este afişat un 

mesaj. Selectaţi OK. 
Observaţie: Folosiţi un dicţionar personalizat pentru a 

adăuga termeni şi cuvinte tehnice. Un exemplu de dicţionar 
personalizat este fişierul sample.cus. 

 
Exerciţiul 5.5: Editarea textului. 
Folosirea capabilităţilor de editare a textului: 
1. Deschideţi un fişier model. 
2. Apăsaţi pe butonul, din dreapta; al mouse-ului pe orice, 

bară cu instrumente pentru a afişa meniul cursor, apoi selectaţi 
Modify II. 

3. În bara cu instrumente Modify II selectaţi Edit Text. 
4. Selectaţi un text  
5. Schimbaţi textul apoi selectaţi OK. 
6. Apăsaţi ENTER pentru a încheia comanda. 
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Verificarea ortografiei 
1. În meniul Tools selectaţi Spelling. 
2. Folosiţi o fereastră pentru a selecta toate obiectele din 

interiorul zonei North.-South Section. 
3. Este afişată fereastra de dialog Check Spelling. 
 Selectaţi Change pentru a corecta ortografia cuvintelor 

scrise 
 Selectaţi Ignore pentru toate celelalte sugestii de 

schimbare. 
4. După ce ati terminat, selectaţi OK. 
5. Salvaţi desenul. 
 
 
Exerciţiul 13.2.1. Schema instalaţiei tip CVD şi principalele 

reacţii chimice ale procesului de depunere a TiC şi TiN (desenaţi 
proporţional, fară cote de execuţie) 
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TiCl4 + CH4 = TiC + 4HCl 

 2TiCl4 + N2 + 4H2 = 2TiN + 8HCl 

2AlCl3 + 3H2O = Al2O3 + 6HCl  

2AlCl3 + 3CO2 + 3H2 = Al2O3 + 3CO 6HCl 
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LUCRAREA 6 COMENZI DE EDITARE I 

 
 

6.1. Editarea obiectelor prin deplasare 
 
Obiectele pot fi editate folosind numeroase metode. Acestă 

lucrare se ocupă de editarea obiectelor folosind Copy, Mirror, Offset, 
Array, Move şi Rotate. Aceste comenzi au efect asupra obiectelor din 
setul de selecţie curent. 

 
Termeni cheie: Editarea prin deplasare 
Base Point - Un sistem de coordonate XY temporar, folosit ca 

referinţă pentru comenzi ca Move şi Copy. 
Displacement - distanţa dintre punctul de bază şi cel de-al 

doilea punct în comenzi ca Move şi Copy. 
Rectangular array - creează copii ale obiectelor pe linii şi 

coloane. 
Polar array - creează copii ale obiectelor, într-un model 

circular în jurul punctului de bază. 
 
Comanda Copy 
Bara cu instrumente: Modify>Copy 
 

 
Meniu: Modify>Copy 
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Linia de comandă: copy 
 
Comanda Move 
Bara cu instrumente: Modify> Move 
 

 
Meniu: Modify> Move 

 
Linia de comandă: move 
 
 
6.1.1. Deplasarea obiectelor 
 
Deplasarea şi copierea obiectelor: 

1. În bara cu instrumente Modify selectaţi Move.  
2. Creaţi un set de selecţie. 
3. Selectaţi un punct de început. 
4. Selectaţi un al doilea punct. 
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Înainte şi după deplasare 

 
5.În bara cu instrumente selectaţi Copy. 
6. Creaţi un set de selecţie. 
7. În linia de comandă tastaţi m, apoi, apăsaţi ENTER. 
8. Specificaţi un punct de început. 
9. Specificaţi un al doilea punct. 
10. Specificaţi punctele finale pentru fiecare copie.  
 

 
 

Înainte şi după copierea multiplă 
 
 
Exerciţiul 6.1: Copierea obiectelor 
 
Creaţi desenul unei piese folosind comenzile Move şi Copy.  
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1.Deschideţi un fişier model. 
 

 
Desenul complet 

 
2. Apăsaţi butonul drept al mouse-ului în desen şi selectaţi 

Options, apoi: 
 Selectaţi Tab-ul Selection. 
 În Selection Modes activaţi Noun/Verb Selection şi Implied 

Windowing. 
 Selectaţi OK. 
3. Activaţi Snap şi Grid cu paşi de 10 unităţi. Selectaţi OK. 
4. Desenaţi conturul exterior urmând paşii: 
 Activaţi comanda Pline; 
 Selectaţi un punct în desen ca punct de pornire şi apoi 

ENTER; 
 Tastaţi a pentru a trece în modulul arc şi apoi ENTER; 
 Tastaţi a pentru a alege unghiul arcului şi apoi ENTER; 
 Tastaţi 180 şi apoi ENTER; 
 Tastaţi r pentru a alege raza arcului şi apoi ENTER; 
 Tastaţi 10 pentru raza arcului şi apoi ENTER; 
 Tastaţi 0 pentru direcţia corzii şi apoi ENTER (am realizat 

primul arc); 
 Tastaţi a pentru a alege unghiul arcului şi apoi ENTER; 
 Tastaţi -90 şi apoi ENTER; 
 Tastaţi r pentru a specifica raza arcului de cerc 
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 Tastaţi 20 pentru raza arcului şi apoi ENTER  
 Tastaţi 45 pentru a specifica direcţia corzii ce subîntinde 

arcul (am realizat al doilea arc); 
 Tastaţi l pentru a trece în modulul linie şi apoi ENTER; 
 Tastaţi l pentru a alege length (lungimea segmentului) şi 

apoi ENTER; 
 Tastaţi 30 şi apoi ENTER; 
 Tastaţi a pentru a trece în modul arc şi apoi ENTER; 
 Tastaţi a pentru a alege unghiul arcului şi apoi ENTER; 
 Tastaţi 180 şi apoi ENTER; 
 Tastaţi r pentru a alege raza arcului şi apoi ENTER; 
 Tastaţi 20 pentru raza arcului şi apoi ENTER; 
 Tastaţi 0 pentru direcţia corzii şi apoi ENTER (am realizat 

arcul din dreapta jos); 
 Tastaţi l pentru a trece în modul line şi apoi ENTER; 
 Tastaţi l pentru a alege length (lungimea segmentului) şi 

apoi ENTER; 
 Tastaţi 30 şi apoi ENTER; 
 Tastaţi a pentru a trece în modul arc şi apoi ENTER; 
 Tastaţi a pentru a alege unghiul arcului şi apoi ENTER; 
 Tastaţi 180 şi apoi ENTER; 
 Tastaţi r pentru a alege raza arcului şi apoi ENTER; 
 Tastaţi 20 pentru raza arcului şi apoi ENTER; 
 Tastaţi 180 pentru direcţia corzii şi apoi ENTER (am 

realizat arcul din dreapta sus); 
 Tastaţi l pentru a trece în modul line şi apoi ENTER; 
 Tastaţi @-30,0 (poziţia relativă a celui de al doilea punct al 

segmentului) şi apoi ENTER; 
 Tastaţi a pentru a trece în modulul arc şi apoi ENTER; 
 Tastaţi a pentru a alege unghiul arcului şi apoi ENTER; 
 Tastaţi -90 şi apoi ENTER; 
 Tastaţi r pentru a alege raza arcului şi apoi ENTER; 
 Tastaţi 20 pentru raza arcului şi apoi ENTER; 
 Tastaţi 135 pentru direcţia corzii şi apoi ENTER (am 

realizat arcul din stânga sus); 
 Tastaţi a pentru a alege unghiul arcului şi apoi ENTER; 
 Tastaţi 180 şi apoi ENTER; 
 Tastaţi r pentru a alege raza arcului şi apoi ENTER; 
 Tastaţi 10 pentru raza arcului şi apoi ENTER; 



Comenzi de editare I 

 129 

 Tastaţi 180 pentru direcţia corzii şi apoi ENTER (am 
realizat arcul din stânga sus); 

 Tastaţi l pentru a trece în modul line şi apoi ENTER; 
 Tastaţi c pentru a închide conturul exterior cu un 

segment de dreaptă şi apoi ENTER; 
5. Desenaţi cercul mic din stânga jos: 
 Selectaţi comanda circle; 
 Stabiliţi cu ajutorul cursorului (Snap, Grid şi Osnap fiind 

active) centrul arcului de cerc şi apoi ENTER; 
 Tastaţi 5 pentru raza cercului şi apoi ENTER; 
6. Multiplicaţi cercul mic: 
 Selectaţi comanda copy; 
 Selectaţi cercul mic şi apoi ENTER; 
 Selectaţi m pentru a multiplica cercul şi apoi ENTER; 
 Stabiliţi ca punct de bază pentru deplasarea copiilor 

centrul cercului cu ajutorul OSNAP-ului activat. 
 Stabiliţi centrele viitoarelor copii şi apoi ENTER; 
7. Desenaţi poligonul: 
 Selectaţi comanda polygon; 
 Stabiliţi numărul de laturi 6 şi apoi ENTER; 
 Stabiliţi cu ajutorul cursorului (Snap, Grid şi Osnap fiind 

active) centrul arcului de cerc şi apoi ENTER; 
 Tastaţi c şi apoi ENTER; 
 Tastaţi 10 pentru raza cercului şi apoi ENTER; 
8. Desenaţi cercul înscris în poligon: 
 Selectaţi comanda circle; 
 Stabiliţi cu ajutorul cursorului (Snap, Grid şi Osnap fiind 

active) centrul şi apoi ENTER; 
 Tastaţi 10 pentru raza cercului şi apoi ENTER; 
9. Multiplicaţi poligonul şi cercul: 
 Selectaţi comanda copy; 
 Selectaţi ambele entităţi (cu o fereatră de selecţie de la 

dreapta la stânga) şi apoi ENTER; 
 Stabiliţi un punct de bază pentru deplasarea copiilor. 
 Stabiliţi centrul copiei şi apoi ENTER; 
10. Salvaţi desenul. 
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6.1.2. Copierea cu ajutorul Clipboard-ului 
 
Secţiunea precedentă descrie cum pot fi copiate obiectele 

folosind comanda Copy. Obiectele pot fi de asemenea copiate 
folosind Windows Clipboard. 

 
Termeni cheie: Copierea folosind Clipboard-ul 
Clipboard - un spaţiu temporar de stocare în memoria activă 

a calculatorului. 
Obiectele AutoCAD pot fi copiate sau mutate folosind 

Clipboard-ul. 
Cut - copie obiectele în Clipboard şi le şterge din desen. 
Copy - copie obiectele în Clipboard fără a modifica 

configuraţia curentă a desenului. 
Paste - inserează date din Clipboard într-un desen AutoCAD. 
 
Copierea obiectelor folosind Clipboard-ul. 
Copierea obiectelor folosind comenzile Copyclip şi Pasteclip: 
1. Creaţi un set de selecţie. 
2. Apăsaţi cu butonul din dreapta în fereastra desenului şi 

apoi selectaţi Copy. 
3. Apăsaţi cu butonul din dreapta în fereastra desenului şi 

apoi selectaţi Paste. 
4. Selectaţi un punct, din desen pentru a insera o copie a 

setului de selecţie. 
 
Folosirea comenzilor Cut/Copy şi Paste 
 
Pentru o utilizare eficientă a comenzilor standard cut/copy şi 

paste, aveţi la dispoziţie câteva facilităţi în plus care oferă 
posibilitatea de a plasa obiecte cu o mai mare precizie. 

Accesul la comenzile cut/copy şi paste: 
 Introducerea standard de la tastatură. Pentru a copia 

obiecte apăsaţi tastele CTRL+C. 
 Meniul Edit 
 Meniul cursor implicit. 
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Opţiuni adiţionale la Copy şi Paste 
Copy With Basepoint - puteţi copia obiecte cu un punct de 

bază specificat pentru transferare într-un nou desen. Copy With 
Base point este de asemenea disponibil de la linia de comandă. 

 
Linia de comandă: copybase 
 
Paste to Original Coordinates - puteţi transfera obiecte 

dintr-un desen în altul cu păstarea aceloraşi coordonate ca în 
desenul original. Paste to Original Coordinates este de asemenea 
disponibil în linia de comandă. 

 
Linia de comandă: pasteorig 
 
Preluare şi deplasare de obiecte (Drag and Drop) 
Alături de comenzile cut/copy şi paste, puteţi prelua şi 

deplasa obiecte în: 
 Altă poziţie din acelaşi desen. 
 Alt desen din aceeaşi sesiune. 
 Alt desen din altă sesiune. 
 Altă aplicaţie, ca Microsoft Word sau Microsoft Excel 

 
Prezentarea comenzilor pentru preluare şi deplasare  
A. Butonul din stânga al mouse-ului 
Folosirea butonului din stânga al mouse-ului pentru preluare 

şi deplasare: 
 Creaţi un set de selecţie. 
 Mutaţi mouse-ul peste un obiect din setul de selecţie şi 

apăsaţi butonul stâng al mouse-ului. 
 Mutaţi cursorul de lângă setul de selecţie ţinând în 

continuare, butonul stâng apăsat; cursorul îşi modifică 
forma: 

 Deplasaţi prin tragere obiectele la poziţia specificată. 
 
Observaţie: Puteţi copia obiectele în cadrul 

aceluiaşi desen prin ţinerea apăsată a tastei CTRL. 
Obiectele mutate în alt desen vor fi de asemenea 
copiate. 
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B. Butonul din dreapta al mouse-ului 
Folosirea butonului din dreapta al mouse-ului pentru 

preluare şi deplasare: 
 Selectaţi obiectele folosind metodele standard ale setului 

de selecţie. 
 Mutaţi mouse-ul peste un obiect din setul de selecţie şi 

daţi drumul la butonul drept al mouse-ului. 
 Mutaţi cursorul de lângă setul de selecţie ţinând în 

continuare apăsat butonul drept; cursorul îşi modifică 
forma. 

 Mutaţi prin tragere obiectele la poziţia specificată. 
 Când daţi drumul la butonul mouse-ului va fi afişat un 

meniu. Meniuri diferite vor fi afişate dacă luaţi şi mutaţi 
obiecte în acelaşi desen sau în unul diferit. 

 Selectaţi o opţiune pentru a localiza obiectele. 

Observaţie: Cursorul nedisponibil o este afişat 
când încercaţi să deplasaţi obiecte într-o altă sesiune AutoCAD care 
are deschisă o comandă. 

 
6.2. Comenzile Offset şi Array 
 
Noi obiecte pot fi create din obiecte deja existente, plasate la 

o distanţă specificată folosind comanda Offset. 
Pot fi multiplicate obiecte existente din desen cu dispunerea 

copiilor pe rânduri şi coloane sau pe un cerc, folosind comanda 
Array. 

 
Comanda Offset 
Bara cu instrumente: Modify>Offset 
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Meniu: Modify>Offset  

 
 
Linia de comandă: offset 
 
Comanda Array 
Bara cu instrumente: Modify> Array  
 

 
Meniu: Modify> Array 
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Linia de comandă: array 
 
Utilizarea comenzilor Offset şi Array 
 
Crearea unui obiect folosind comanda Offset şi apoi crearea 

unor copii multiple folosind comanda Array: 
1. În bara cu instrumente Modify selectaţi Offset, apoi: 
 În linia de comandă tastaţi 5 pentru a introduce distanţa 

la care va fi copiat obiectul. 
 Selectaţi obiectul de copiat. 
 Specificaţi partea în care doriţi să copiaţi obiectul, apoi 

apăsaţi ENTER. 

 
Duplicarea conturului exterior prin comanda offset 

 
 
2.:Copiaţi de pe desenul anterior unul din cele doua 

reprezentari ale capului surubului apoi: 
 În bara cu instrumente Modify selectaţi Array. 
 Selectaţi obiectul de multiplicat şi apoi apăsaţi ENTER. 
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 Apăsaţi pe butonul din dreapta al mouse-ului în fereastra 
de desenare şi apoi selectaţi Polar. 

 Selectaţi punctul central în jurul căruia realizaţi copierea. 
 Tastaţi 5 la prompterul Number of items. 
 Apăsaţi ENTER pentru a accepta unghiul implicit de 360. 
 Apăsaţi ENTER a accepta opţiunea de rotire a obiectelor 

copiate. 
 

 
 
Exerciţiul 6.2: Utilizarea comenzilor Offset şi Array 
Realizaţi desenul de mai jos in AUTOCAD folosind comenzile 

invăţate: Copy/Move, Offset, Array.  
 



Lucrarea 6 

 136 

 
 
 

6.3. Oglindirea obiectelor 
În timpul procesului de desenare, formele pot fi desenate 

rapid prin crearea unei jumătăţi din desen şi apoi prin oglindirea 
setului de selecţie pentru a completa întregul. 

 
Termeni cheie: Oglindirea 
Mirror line - o linie bidimensională din planul XY al UCS-

ului curent. Obiectele sunt oglindite în raport cu această linie. 
 
Comanda Mirror 
Bara cu instrumente: Modify> Mirror 

 
Meniu: Modify> Mirror 
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Linia de comandă: mirror 
 
Oglindirea obiectelor  
Oglindirea obiectelor pentru a crea desenul unei piese: 
În bara cu instrumente Modify selectaţi Mirror, apoi: 
 Creaţi un set de selecţie a obiectelor de oglindit. 
 Specificaţi primul şi cel de-al doilea punct al liniei de 

oglindire. 
 Apăsaţi pe butonul din dreapta al mouse-ului în fereastra 

de desenare şi apoi selectaţi No, pentru ca desenul 
original să nu fie şters. 
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Observaţie: Pentru desenul de mai sus obiectele oglindite 

sunt cu linie continuă înaintea încheierii comenzii de oglindire. 
 
.4. Rotirea obiectelor 
Poziţia unghiulară în jurul unui punct numit centru de 

rotaţie poate fi obţinută prin rotirea obiectelor. 
Termeni cheie: Rotire 
Rotation Angle - o valoare absolută sau relativă pentru a 

roti obiectele. 
 
Comanda Rotate 
Bara cu instrumente: Modify> Rotate  

 
 

Meniu: Modify> Rotate 

 
 
Linia de comandă: rotate 
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Rotirea obiectelor 
Rotirea obiectelor într-o nouă poziţie: 
În bara cu instrumente Modify, selectaţi Rotate, apoi: 
 Creaţi un set de selecţie format din obiectele ce trebuiesc 

rotite. 
 Specificaţi ca centru de rotaţie piciorul bradului. 
 În linia de comandă tastaţi 35 pentru valoarea unghiului 

de rotaţie. 

 
Obiectul original şi cel rotit 

 
Exerciţiul 6.3: Crearea desenului unei piese folosind 

comenzile de editare 
Realizaţi desenele de mai jos: 
 
Activaţi/dezactivaţi comenzile Osnap, Grid, Snap, Ortho şi 

folosiţi comenzile de editare învăţate. 
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Exerciţiul 6.4: Crearea desenului flanşei din imaginea 
urmatoare. 
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LUCRAREA 7 COMENZI DE EDITARE II 

 
 

7.1. Editarea obiectelor prin redimensionare 
În secţiunea precedentă obiectele erau editate prin 

deplasarea lor din poziţia curentă prin mutare sau rotire. 
În această secţiune sunt descrise comenzile de editare care 

au ca efect mărimea totală a obiectelor folosind comenzile Scale, 
Stretch, Lengthen. 

 
7.1.1. Comanda Scale 
 
Termeni cheie: Redimensionare 
Scale factor - mărirea şi micşorarea obiectelor pe baza unei 

valori numerice. Valorile supraunitare măresc obiectul, iar cele 
subunitare îl micşorează.  

Reference - folosirea mărimii unui obiect existent pentru a 
scala un alt obiect. 

Comanda Scale 
Bara cu instrumente: Modify>Scale 
 

 
Meniu: Modify>Scale 

 



Lucrarea 7 

 116 

Linia de comandă: scale 
 
Scalarea obiectelor 

 
Obiectul înainte şi după scalare 

 

În bara cu instrumente Modify selectaţi Scale , apoi: 
 Creaţi un set de selecţie cuprinzând obiectele ce trebuiesc 

scalate, apoi apăsaţi ENTER. 
 Specificaţi un punct de bază. 
 În linia de comandă tastaţi 1.5 pentru factorul de scalare. 

 

Factor de scalare este un factor multiplicare cu 
care se inmultesc toate dimensiunile desenului. Astfel dacă acest 
factor este mai mare decat 1 desenul va fi mai mare decât originalul 
iar dacă este mai mic decat 1, desenul va fi mai mic decât desenul 
original. Bineînţeles, dacă factorul este 1 atunci desenul pastrează 
aceleaşi dimensiuni ca cele ale desenului original. 

 
7.1.2. Întinderea (deformarea) obiectelor 
Scalarea obiectelor prin valori egale pe axele X şi Y s-ar putea 

să nu satisfacă cerinţele de editare. Folosind o selecţie de tip 
fereastră prin intersectare sau poligon prin intersectare, obiectele 
pot fi întinse faţă de un punct de bază. 
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Comanda Stretch 
Bara cu instrumente: Modify>Stretch 

 
Meniu: Modify> Stretch 

 
Linia de comandă: Stretch 
 
Întinderea obiectelor 
Crearea unui set de selecţie folosind o selecţie de tip fereastră 

prin intersectare şi apoi redimensionarea obiectelor prin întindere: 

În bara cu instrumente Modify selectaţi Stretch , apoi: 
 Creaţi un set de selecţie folosind o selecţie de tip fereastră 

prin intersectare. 
 Specificaţi un punct de bază. 
 Trageţi cursorul spre dreapta 6 de unităţi pentru a întinde 

obiectele. 
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Obiectul înainte şi după întindere 

 

 
Observaţie: Folosiţi Polar Tracking sau modul Ortho pentru a 

întinde obiectele pe verticală sau orizontală. 
Pentru a redimensiona prin comanda Stretch trebuie ca cel 

puţin un element sa ramână neselectat, acesta fiind şi elemental 
care nu se va modifica. 

Notă: Dimensiunea nouă este reafişată automat la valoarea 
curentă prin editarea obiectelor pe care le cotează. Aceasta se 
numeşte redimensionare asociativă. 

 
7.1.3. Lungirea obiectelor 
În general, comenzile de editare pot fi folosite pe obiecte 

închise sau deschise. Comanda Lenghten poate fi aplicată numai 
obiectelor deschise, ca arce, linii sau polilinii deschise. 

 
Temeni cheie: Lungire 
Open objects - obiecte care nu alcătuiesc o formă închisă. 

De exemplu o linie este un obiect deschis, în timp ce un dreptunghi 
este un obiect închis. 

Delta length - un increment specificat la linia de comandă 
sau prin selectarea a două puncte. 

Dynamic dragging - mutarea unui capăt al unui obiect prin 
tragerea cursorului. Noua poziţie a obiectului este afişată dinamic. 
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Comanda Lenghten 
Bara cu instrumente: Modify> Lenghten 

 
Meniu: Modify> Lenghten 

 
Linia de comandă: Lengthen 
 
Lungirea obiectelor 
Editarea unghiului la centru al unui arc: 

În bara cu instrumente Modify selectaţi Lenghten , apoi: 
 Selectaţi arcul. Lungimea curentă şi unghiul la centru al 

arcului sunt afişate în linia de comandă.  
 Apăsaţi pe butonul din dreapta al mouse-ului în fereastra 

de desenare, apoi selectaţi Total. 
 Apăsaţi pe butonul din dreapta al mouse-ului în fereastra 

de desenare, apoi selectaţi Angle. 
 În linia de comandă tastaţi 180, apoi apăsaţi ENTER.  
 Selectaţi arcul pentru a edita unghiul la centru. 
 Apăsaţi ENTER pentru a ieşi din comandă.  
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Obiectul înainte şi după lungire 

 
7.2. Extinderea obiectelor 
 
Obiectele pot fi extinse până la o limită specificată de 

utilizator. Obiectele includ linii, arce, arce eliptice, cercuri, polilinii 
deschise 2D şi 3D şi linii ajutătoare cu un capăt finit. 

 
Termeni cheie: Extindere  
Boundary - limita până la care vor fi extinse celelalte obiecte 

şi care este de obicei un alt obiect. 
Projection mode - cele trei metode posibile de extindere a 

obiectelor. Acestea sunt none (nici una), UCS şi view (vedere). 
Edge - există două opţiuni care determină dacă un obiect 

poate fi extins sau nu, Opţiunea Extend va extinde obiectul până la 
o limită implicită. Opţiune a No Extend va extinde numai obiectele 
pentru care există un punct de intersecţie cu limita. 

 
Comanda Extend 
Bara cu instumente: Modify> Extend 

 
 
Meniu: Modify> Extend 
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Linia de comandă: Extend 
 
Extinderea obiectelor  
Extinderea obiectelor până la o limită: 
 

 
 

 În bara cu instrumente Modify selectaţi Extend. 
 Selectaţi arcul de cerc fiind limita de extindere (boundary 

edge). 
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 Apăsaţi Enter (am terminat selecţia) 
 Selectaţi obiectele de extins unul cate unul (fiecare 

segment in parte). 
 

 
liniile extinse până la limita granitelor 

 
 
7.3. Tăierea obiectelor 
 
Obiectele pot fi tăiate folosind un obiect drept limită de tăiere. 

Obiectele includ linii, arce, arce eliptice, cercuri, polilinii deschise 
2D şi 3D şi linii radiale. 

 
Termeni cheie: Tăiere 
Cutting edge - marginea de la care vor fi tăiate celelalte 

obiecte. 
Projection mode - cele trei metode posibile de extindere a 

obiectelor. Acestea sunt None, UCS şi View. 
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Edge - sunt două opţiuni care determină dacă un obiect 
poate fi extins sau nu. Opţiunea Extend va extinde obiectul până la 
o margine implicită. Opţiunea No Extend va extinde numai obiectele 
pentru care există un punct de intersecţie. 

 
Comanda Trim 
Bara cu instrumente: Modify> Trim 

 
Meniu: Modify> Trim 

 
Linia de comandă: Trim 
 
Tăierea obiectelor 
Tăierea a două obiecte folosind o limită de tăiere: 

1. În bara cu instrumente selectaţi Trim . 
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2. Selectaţi limita de tăiere (cercul). 
 

 
 

3. Selectaţi un singur obiect de tăiat prin selectarea părţii pe 
care doriţi să o tăiaţi. 

 

 
liniile tăiate pâna la limita de tăiere 
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Observaţie: Când sunt mai multe obiecte de tăiat 
folosiţi opţiunea Fence pentru a crea un set de selecţie. 

 
Observaţie: Pentru creşterea vitezei de lucru când folosiţi 

comenzile Trim sau Extend se pot selecta toate obiectele din desen 
ca limite de tăiere. 

Acest lucru se poate face apăsând ENTER la cererea Select 
Objects. 

 
 
Exerciţiul 7.1.: Completarea planului unui nivel folosind 

comenzile de editare 
Completaţi planul unui nivel a unei clădiri, folosind 

comenzile Offset, Trim, Copy şi Stretch.  
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Crearea perimetrului  
1. Deschideţi un fişier model. 
2. Cu ajutorul comenzii pline desenăm conturul exterior. 

 
 

3. În bara cu instrumente Modify selectaţi Offset, apoi: 
 Tastaţi 1 ca distanţă de copiere, apoi apăsaţi ENTER. 
 Selectaţi conturul exterior al clădirii şi apoi selectaţi un 

punct din interiorul clădirii. 

 
 

4. În bara cu instrumente Modify: 
 Selectati Explode. 
 Selectaţi cele două linii exterioare şi apoi apăsaţi ENTER 

pentru a desface entităţile polilinie în segmente ce 
reprezintă fiecare în parte o entitate separată. 
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5. În bara cu instrumente Modify selectaţi Offset, pentru a 
desena peretele interior de jos: 

 Tastaţi 20 ca distanţă de copiere, apoi apăsaţi ENTER. 
 Selectaţi marginea exterioară de jos a liniei exterioare, 

apoi selectaţi un punct din interiorul clădirii. 
 Apăsaţi ENTER. 
6. Repetaţi comanda Offset, apoi: 
 Tastaţi 2 ca distanţă de copiere, apoi apăsaţi ENTER. 
 Selectaţi ultima linie creată pentru a o copia şi apoi 

selectaţi un punct din interiorul clădirii. 
 Apăsaţi ENTER. 
 Folosind EXTEND prelungiţi linia de sus a peretelui din 

mijloc până la peretele din dreapta. 

 
7. Apăsaţi pe butonul din dreapta al mouse-ului în linia de 

comandă, selectaţi Recent Commands apoi selectaţi Offset pentru a 
desena peretele interior de sus: 

 Tastaţi 30 ca distanţă de copiere, apoi apăsaţi ENTER. 
 Selectaţi marginea exterioară de jos a liniei exterioare, 

apoi selectaţi un punct din interiorul clădirii. 
 Apăsaţi ENTER. 
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  
8. Repetaţi comanda Offset, apoi: 
 Tastaţi 2 ca distanţă de copiere, apoi apăsaţi ENTER. 
 Selectaţi noul obiect pentru a-l copia şi apoi selectaţi un 

punct de deasupra liniei anterior create (pentru a indica 
partea pe care dorim să poziţionăm copia). 

 Apăsaţi ENTER. 
 

 
9. Apăsaţi pe butonul din dreapta al mouse-ului în linia de 

comandă, selectaţi Recent Commands apoi selectaţi Offset pentru a 
desena peretele interior vertical: 

 Tastaţi 40 ca distanţă de copiere, apoi apăsaţi ENTER. 
 Selectaţi marginea exterioară din dreapta a desenului, 

apoi selectaţi un punct din interiorul clădirii. 
 Apăsaţi ENTER. 
10. Repetaţi comanda Offset, apoi: 
 Tastaţi 2 ca distanţă de copiere, apoi apăsaţi ENTER. 
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 Selectaţi noul obiect pentru a-l copia şi apoi selectaţi un 
punct din partea dreaptă a linei anterior create. 

 Apăsaţi ENTER. 

 
 

11. În bara cu instrumente Modify selectaţi Trim, apoi: 
 Apăsaţi ENTER pentru a selecta toate obiectele care vor 

realiza tăierea astfel încât să rezulte conturul pereţilor 
uniform. 

 Selectaţi obiectele ce trebuiesc tăiate, apoi apăsaţi ENTER. 

Observaţie : Pentru a avea o precizie mai mare în 
selectarea liniilor ce trebuiesc tăiate folosiţi Zoom pentru a mări 
zonele de selecţie ale desenului. 
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12. Realizarea uşilor: Se face tot cu ajutorul comenzii offset, 

folosind cotele de pe desen. Exemplu: realizarea uşii interioare din 
partea stângă jos:  

 Selectaţi comanda offset pentru copierea segmentului din 
partea de exterioara stângă. 

 Tastaţi 17 ca distanţă de copiere, apoi apăsaţi ENTER. 
 Selectaţi segmentul exterior din partea stângă a desenului 
 Sectaţi un punct din interiorul desenului 
 Apăsaţi ENTER. 
Repetaţi comanda Offset, apoi: 
 Tastaţi 3 ca distanţă de copiere (deschiderea uşii), apoi 

apăsaţi ENTER. 
 Selectaţi noul obiect pentru a-l copia şi apoi selectaţi un 

punct din partea dreaptă a linei anterior create. 
 Apăsaţi ENTER. 
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11. În bara cu instrumente Modify selectaţi Trim, apoi: 
 Apăsaţi ENTER pentru a selecta toate obiectele care vor 

realiza tăierea astfel încât să rezulte conturul pereţilor 
uniform. 

 
Repetaţi comenzile anterioare şi pentru celelalte uşi şi gasiţi 

cotele care caracterizează fiecare uşă: 
 

 
7.4. Editarea obiectelor prin modificare 
 
Cele două secţiuni precedente au trecut în revistă comenzile 

de editare pentru deplasare, copiere sau redimensionare a 
obiectelor. Această secţiune va arăta cum pot fi folosite comenzile 
Fillet, Chamfer sau Break pentru a edita obiecte deja existente. 

 
Termeni cheie: Modificarea obiectelor 
Fillet - un colţ rotunjit (racordat) creat din obiecte deja 

existente. 
Chamfer - un colţ teşit creat între obiecte deja existente. 
 
Comanda Fillet 
Bara cu instrumente: Modify> Fillet 

 
Meniu: Modify> Fillet 
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Linia de comandă: Fillet 
 
Comanda Chamfer 
Bara cu instrumente: Modify> Chamfer 

 
Meniu: Modify>Chamfer 
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Linia de comandă: Chamfer 
 
7.4.1. Racordarea obiectelor 
 
Racordarea a două linii: 

1. În bara cu instrumente Modify selectaţi Fillet , apoi: 
 Apăsaţi pe butonul din dreapta al mouse-ului în fereastra 

de desenare, apoi selectaţi Radius. 
 În linia de comandă tastaţi 5, apoi apăsaţi ENTER. 
2. Repetaţi comanda Fillet, apoi selectaţi cele două linii 

pentru a face racordare. 

  
3. Repetaţi comanda Fillet pentru a racorda colţurile rămase. 
 
Opţiunea Trim/No Trim 
Setările implicite-pentru comanda Fillet taie ambele obiecte 

pentru a crea racordarea. Pentru a menţine obiectele nemodificate 
folosiţi opţiunea No Trim. 
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Racordarea cercurilor şi a arcelor 
Pentru a adăuga o racordare la cercuri sau arce folosiţi 

aceeaşi procedură ca pentru linii. Punctul selectat de pe cerc sau 
arc determină amplasarea racordării. În unele cazuri sunt posibile 
mai multe soluţii. 

Pentru mai multe informaţii privind aceste opţiuni consultaţi 
în Help subiectul Filleting Objects 

 
 
Racordarea liniilor şi a poliliniilor 
Obiectele care au fost create folosind linii sau polilinii pot 

avea o racordare adăugată la un colţ de intersecţie sau la intersecţia 
unei linii sau polilinii când acestea sunt extinse. Linia şi racordul 
sunt adăugate la o linie dacă este activată opţiunea Trim. 

La racordarea unei polilinii formate din mai multe segmente, 
va fi creată o racordare la fiecare vertex, dacă este îndeplinită 
condiţia ca segmentul să fie mai mare sau cel puţin egal cu dublul 
razei de racordare. 

 
Racordarea liniilor paralele 
Liniile paralele pot fi unite folosind comanda Fillet. Distanţa 

dintre liniile paralele este folosită ca rază de racordare, fără a se lua 
în considerare valoarea curentă a razei. 
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Liniile originale şi liniile unite prin semicerc folosind comanda 

Fillet 

Observaţie: Folosiţi o rază de racordare de 0 (zero) 
pentru a tăia sau extinde două obiecte până la punctul lor de 
intersecţie. 

Exemplu: Desen iniţial în stânga iar în dreapta realizarea 
îmbinărilor s-a făcut cu ajutorul comenzii Fillet cu raza r=0. 

       
 
7.4.2.Teşirea obiectelor  
Teşirea a două linii: 

1. În bara cu instrumente Modify selectaţi Chamfer , apoi: 
 Apăsaţi pe butonul din dreapta al mouse-ului în fereastra 

de desenare, apoi selectaţi Distance. 
 În linia de comandă tastaţi 6 pentru a introduce prima 

distanţă de teşire. 
 Tastaţi 3 pentru a introduce a doua distanţă de teşire. 
2. Repetaţi comanda Chamfer, apoi selectaţi cele două obiecte 
pentru a realiza teşirea. 
Opţiunea Trim/No Trim 
Această opţiune este similară cu cea a comenzii Fillet. Pentru 

a păstra obiectele selectate nemodificate folosiţi opţiunea No Trim. 
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Obiectul înainte şi după teşire cu opţiunea No Trim şi cu opţiunea Trim 

 
Teşirea liniilor şi a poliliniilor 
Obiectele care au fost create folosind linii sau polilinii pot 

avea o teşire adăugată la un colţ de intersecţie sau la intersecţia 
unei linii sau polilinii când acestea sunt extinse. Linia şi teşirea 
sunt adăugate, la polilinie dacă este activată opţiunea Trim. 

 
Teşirea unei polilinii 
La teşirea unei polilinii formate din mai multe segmente, va fi 

creată o teşire la fiecare vertex, dacă segmentul este destul de lung 
pentru a permite această operaţie. 

 
 
7.5. Comanda Break 
O parte dintr-un obiect poate fi îndepărtată cu ajutorul 

comenzii Break. Obiectele pot fi: linii, cercuri, arce, linii ajutătoare 
şi raze. 

 
Comanda Break 
Bara cu instromente: Modify> Break 

 
Meniu: Modify> Break 

Mihai
Highlight

Mihai
Highlight

Mihai
Note
tesirile de pe 2 si 3 au valori diferite
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Linia de comandă: Break 
 
Ştergerea unei părţi a unui obiect folosind comanda 

Break: 
Îndepărtarea unei părţi dintr-un obiect folosind comanda 

Break: 
În bara cu instrumente Modify selectaţi Break apoi: 
 Selectaţi orice punct de pe obiect. 
 Tastaţi f apoi selectaţi un punct pentru a specifica prima 

limită de ştergere. 
 Selectaţi un al doilea punct pentru a şterge partea din 

obiect cuprinsă între cele două puncte selectate. 
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Editarea folosind manipulatoarele (Grips) 
Editarea obiectelor necesită în mod obişnuit crearea unui set 

de selecţie şi folosirea unor comenzi de editare ca Move sau Copy. 
Manipulatoarele pun la dispoziţie o altă metodă de editare a 
obiectelor. Folosind acestea, obiectele pot fi întinse, mutate, rotite, 
scalate şi oglindite. 

Termeni cheie: Manipulatoare 
Base grip - manipulatorul selectat pentru a fi punctul de 

bază al editării. 
Noun/Verb Selection - la folosirea manipulatoarelor, sunt 

selectate mai întâi obiectele.  
Grip size - mărimea efectivă a unui manipulator este 

măsurată în pixeli aceasta poate fi setată din fila Selection din 
fereastra de dialog Options. 

Grip color - culoarea manipulatoarelor selectate şi 
neselectate; aceasta poate fi setată din fila Selection din fereastra de 
dialog Options. 

 
Folosirea manipulatoarelor 
Întinderea unei linii folosind manipulatoarele: 
1. În fila Selection din fereastra de dialog Options asiguraţi-vă 

că Enable Grips este activat. 
2. Selectaţi cele două linii care trebuiesc modificate. 

Manipulatoarele vor fi afişate pe acestea. 

 
2. Selectaţi un manipulator pentru a-l face manipulator de 

bază, apoi deplasaţi cursorul spre dreapta. Obiectele sunt 
întinse. 
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4. Apăsaţi ESC de două ori pentru a îndepărta 

manipulatoarele. 
 
Exerciţiul 7.3. Folosirea manipulatoarelor  
 
Vizualizaţi poziţia manipulatoarelor pe obiecte. 
1. Deschideţi un fişier model. 
2. Asiguraţi-vă că Noun/Verb Selection şi Enable Grips sunt 
activate.  
3. Selectaţi fiecare dintre obiectele din desen şi observaţi 

poziţia manipulatoarelor. 
4. Selectaţi un manipulator şi observaţi ca acesta devine 

roşu.  
5. Apăsaţi tasta ENTER pentru a initializa editarea selecţiei. 
6. Apoi folosiţi variate metode de editare prin apasarea 

butonului din dreapta al mouse-ului în aria de desenare sau prin 
folosirea comenzilor de la tastatura si a opţinilor din linia de 
comandă. 

Observaţie: Selectaţi un manipulator şi folosiţi 
meniul care apare la apăsarea butonului din dreapta al mouse-ului 
pentru a afişa opţiunile de editare folosind manipulatoarele. 

5. Salvaţi desenul. 
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Exemplu: folosirea manipulatoarelor pentru copierea 
obiectelor 

Creaţi o altă entitate folosind comenzile Copy şi Mirror. 
1. Folosiţi comenzile Pan şi Zoom pentru a mări entităţile ce 

vor fi selectate. 
2. Selectaţi entităţile ce vor fi multiplicate: 
 Selectaţi prin apăsarea butonului stang al mouseului pe 

unul din manipulatoare 
 Apăsaţi pe butonul din dreapta şi selectaţi Enter din 

meniul derulant. 
 Apăsaţi pe butonul din dreapta al mouse-ului în aria de 

desenare apoi selectaţi Copy. 
 Apăsaţi pe butonul din dreapta al mouse-ului în aria de 

desenare apoi selectaţi Base Point. 
 Deplasaţi cursorul vertical în sus, localizaţi poziţia noii 

entităţi, apoi apăsaţi ENTER. 
 Salvaţi desenul. 
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7.7. Gruparea obiectelor 
 
Editarea obiectelor necesită crearea unui set de selecţie. 

Setul anterior de selecţie poate fi reapelat pentru editare, dar 
celelalte seturi de selecţie vor trebui recreate. Acestea sunt seturi de 
selecţie nedenumite. Gruparea obiectelor asigură o metodă eficientă 
de creare şi salvare a unui set de selecţie sub un nume. 

 
Termeni cheie: Grupare 
Order/Reorder - numărul de ordine unui obiect în cadrul 

unui grup. Acesta este important pentru maşinile cu cont numeric. 
Selectable - selectarea unui singur membru al grupului duce 

la selectarea tuturor membrilor grupului din spaţiul curent, cu 
excepţia celor existenţi într-un spaţiu alternativ sau aflaţi sub 
layere îngheţate - blocate. 

 
Comanda Group 
Linia de comandă: group 
 
Crearea unui grup 
Crearea unui set de selecţie şi salvarea sub un nume cu 

ajutorul comenzii Group: 
1. În linia de comandă tastaţi group pentru a afişa fereastra 

de dialog Object Grouping. 
2. În tabloul Group Identification, în câmpul Group Name 

tastaţi numele grupului sau dacă nu doriţi să desemnaţi un nume 
puteţi selecta opţiunea unnamed în tabloul Create Group. 

3. În tabloul Create Group: 
 Selectaţi Selectable. 
 Selectaţi New. 
 Selectaţi toate entităţile pe care le doriţi grupate, apoi 

apăsaţi ENTER. 
 Selectaţi OK pentru a ieşi din fereastra de dialog Object 

Grouping. 
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Exercitiul 7.8  
Desenaţi arborele cu secţiune variabilă de mai jos. 
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LUCRAREA 8 Modele de haşurare. Filtre de coordonate 

 
8. Haşurarea în Autocad 

 
Haşurarea presupune umplerea cu un anumit model a unui 

contur închis. De obicei sunt haşurate secţiunile prin obiecte. 
Modelul de haşurare dă indicaţii asupra materialului din care e 
construit obiectul secţionat.   

Secţiunea este reprezentarea în proiecţie ortogonală pe un 
plan a obiectului, după intersectarea acestuia cu o suprafaţă fictivă 
de secţionare şi îndepărtarea imaginară a părţii obiectului aflată 
între observator şi suprafaţa respectivă. 
 

   
 
8.1. Clasificarea secţiunilor: 
 

1) După modul de reprezentare secţiunile se clasifică în: 
 secţiune propriu-zisă, dacă se reprezintă numai figura 

obţinută prin intersecţia obiectului cu suprafaţa de 
secţionare (fig.8.1, a); 

 secţiune cu vedere, dacă se reprezintă atât secţiunea 
propriu-zisă, cât şi partea obiectului aflată după suprafaţa de 
secţionare (fig. b). 
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Fig. 8.1. 

 
2) După poziţia planului de secţionare faţă de planul orizontal de 
proiecţie: 

 secţiune orizontală,  dacă planul  de  secţionate este paralel  
cu planul orizontal de proiecţie (fig. 8.2); 

 
Fig 8.2. 

 
 Secţiune verticală, când planul de secţionare este 

perpendicular pe planul orizontal de proiecţie (fig. 8.3, A-A, 
B-B); 
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Fig 8.3. 

 
 Secţiuni înclinate, când planul de secţionare formează cu 

planul orizontal de proiecţie un unghi diferit de 90°. 
 

3) După poziţia planului vertical de secţionare: 
 secţiune frontală, dacă planul de secţionare este paralel cu 

planul frontal de proiecţie (vezi fig. 8.3, A-A); 
 secţiune de profil, dacă planul de secţionare este paralel cu 

planul de profil de proiecţie (vezi fig. 8.1, a, b); 
 secţiune verticală obişnuită, dacă planul vertical de 

secţionare formează cu planul frontal  de proiecţie un unghi 
diferit de 90° (vezi fig. 8.3, B-B). 

 
4) După forma suprafeţei de secţionare: 

 secţiune plană, dacă suprafaţa de secţionare este un plan 
(vezi fig. 8.1, 8.2, 8.3); 

 secţiune cilindrică, dacă suprafaţa de secţionare este 
cilindrică. În acest caz secţiunea se desfăşoară în plan (fig. 
8.4). 
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Fig 8.4. 

 
5) După numărul de plane de secţionare: 

 secţiune simplă, dacă este generată de un singur plan de 
secţionare (vezi fig. 8.1, 8.2, 8.3); 

 secţiune compusă,  dacă este generată de două sau mai  
multe plane de secţionare. 

6) După poziţia planului de secţionare faţă de axa piesei: 
 secţiune longitudinală, când planul de secţionare trece prin 

axa principală a piesei sau este paralel cu aceasta; 
 secţiune transversală, când planul de secţionare este 

perpendicular pe axa obiectului (vezi fig. 8.1). 
7) După proporţia în care se face secţionarea: 

 secţiune completă, când în proiecţia respectivă obiectul este 
reprezentat secţionat integral (vezi fig. 8.2, 8.3); 

 jumătate vedere–jumătate secţiune, când obiectul este 
reprezentat jumătate în vedere şi jumătate în secţiune, 
separate între ele prin axa de simetrie. Se permite numai în 
cazul când vederea completă şi secţiunea completă respectivă 
sunt reprezentări simetrice cu aceeaşi axă de simetrie (fig. 
8.5). 
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Fig 8.5. 

 secţiune parţială, dacă numai o parte a obiectului este 
reprezentată cu secţiune, separată printr-o linie de ruptură 
(fig. 8.6). 

 
Fig 8.6. 

 
8.2. Indicaţii speciale de reprezentare 
 

 Piesele fără găuri (şuruburi, nituri, pene, arbori, mânere, tije. 
etc.), precum şi unele elemente care intră în componenţa 
unor piese (nervuri de rigiditate, spiţe etc.) se reprezintă în 
secţiune longitudinală nesecţionate. 

 La executarea a jumătate vedere-jumătate secţiune în funcţie 
de poziţia axei de simetrie vederea va fi în stânga, iar 
secţiunea în dreapta axei sau vederea deasupra şi secţiunea 
sub axă. 

 
8.3. Haşurarea în desenul tehnic 
Secţiunea arată părţile pline ale obiectului care sunt în 

contact cu planul de secţionare şi se evidenţiază prin haşură, 
reglementată pentru diferite materiale de STAS 104-80).  



Modele de haşurare. Filtre de coordonate 

 148 

Pentru piesele metalice haşura prezintă  linii  continue  
subţiri paralele, echidistante, înclinate sub 45° în dreapta sau 
stânga faţă de o linie de contur (vezi  fig. 8.2,  8.4,  8.5),  de o axă a 
reprezentării (vezi fig. 8.1) sau faţă de chenarul desenului. 

Dacă liniile conturului sau axa reprezentării sunt înclinate 
sub 45° faţă de chenarul desenului, atunci haşurile se trasează sub 
30° sau 60° faţă de chenar.  

Distanţa dintre  liniile haşurii  se alege  în  funcţie de 
mărimea suprafeţei haşurate între 1…10 mm. 

Nemetalele (masă plastică, cauciuc, piele etc.) se haşurează 
în ambele sensuri 45° şi 135° (vezi fig. 8.3). 

Suprafeţele înguste, cu lăţimea mai mică de 2 mm se 
înnegresc. 
 

8.4. Modele de haşurare şi aplicare de culoare uniformă 
 
Modele de haşuri realizează umplerea unei suprafeţe 

selectate cu o reprezentare regulată de puncte, linii punctate, linii, 
forme sau colorare completă. Puteţi crea uşor haşuri pe suprafeţe şi 
le puteţi edita proprietăţile mai târziu. Controlaţi vizibilitatea 
haşurii cu ajutorul comenzii Fill sau cu variabila de sistem 
FILLMODE. 

 
Termeni cheie: Haşurare 
Hatch Pattern - aranjament regulat de puncte, linii 

punctate, forme sau linii într-o suprafaţă închisă. 
Solid Fill - un tip de haşură sub formă de culoare uniformă 

ce acoperă o arie selectată. 
Islands - suprafeţe ce nu trebuie haşurate din interiorul unui 

contur. 
 
Comanda Bhatch . 
Bara cu instrumente: Draw > Hatch 

 
Meniu: Draw > Hatch 
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Linia de comandă: Bhatch 
 
Crearea unei haşuri 
 
Crearea unei haşuri se face prin selectarea unui contur 

închis pe care se va aplica un model de haşură, apoi se alege un 
model căruia i se aplică setările necesare pentru unghi şi densitate. 

1. În bara cu instrumente Draw, selectaţi Hatch. 
2. Selectaţi modelul de haşurare din lista Pattern. 
 Pentru a vedea modelele de haşurare disponibile, apăsaţi 

butonul (...) din partea dreaptă a ferestrei Pattern. 
 Alegeţi una din filele ANSI1, ISO sau Other Predefined, 

selectaţi un model, apoi selectaţi OK. 
3. Selectaţi unghiul de rotaţie pentru model din lista Angle. 
4. În câmpul Scale tastaţi factorul de scară al modelului. O 

valoare mai mică decât 1 determină un model mai dens, iar o 
valoarea mai mare decât 1 determină un model mai rarefiat. 

 

 
Scara setată la 1.25 şi la 0.5 
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5. Selectaţi Pick Points pentru a indica suprafaţa închisă ce 

trebuie haşurată. Selectaţi un punct în interiorul unei suprafeţe 
închise, apăsaţi pe butonul din dreapta al mouse-ului, apoi apăsaţi 
ENTER. 

6. Dacă doriţi haşurarea unei entitaţi închise (ex.: Polilinbie, 
cerc, poligon, etc.) puteţi alege opţiunea Select Objects, după care 
selectaţi selectaţi conturul ce trebuie haşurat, apoi apăsaţi ENTER. 

 

 
 

 
Observaţie: Dacă punctul ales nu se găseşte într-o suprafaţă 

închisă, este afişat un avertisment. 
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Observaţie: Puteţi selecta mai multe suprafeţe o dată, dar 
dacă va trebui să editaţi conturul sau modelul mai târziu, trebuie 
să haşuraţi pe rând suprafeţele. 

 
Haşura nu acoperă textul introdus anterior în desen 

6. Pentru a previzualiza haşura, selectaţi Preview. După 
previzualizare, apăsaţi pe butonul din dreapta la mouse-ului. 

7. Schimbaţi oricare dintre parametrii haşurii în funcţie de 
cerinţe, apoi selectaţi OK. 

 Haşura este creată în layerul curent, având culoarea şi 
tipul de linie specific acestuia. 

 Zona ce delimitează texte şi texte de cotă nu sunt 
haşurate. 

Observaţie: Dacă nu apare nici un model de 
haşurare şi este afişat mesajul "Hatch spacing too dense, or dash 
size too small", setaţi valoarea Scale la una mai ridicată. 

 
Selecţia obiectelor 
Pentru Pick Points, alegeţi un punct în interiorul unui contur 

închis. Opţiunea Select Objects vă permite alegerea obiectelor de 
haşurat prin specificarea unui set de selecţie. 

Pentru a haşura totul în interiorul unui contur, selectaţi 
conturul, selectaţi Remove Islands şi selectaţi părţile (insulele) ce 
trebuie îndepărtate. 
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Haşura fără şi cu opţiunea Remove Islands 

 
Opţiunile avansate 
Pentru situaţii mai complexe alegeţi opţiunile Advanced. 
 
Island Detection Option - specifică cum tratează comanda 

marginile din interiorul altor margini. 
Observaţie: Pentru informaţii privind opţiuni avansate, 

vedeţi Help. 
Crearea unei noi haşuri pe baza unui model existent 
Folosirea unui model de haşură existent ca bază, pentru un 

nou model: 
1. În bara cu instrumente Draw, selectaţi Hatch. 
2. În fereastra de dialog Boundary Hatch selectaţi Inherit 

Properties. Selectaţi un model de haşură existent. 
3. Dacă este necesar, schimbaţi orice proprietate a modelului 

în fereastra de dialog. 
4. Selectaţi Pick Points sau Select Objects pentru a selecta o 

nouă suprafaţă de haşurat. 
5. Selectaţi OK. Apare noul model de haşură. 
 
Vizibilitatea modelului de haşură 
Controlaţi vizibilitatea modelului de haşură prin îngheţarea 

sau dezgheţarea layerului de haşură. 
Ca o posibilitate alternativă, vizibilitatea poate fi permutată 

între activat şi dezactivat folosind comanda Fill. 
1. Pentru a dezactiva vizibilitatea modelului de haşură, 

tastaţi fill în linia de comandă, apoi tastaţi off. 
2. În meniul View selectaţi Regen. 
3. Pentru a activa vizibilitatea modelului de haşură, tastaţi fill 

în linia de comandă, apoi tastaţi on. 
4. În meniul View selectaţi Regen. 
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Observaţie: Afişarea umplerii obiectelor poate fi 
controlată din fereastra de dialog Options. Apăsaţi pe butonul din 
dreapta al mouse-ului în fereastra de desenare, apoi selectaţi 
Options. Selectaţi fila Display. În secţiunea Display Performance, 
selectaţi Apply Solid Fill pentru a o activa sau dezactiva. 

 
Editarea haşurilor 
Este posibilă editarea contururilor şi modelului haşurii 

asociative fără a crea o nouă haşură. 
 
Termeni cheie: Editarea haşurilor 
Associative Hatching - o haşură asociată conturului. 

Editarea marginilor are ca efect reactualizarea haşurii pentru a 
acoperi noul contur. 

 
Comanda Hatchedit 
Bara cu instrumente: Modify II 
Meniu: Modify> Hatch 
Linia de comandă: Hatchedit 
Folosiţi manipulatoarele sau alte comenzi de modificare (cu 

excepţia comenzilor Fillet, Chamfer, Offset, Break sau Divide) pentru 
a schimba conturul haşurii. Dacă conturul rămâne închis, haşurul 
este redesenat pentru a umple noua suprafaţă închisă. Când lăsaţi 
conturul deschis, pierdeţi asociativitatea şi haşura rămâne aceeaşi. 

 
Haşura asociativă: editarea cu şi 
 fără păstrarea conturului inchis 



Modele de haşurare. Filtre de coordonate 

 154 

Observaţie: asociativitatea haşurii este păstrată 
când o copiaţi, mutaţi sau oglindiţi şi selectaţi toate marginile 
haşurii. Dacă haşura este pe un layer îngheţat sau blocat, aceasta 
nu este redesenată. 

Puteţi de asemenea edita insule în interiorul unei haşuri. 
Haşura este redesenată atunci când mutaţi sau ştergeţi o insulă. 

 
Mutarea şi ştergerea unei insule în interiorul haşurii . 

Puteţi edita o haşură folosind manipulatoarele. 
Manipulatorul pentru o haşură asociativă apare în centrul/acesteia. 

 
Editarea unei haşuri  
Schimbarea definirii unei haşuri: 
1. În bara cu instrumente Modify II selectaţi Edit Hatch. 
2. Selectaţi o haşură. Este afişată fereastra de dialog Hatch 

Edit. Este similară ferestrei de dialog Boundary Hatch, cu câteva 
opţiuni neaplicabile. 

3. Schimbaţi, după nevoie, Pattern, Angle şi Scale. 
4. Dacă este necesar, schimbaţi stilul Island Detection din fila 

Advanced. 
5. Selectaţi OK. 
Observaţie: Puteţi de asemenea folosi fereastra Properties 

pentru a schimba proprietăţile haşurii. 
 
Editarea conturului unei haşuri 
Editarea elementelor unei haşuri folosind manipulatoarele 

sau variabila de sistem PICKSTYLE: 
1. În meniul Tools selectaţi Options. Alegeţi fila Selection. 
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2. Sub Grips selectaţi Enable Grips Within Blocks apoi 
selectaţi OK. 

3. Selectaţi orice parte a haşurii. 
4. Pentru a şterge o haşură fără a şterge conturul, setaţi 

PICKSTYLE la 0 sau 1. Pentru a şterge ambele, setaţi PICKSTYLE la 
2 sau 3. 

 
Exerciţiul 8.1: folosirea haşurilor în desene 
 Deschideţi un fişier model şi realizaţi un hexagon şi un 

patrulater rectangular.  
 Creaţi layerul HATCH1 curent şi setaţi-l ca şi layer 

curent. 
 În bara cu instrumente Draw selectaţi Hatch. 
 Apăsaţi butonul (...) de lângă câmpul Pattern. 
 În Hatch Pattern Palette selectaţi fila ANSI şi selectaţi 

modelul ANSI34. Selectaţi OK. 
 În lista Angle selectaţi 60. 
 În lista Scale selectaţi 0.5. 
 Selectaţi Pick Points şi alegeţi un punct în interiorul 

hexagonului. 
 Apăsaţi pe butonul din dreapta al mouse-ului, apoi 

selectaţi Preview din meniul cursor; 
 Apăsaţi pe butonul din dreapta al mouse-ului, apoi 

selectaţi OK. Noua haşură apare în desen. 
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Folosirea proprietăţilor moştenite în haşurare 
1. Apăsaţi pe butonul din dreapta al mouse-ului în fereastra 

de desenare, apoi selectaţi Repeat Hatch. 
2. Selectaţi Inherit Propeties. 
3. Selectaţi haşura din hexagon (cursorul se modifică sub 

forma unui penson) apoi apăsaţi Enter. 
4. În fereastra Boundary Hatch selectaţi Pick Points pentru a 

selecta un punct în interiorul patrulaterului sau Select Objects 
pentru a selecta marginile individual. 

 
5. Apăsaţi pe butonul din dreapta al mouse-ului, apoi 

selectaţi Preview din meniul cursor. 
6. Apăsaţi pe butonul din dreapta al mouse-ului, apoi 

selectaţi OK. 
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Haşurarea suprafeţelor multiple 
 
1. Apăsaţi pe butonul din dreapta al mouse-ului în fereastra 

de desenare, apoi selectaţi Repeat Hatch. 
2. În lista Pattern selectaţi SACNCR. 
3. Selectaţi Pick Points. 
4. Selectaţi câte un punct în interiorul tuturor suprafeţelor 

nehaşurate  
5. Apăsaţi ENTER. 
6. Apăsaţi pe butonul din dreapta al mouse-ului, apoi 

selectaţi ENTER. 
 

 
 

Editarea unei haşuri existente  
 
Schimbaţi proprietăţile unei haşuri. 
1. Apăsaţi pe butonul din dreapta al mouse-ului pe orice 

bară cu instrumente pentru a afişa meniul cursor, apoi selectaţi 
Modify II. 
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2. În bara cu instrumente Modify II, selectaţi Edit Hatch. 

 
3. Selectaţi haşura din hexagon. 
4. În lista Pattern, selectaţi GRATE. 
5. Setaţi Scale la 0.5. 
6. Setaţi Angle la 45. 
7. Selectaţi OK pentru a aplica noul model. 

 
 
Întinderea unui contur de haşură  
Editaţi conturul unui model asociativ de haşură. 
1. În bara cu instrumente Modify selectaţi Stretch. 
2. Creaţi o fereastră de selecţie prin intersectare pentru a 

include părţile haşurate. 
3. Selectaţi oriunde în desen pentru a defini punctul de bază: 
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 Pentru a specifica al doilea punct al mutării, deplasaţi 
cursorul în jos, apoi tastaţi 1 şi apăsaţi ENTER. 

 Conturul exterior al entităţii şi haşura se întind. 
 

 
Haşura şi conturul întinse 

 
Exercitiul 8.2. Realizaţi desenul piesei de mai jos 
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Exerciţiul 8.3. Desenaţi cele două vederi ale bucşei de mai jos. 
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8.5. Filtre de coordonate 
 
Filtrele de coordonate se folosesc pentru preluarea parţială a 

coordonatelor unui punct sursă spre a fi folosite în indicarea 
coordonatelor unui alt punct. (ex. Folosim coordonata x a unui 
punct existent pentru a defini coordonata x a punctului curent pe 
care-l realizăm). 

 Autocad pune la dispoziţia utilizatorului filtrele de 
coordonate prin funcţia „Point Filters”  

 .x - pentru preluarea de la punctul-sursă a coordonatei x. 
 .y - pentru preluarea de la punctul-sursă a coordonatei y. 
 .z - pentru preluarea de la punctul-sursă a coordonatei z. 
 .xy – pentru preluarea de la punctul-sursă a 

coordonatelor x si y. 
 .yz – pentru preluarea de la punctul-sursă a 

coordonatelor y si z. 
 .xz - pentru preluarea de la punctul-sursă a 

cbordonatelor x si z. 
În figura de mai jos este prezentat un exemplu de utilizare. 

Exercitiul 8.3. Folosind filtrele de coordonate desenaţi o linie ale 
carei capete sa fie aliniate pe aceleaşi coordonate x cu capetele 
arcului de cerc, ca în figura de mai jos. 
 

 
Fiind desenate polilinia ABCDEF şi cercul, se va trasa o 

polilinie care va urmări forma poliliniei iniţiale: 
Command: line < 
From point: .x < 
of end < 
of {selectaţi unul din capetele arcului de cerc} 
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(need YZ): .yz < 
of {alegeţi un punct aleator deasupra arcului de cerc} 
To point: .x < 
of end < 
of {selectaţi celălalt capăt al arcului de cerc} 
(need YZ): @ < 

 

Observaţie: După specificarea unui filtru, AutoCAD 
solicită punctul-sursă, de la care să preia coordonatele ("of"); 
Urmare a indicării lui, programul afişează mesajul: "(need ...)", 
menţionând coordonata sau coordonatele care îi lipsesc pentru 
punctul destinaţie. 

Filtrele de coordonate sunt similare liniilor de ordine din 
desenul clasic. 

 
Exercitiul 8.3. 

 
Desenaţi vederea de sus şi cea din stânga a piesei prezentată 

3D şi apoi construiţi folosind doar filtrele de coordonate vederea din 
faţă. 
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La final desenul trebuie să fie de forma celui de mai jos. 
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LUCRAREA 9 COTAREA DESENULUI 

 
9.1. Reguli, metode şi principii de cotare 
 
Prin cotarea desenului se înţelege operaţia de înscriere a 

dimensiunilor   formelor  geometrice din care este alcătuit  obiectul 
proiectat, precum şi a dimensiunilor care stabilesc poziţia reciprocă 
a acestora şi se efectuează conform regulilor stabilite de STAS 104-
80 

Elementele cotării. 
Operaţia de cotare se realizează prin intermediul următoarelor  
elemente (fig. 2.5): 
- linia de cotă; 
- extremităţile liniei de cotă (de regulă, săgeţi); 
- linii ajutătoare; 
- linia de indicaţie; 
- cota. 
 

 
Fig. 9.1. 

 
Linia de cotă se trasează cu linie continuă subţire paralel cu 

liniile de contur ale proiecţiei, la o distanţă de min 10 mm de  la 
contur  şi  min 7 mm dintre  liniile de cotă.  Se  recomandă evitarea 
intersecţiei liniilor de cotă între ele sau cu alte linii ajutătoare şi 
dispunerea în afara reprezentării în ordine crescătoare (fig. 9.2). 
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9.1.1. Principii de cotare 
• Cotele referitoare la acelaşi element se înscriu numai pe una din  
proiecţiile obiectului reprezentat, unde elementul este mai complet  
determinat. 
• Trebuie să se urmărească definirea fiecărei forme geometrice din 
care este alcătuit obiectul proiectat, precum şi poziţia lor reciprocă. 
• Cotele se înscriu pe proiecţia în care elementul se proiectează în 
mărime adevărată. 
• Nu se admite cotarea elementelor pe proiecţia în care acestea sunt 
reprezentate cu linie întreruptă (muchii acoperite), cu excepţia 
cazurilor în care cotarea de la muchia acoperită duce la excluderea 
necesităţii desenării unei reprezentări suplimentare. 
• Nu se admite înscrierea pe desene a mai multor cote decât cele 
necesare execuţiei corecte a obiectului proiectat. 
• La înscrierea cotelor pe desenele de execuţie a pieselor se ţine  
cont, de obicei, de procesul tehnologic de fabricaţie al piesei. 
 

9.2.  Adăugarea cotelor folosind QuickDimension 
 
Cotările pot fi adăugate desenului folosind variate metode. 

Folosind Quick Dimension, pot fi adăugate o serie de cotări folosind 
metode standard de plasare. 

 
Termeni cheie: Folosirea Quick Dimension 
Baseline - o serie de cote măsurate de la prima linie de 

extindere (cotare paralelă). 
Continued - o serie de cote măsurate în secvenţe (cotare în 

lanţ). 
 
Comanda Quickdim 
Bara cu instrumente: Dimension > Quick Dimension 

 
 

Meniu: Dimension>QDIM 
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Linia de comandă: Qdim 
 

 
a. Selectarea obiectelor  b. Plasarea lanţului de dimensiuni 

b.  
Utilizarea Quick Dimension pentru a cota un desen 
Adăugarea cotelor liniare şi diametrale folosind comanda 

Quickdim: 
1. În bara cu instrumente Dimension, selectaţi Quick 

Dimension, apoi: 
 Selectaţi obiectele liniare ce trebuiesc cotate, apoi apăsaţi 

ENTER. 
 Deplasaţi cursorul în sus, apoi selectaţi un punct pentru 

a localiza cotarea în lanţ. 
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Observaţie: Setarea implicită este cea continuă (în lanţ). 
Pentru a plasa cotele folosind o altă metodă, precum cotarea faţă de 
o linie de bază (cotare paralelă), tastaţi valoarea la cererea din linia 
de comandă, sau apăsaţi pe butonul din dreapta al mouse-ului 
pentru a afişa meniul cursor. Cotările sunt afişate dinamic înainte 
de plasarea în desen. 

 

 
Cotarea faţă de o linie de bază 

 
2. Repetaţi comanda Quickdim, apoi: 
 Selectaţi obiectele cerc, apoi apăsaţi ENTER. 
 Apăsaţi pe butonul din dreapta al mouse-ului în fereastra 

de desenare, apoi selectaţi Radius Dimension sau 
Diameter Dimension. 

 Selectaţi un punct pentru a poziţiona diametrul sau raza. 
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Piesa cotată 

 
 
Tipuri de cote 
Obiectele pot fi cotate folosind formatele Linear, Aligned, 

Ordinate, Radial, Diameter sau Angled. 
 
 

 
Tipuri de cote 
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Adăugarea cotelor liniare, radiale, diametrale şi 
unghiulare. 

Cotarea cu linie de indicaţie 
Cele mai multe piese sunt linii, arce sau cercuri. Aceste 

obiecte sunt cotate folosind cote liniare, radiale sau diametrale. 
Notele pot fi adăugate desenului folosind liniile de indicaţie. 

 
Termeni cheie: Linii de indicaţie 
Leaders - adnotare adăugată la sfârşitul unei linii 

personalizate. Rânduri singulare de text, text multilinie sau 
toleranţe geometrice sunt exemple de adnotări. 

 
Comanda dimlinear 
Bara cu instrumente: Dimension> Linear Dimension 

 
 

Meniu: Dimension>Linear 

 
 

Linia de comandă: Dimlinear 
 
Comanda Dimdiameter 
Bara cu instrumente: Dimension > Diameter Dimension 

 
 

Meniu: Dimension> Diameter 
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Linia de comandă: Dimdiameter 
 
Comanda Dimradius 
Bara cu instrumente:Dimension>Radius Dimension  

 
 

Meniu: Dimension> Radius 

 
 

Linia de comandă: dimradius 
 
Comanda Qleader 
Bara cu instrumente: Dimension>Quick Leader 

 
 

Meniu: Dimension>Leader 
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Linia de comandă: Qleader 
 
Comanda Angular Dimmension (DIMANG sau DIM ANG ) 

 
Bara cu instrumente: Dimension>Angular Dimension 

 
Meniu: Dimension>Angular 

 
 

Linia de comandă: Dimang 
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Observaţie:  în textul cotei pot fi inserate caractere 
speciale (Ø, R, ˚etc.). Pentru aceasta, la prompterul  Dimension text  
se va introduce  o secvenţă specială: două caractere procent urmate 
de o literă sau de o valoare numerică. În tabelul următor se prezintă 
semnificaţia caracterelor utilizabile în acest context: 
 
Secvenţă tastată  Rezultat 
%%C  Ø (semnul pentru diametru) 
%%D  ° (semnul pentru grade)  
 

 
În acest mod puteţi cota spre exemplu diametrul unui obiect 

de rotaţie.   
 

Cotările liniare, radiale şi diametrale. Linii de indicaţie 
Adăugarea cotărilor şi a liniilor de indicaţie: 
 
1.În bara cu instrumente Dimension selectaţi Linear 

Dimension , apoi: 
 Selectaţi capătul liniei pentru a specifica originea liniei de 

cotă. 
 Selectaţi celălalt capăt al liniei pentru a specifica al doilea 

punct al liniei de cotă. 
 Trageţi cursorul spre dreapta apoi apăsaţi un punct 

pentru a localiza cota. 
 Repetaţi operaţiile pentru fiecare segment de dreaptă. 
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Observaţie: Pentru a cota un obiect de tip linie apăsaţi 

ENTER, apoi selectaţi obiectul. 
2. În bara cu instrumente Dimension selectaţi Radius 

Dimension , apoi: 
 Selectaţi arcul. 
 Trageţi cursorul în exteriorul arcului, apoi selectaţi un 

punct pentru a plasa cota. 

 
Adăugarea cotei radiale 

3. În bara cu instrumente Dimension selectaţi Diameter 

Dimension , apoi: 
 Selectaţi cercul. 
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 Trageţi cursorul în exteriorul cercului, apoi selectaţi un 
punct pentru a plasa cota. 

 
Adăugarea cotei diametrale 

 
4. În bara cu instrumente Dimension selectaţi Quick Leader 

, apoi:  
 Selectaţi un punct pe cerc. 
 Selectaţi două puncte pentru a defini linia de indicaţie, 

apoi apăsaţi ENTER. 
 Selectaţi un punct pentru a defini dimensiunea textului 

de cotare, apoi apăsaţi ENTER pentru a afişa fereastra de 
dialog Multiline Text Editor. 

  Tastaţi: raza de 20. 
 Selectaţi OK pentru a plasa textul. 

 
Marcatorul de centru 
Când este cotat un cerc sau un arc, poate fi adăugat un 

marcator de centru sau linii de centru. 
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Marcator de centru 

 

 
Linii de centru 

 
 
Observaţie: Folosiţi comanda Dimcenter pentru a plasa linii 

de centru unui arc sau unui cerc, apoi plasaţi cota rară marcator 
sau linii de centru. 

 
Comanda Dimcenter 
Bara cu instrumente: Dimension> Center Mark  

 
 

Meniu: Dimension> Center Mark 
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Linia de comandă: Dimcenter 
 
Leader Settings 
Quick Leader este definit folosind fereastra de dialog Leader 

Settings. Setările includ: 
 Crearea textului folosind opţiunea mtext. 
 Specificarea tipului de indicaţie şi numărul punctelor 

necesare pentru a o defini. 
 Metoda de ataşare a textului, cum ar fi deasupra sau 

dedesubtul liniei. 
 
 
 

Exerciţiul 9.1.: 
Adăugarea cotărilor liniare, radiale şi diametrale. Cotarea cu 

linie de indicaţie. 
Adnotaţi o piesă folosind cote liniare, radiale şi diametrale, 

precum şi linii de indicaţie. 
 
Adăugarea cotărilor liniare 
1. Realizaţi desenul  cardului de memorie de mai jos: 



Cotarea desenului 

 177 

 
2. Realizaţi un nou layer denumit DIM, cu tipul de linie 

continuă si lăţimea de 0.05 mm. 
3. Setaţi DIM ca layer curent. 
4. În bara cu instrumente Dimension selectaţi Quick 

Dimension, apoi: 
 Selectaţi conturul exterior al cardului, apoi apăsaţi 

ENTER. 
 Deplasaţi cursorul spre stânga şi selectaţi un punct 

pentru a plasa cotele. 
 Repetaţi operaţiile dar deplasând cursorul în jos pentru a 

stabili cotele laturilor de bază. 

 
5. În bara cu instrumente Dimension selectaţi Baseline 

Dimension, apoi: 
 Apăsaţi pe butonul din dreapta al mouse-ului în fereastra 

de desenare, apoi selectaţi Select.  
 Selectaţi linia de extensie inferioară pentru a selecta cota 

de bază.  
 Selectaţi liniile etichetei pentru a plasa cotele şi poziţia 

verticală a centrului celor două cercuri, apoi apăsaţi 
ENTER de două ori. 
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6. În bara cu instrumente Dimension selectaţi Quick 
Dimension, apoi: 

 Selectaţi liniile  verticale ale etichetei şi poziţia centrelor 
celor două cercuri, apoi apăsaţi ENTER. 

 Deplasaţi cursorul în sus şi selectaţi un punct pentru a 
plasa cotele. 

 7. În bara cu instrumente Dimension selectaţi Baseline 
Dimension, apoi: 

 
 Apăsaţi pe butonul din dreapta al mouse-ului în fereastra 

de desenare, apoi selectaţi Select. 
 Selectaţi linia de extensie din dreapta pentru a selecta 

cota de bază.  
 Selectaţi capătul liniei superioare pentru a plasa cota, 

apoi apăsaţi ENTER de două ori. 
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Adăugarea liniilor de centru şi cotelor radiale şi 
diametrale  

Adăugaţi marcatori de centru cercurilor şi arcelor. 
1. Folosiţi comanda Zoom Window pentru a mări zona 

cercurilor. 
 

 
 

1. În bara cu instrumente Dimension selectaţi Center Mark 
apoi selectaţi cercul din stânga pentru a adăuga linii de centru. 

2. Repetaţi comanda Dimcenter apoi selectaţi cercul din 
dreapta pentru a adăuga linii de centru. 

 

 
3. În bara cu instrumente Dimension selectaţi Diameter 

Dimension, apoi: 
 Selectaţi cercul din stânga. 
 Apăsaţi pe butonul din dreapta al mouse-ului în fereastra 

de desenare, apoi selectaţi Text. 
 Tastaţi  gaura falsa apoi apăsaţi ENTER. 
 Selectaţi un punct pentru a plasa cota. 
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 Repetaţi paşii pentru cercul din dreapta. 
 
 

 
Notă: AutoCAD plasează valoarea măsurată a cotei curente 

între semnele mai mic şi mai mare. 
4. În bara cu instrumente Dimension selectaţi Radius 

Dimension, apoi: 
 Folosiţi comanda Zoom Window. 
 Selectaţi arcul superior din stânga a etichetei. 
 Apăsaţi pe butonul din dreapta al mouse-ului în fereastra 

de desenare, apoi selectaţi Text. 
 Tastaţi Hârtie apoi apăsaţi ENTER 
 Selectaţi un punct pentru a plasa cota. 

 
 
Completarea cotării 
1. În bara cu instrumente Dimension selectaţi Liner 

Dimension, şi cotaţi sistemul de blocare a cardului de memorie. În 
prealabil măriţi zona cu comanda Zoom Window.  
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Adăugarea liniilor de indicaţie 
1. Folosiţi comenzile Zoom şi Pan pentru a afişa vederea de 

sus. 
2. În bara cu instrumente Dimension selectaţi Quick Leader, 

apoi: 
 Selectaţi un punct lângă textul San Disk. 
 Selectaţi un al doilea punct pentru a defini capătul liniei 

de indicaţie, apoi apăsaţi ENTER. 
 Tastaţi 50 apoi apăsaţi ENTER pentru a specifica grosimea 

textului. 
 Apăsaţi ENTER de două ori pentru a afişa fereastra 

Multiline Text Editor. 
 Tastaţi 3mm HIGH STAMPED apoi selectaţi OK. 
 Repetaţi operaţiile pentru literele SD cu textul 10 mm 

HIGH STAMPED 
3. În meniul File selectaţi Save As, apoi salvaţi desenul ca 

Dimensioned plate. 
Sfârşitul exerciţiului. 
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Crearea de stiluri de dimensionare standard industriale 
 
Standardele de proiect şi cele specifice întreprinderii pot cere 

standarde diferite pentru stilurile de cotare. AutoCAD pune la 
dispoziţie un stil predefinit, numit STANDARD pentru desenele 
model englezeşti şi IS0-25 pentru desenele model cu sistem metric 
de măsură. 

 
Termeni cheie: Stiluri de cotare 
Extension Line - liniile de extensie pe care se sprijină cota şi 

care marchează elementul măsurat. 
Dimension Line - linia de cotă care se sprijină pe liniile de 

extensie. De obicei, valoarea cotei se găseşte pe această linie. 
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Comanda Dimstyfe 
Bara cu instrumente: Dimension >Dimension Style 
Meniu: Format> Dimension Style 
Linia de comandă: Dimstyle 
 
Crearea stilurilor de cotare 
Crearea unui nou stil de cotare: 
În bara cu instrumente Dimension selectaţi Dimension Style 

pentru a afişa fereastra de dialog Dimension Style Manager. 
 

 
 

2. Selectaţi New pentru a afişa fereastra de dialog Create New 
Dimension Style, apoi tastaţi DIM-2 în câmpul New Style Name. 
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3. Selectaţi Continue pentru a afişa fereastra de dialog New 

Dimension Style. 
 

 
4. Selectaţi filele Lines şi Arrows, apoi în lista Arrowheads 

apăsaţi Origin indicator pentru prima săgeată. A doua săgeată se va 
schimba automat pentru a fi la fel cu prima. 

5. Selectaţi fila Text, apoi în lista Text Style selectaţi DIM-2. 
6. În zona Text Alignment selectaţi Horizontal. 
7. Selectaţi OK. DIM-2 este adăugat listei Styles. 
8. În fereastra de dialog Dimension Style Manager selectaţi 

Close pentru a ieşi şi salva stilul DIM-2. 
 
Cote asociative 
Atunci când o cotă este plasată în desen, punctele de definiţie 

sunt adăugate desenului. Aceste puncte se găsesc într-un layer 
special numit DEFPOINTS; acesta nu poate fi şters. 

Funcţia punctelor de definiţie este de a defini poziţia cotei. 
Când o piesă este modificată, punctele de definiţie permit 
modificarea corespunzătoare automată a cotei asociate. 

Cotarea asociativă este implicit activată (On) şi este 
controlată prin variabila de sistem DIMASO.  
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Fereastra Dimension Style Manager 
Toate stilurile disponibile sau stilurile în uz sunt listate în 

fereastra Styles. O previzualizare a stilului curent este afişată 
alături de o descriere. 

Noile stiluri şi modificările aduse stilurilor existente sunt 
controlate prin intermediul acestei ferestre de dialog. Selectând 
Modify va fi afişată fereastra de dialog Modify Dimension Style. 

 

 
 
Fereastra de dialog Modify Dimension Style are 6 file: 
Lines And Arrows - controlează setările pentru liniile de 

cătare, liniile de extensie şi capetele de săgeţi. 
Text - controlează aspectul, plasarea şi alinierea textului. 
Fit - controlează plasarea textului şi a săgeţilor. 
Primary Units - controlează afişarea valorii cotei. Tot în 

această filă sunt afişate precizia şi afişarea zerourilor şi zecimalelor. 
Alternate Units - controlează afişarea unităţilor alternative. 

De exemplu, cotele pot fi afişate în inci şi în milimetri în acelaşi 
timp pe aceeaşi linie de cotă. 



Cotarea desenului 

 187 

Tolerances - controlează formatul de afişare a toleranţelor 
dimensionale. 

Fereastra Preview - setările modificate sunt afişate în 
fereastra Preview. 

 
Editarea proprietaţilor unui stil existent 
Stilurile de cotare pot avea mici diferenţe pe parcursul 

operaţiilor de cotare. Cotările liniare pot cere o precizie de 3 
zecimale, în timp ce cotările unghiulare cer numai o zecimală 
precizie. În loc să creaţi un nou stil de cotare, folosiţi opţiunea pusă 
la dispoziţie în fereastra de dialog Create New Dimension Style de 
creare a unei copii a stilului de cotare ISO-25, de exemplu. 

Lista Use For afişează numele diferitelor tipuri. Folosind 
această metodă, editările minore pot fi făcute fără crearea unui nou 
stil. 

 
Utilizarea parametrilor prioritari pentru un stil de cotare 
O altă metodă de editare a unui stil de cotare este folosirea 

parametrilor prioritari. Selectând Override în fereastra de dialog 
Dimension Style Manager, este afişată fereastra de dialog Override 
Current Style. 

Această fereastră afişează aceleaşi file ca fereastra Modify 
Dimension Style. 

Fereastra Styles indică existenţa unui parametru prioritar, 
iar fereastra Description listează variaţia faţă de stilul curent. 

După crearea unui parametru prioritar, toate cotele adăugate 
unui desen folosind acest stil vor folosi acel parametru prioritar. 

Observaţie: Apăsaţi pe butonul din dreapta al mouse-ului pe 
Style Overrides pentru a afişa meniul cursor ce listează opţiunile 
pentru redenumire, ştergere şi salvare a parametrului prioritar în 
stilul curent. 

 
Exerciţiul 9.2: Crearea unor noi stiluri de cotare 
Creaţi noi stiluri de cotare şi cotaţi un obiect folosind un stil 

potrivit. 
Crearea unui nou stil 
1. Realizaţi desenul de mai jos. 
2. Apăsaţi pe butonul din dreapta al mouse-ului pe orice 

bară cu instrumente pentru a afişa meniul cursor, apoi selectaţi 
Dimension. 
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3. În bara cu instrumente Dimension selectaţi Dimension 

Style pentru a afişa fereastra Dimension Style Manager. Desenul are 
un singur stil: IS0-25. Acesta este stilul implicit într-un desen 
metric. 

4. Selectaţi New. În câmpul New Style Name tastaţi Nou apoi 
selectaţi Continue. 

5. Selectaţi fila Lines And Arrows, apoi: 
 Tastaţi 15 în câmpul Baseline Spacing. 
 Tastaţi 2 în câmpul Extend Beyond Dim Lines. 
 Tastaţi 2 în câmpul Offset From Origin. 
6. Selectaţi fila Text, apoi în lista Text Style selectaţi DIM-2. 
7. În Text Placement selectaţi Centered Lista Vertical. 
8. În Text Alignment selectaţi Horizontal. 
9. Selectaţi fila Fit, apoi în zona Fit Options selectaţi Either 

The Text Or The Arrows, Whichever Fits Best.  
10. Selectaţi fila Primary Units, apoi în fereastra Linear 

Dimensions: 
 În lista Precision selectaţi 0.0000. 
 În lista Decimal Separator selectaţi Period. 
11.În fereastra Angular Dimensions: 
 În zona Zero Suppression selectaţi Trailing. 
 Selectaţi OK şi închideţi fereastra pentru a salva noul stil. 
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Editarea unui stil pentru un tip de cotare 
Editaţi tipurile Radius şi Diameter. 
1. În bara cu instrumente Dimension selectaţi Dimension 
Style. 
2. În fereastra Styles selectaţi Nou apoi selectaţi New pentru 

a afişa fereastra de dialog Create New Dimension Style.  
3. În lista Use For, selectaţi Radius Dimensions, apoi selectaţi 
Continue. 
4. Selectaţi fila Lines And Arrows, apoi în fereastra Center 

Marks For Circles selectaţi None în lista Type. 
5. Selectaţi OK. 
6. Selectaţi New pentru a afişa fereastra de dialog Create New 

Dimension Style. 
7. În lista Use For, selectaţi Diameter Dimensions, apoi 
selectaţi Continue.  
8. Selectaţi fila Lines And Arrows, apoi în fereastra Center 

Marks For Circles selectaţi None în lista Type. 
9. Selectaţi OK şi Close pentru a salva schimbările. 
 
Crearea unui alt stil de cotare 
Creaţi un stil de cotare pentru toleranţe: 
1. În bara cu instrumente Dimension selectaţi Dimension 

Style pentru a afişa fereastra de dialog Dimension Style -Manager. 
2. Selectaţi New. În câmpul New Style Name tastaţi TOL-2, 

apoi selectaţi Continue. Acest stil va fi folosit pentru notare a 
abaterilor dimensionale limită de plus sau minus 0.1 mm. 

3. Selectaţi fila Lines And Arrows, apoi în fereastra Center 
Marks For Circles selectaţi None în lista Type. 

4.  Selectaţi fila Tolerances, apoi: 
 În lista Method selectaţi Limits. 
 În lista Precision selectaţi 0.0000.  
 Tastaţi 0.1 în Upper Value. 
 Tastaţi 0.1 în Lower Value. 
5. Selectaţi OK, apoi selectaţi Close pentru a salva noul stil. 
 
Folosirea parametrilor prioritari unui stil de cotare 
Faceţi o modificare minoră unui stil existent de cotare 

folosind un parametru prioritar.  
1. În bara cu instrumente Dimension selectaţi Dimension 

Style, apoi: 
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 Selectaţi Nou apoi selectaţi Set Current. 
 Selectaţi Override. 
 Selectaţi fila Text. 
 În zona Text Appearance selectaţi Draw Frame Around 

Text pentru a o activa. 
 Selectaţi OK pentru a ieşi din fereastra de dialog Override 

Current Style. 
 Selectaţi Close pentru a salva parametrul prioritar, 
2. În bara cu instrumente Dimension selectaţi Dimension 

Update apoi selectaţi cota de 85.725. Un chenar este adăugat cotei 
indicând că aceasta este cotă de bază. 

 

 
 
3. Măriţi desenul. 
4. În meniul File selectaţi Save As. În câmpul File Name 

tastaţi Dimension style, apoi apăsaţi Save. 
Sfârşitul exerciţiului. 
 
 
9.3. Toleranţe geometrice 
 
Toleranţele geometrice sunt adăugate unei piese mecanice 

pentru a arăta deviaţiile de formă, de profil, de orientarei, de poziţie 
şi bătaia radială pentru o suprafaţă a acesteia. Aceste informaţii 
sunt conţinute într-un chenar standard specific acestor abateri. 

 
Termeni cheie: Prescrierea toleranţelor 
Material Conditions - se aplică suprafeţelor cu cote tolerate. 

De exemplu, la condiţia de maxim de material (MMC) o suprafaţă 



Lucrarea 9 

 192 

are cantitate maximă de material corespunzătoare limitei superioare 
a toleranţei. 

 
Comanda Tolerance 
Bara cu instrumente: Dimension > Tolerance  
Meniu: Dimension > Tolerance 
Linia de comandă: Tolerance 
 
Adăugarea toleranţelor geometrice  
Adăugarea unui chenar conţinând toleranţe geometrice: 
1.În bara cu instrumente Dimension selectaţi Geometric 

Tolerance pentru a afişa fereastra de dialog Geometric Tolerance. 
 

 
 

2. Selectaţi căsuţa superioara Symbol pentru a afişa fereastra 
de dialog Symbol, apoi selectaţi simbolul necesar. 

3. Selectaţi caseta superioară Tolerance 1 pentru a afişa 
simbolul diametrului. 

4. În fereastra Value tastaţi 100. 
5. Apăsaţi fereastra Material Condition pentru a afişa 

fereastra de dialog Material Condition, apoi selectaţi simbolul 
maximului de material. 

6. În fereastra Datum Identifier tastaţi A. 
7. Selectaţi OK şi plasaţi chenarul. 
 
Adăugarea toleranţelor folosind o linie de indicaţie 
Chenarele cu toleranţe geometrice pot fi ataşate liniilor de 

indicaţie. Comanda Leader are opţiunea Tolerance. 
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Observaţie: Pentru a adăuga toleranţe mai poate fi folosit şi 

Quick Leader. În fereastra de dialog Leader Settings selectaţi 
Tolerance. 
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LUCRAREA 10 CREAREA BLOCURILOR 

 
10.1. Crearea blocurilor 
 
Blocurile vă permit combinarea, organizarea şi manipularea 

mai multor obiecte ca unul singur. Blocurile măresc eficienţa 
desenelor şi reduc mărimea fişierelor, ele ajută la mai buna 
gestionare a desenelor în cadrul unei unităţi. Un bloc este creat 
dintr-un set de selecţie a unuia sau mai multor obiecte grupate 
împreună pentru a forma un tot, numit definiţia blocului. Definiţia 
blocurilor poate apoi fi inserată, scalată şi rotită în cadrul desenului 
curent. 

Folosiţi blocuri pentru simboluri des folosite, cum ar fi 
scaune, uşi, întrerupătoare, rezistoare, bolţuri sau nituri. Blocurile 
pot conţine orice tip de obiect din desen, cum ar fi linii, arce, cercuri 
şi text. 

 
Termeni cheie: Blocuri 
Base Point - punctul de bază specificat pentru inserarea 

blocurilor. De obicei, acesta este centrul sau colţul obiectelor 
blocului. 

Insertion Point - locul unde este plasat punctul de bază al 
blocului, la inserarea acestuia. 

Long Block Name - numele poate fi de maximum 255 
caractere, - inclusiv spaţii. Dacă aveţi date ce sunt împărţite cu 
sisteme ce nu suportă nume lungi de fişiere; limitaţi numele 
blocului la 8 caractere sau chiar mai puţin şi nu folosiţi spaţiile. 

Nested Block - un bloc ce este componentă a unei definiţii de 
bloc mai complexă.  

Explode - separarea blocului în componentele originale ce    
l-au definit. 

Block Redefinition - schimbarea definiţiei unui bloc, dar 
păstrarea numelui acestuia. Blocurile inserate anterior cu acelaşi 
nume sunt schimbate automat pentru a reflecta schimbările. 
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Comanda Block 
 
Bara cu instrumente: Draw 

 
 

Meniu: Draw>-Block> Make 
 

 
 

Linia de comandă: Block 
 
Comanda Block  
Crearea unui bloc din obiecte deja existente. 

1. În bara cu instrumente Draw, selectaţi Make Block  . 
2. Tastaţi Pupitru comandă pentru numele blocului. 
3. Selectaţi Pick Point şi selectaţi colţul din stânga sus ca 

punct de bază. 
4. Selectaţi Select Objects şi selectaţi toate obiectele care 

compun pupitrul de comandă. 
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5. Selectaţi opţiunea Delete. Aceasta şterge obiectele care 

compun blocul. Celelalte opţiuni sunt: 
 Retain - reţine arcele, liniile şi textul care formează blocul 

în desen. 
 Convert To Block - şterge obiectele care compun blocul 

şi inserează un bloc în aceeaşi poziţie.  
6. Sub Preview Icon selectaţi opţiunea Create Icon From Block 

Geometry. 
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Observaţie: Cu opţiunea Create Icon, pictograma apare în 

fereastra AutoCAD DesignCenter. Dacă nu credeţi că veţi folosi 
blocul în alt desen, apăsaţi Do Not Include An Icon. 

7. Din lista Insert Units, selectaţi Inches. 
 
Notă: Inset Units suportă scalarea automată a blocului 

inserat din fereastra AutoCAD DesignCenter. Dacă un bloc ar fi 
definit în inci şi apoi inserat într-un desen a cărui unitate de bază o 
reprezintă milimetrul, va fi scalat la un factor de 25.4. 

8. Tastaţi Pupitru comandă 1 x 0.5 în câmpul Description. 
 

 
 

9. Selectaţi OK pentru a defini blocul. 
 
10.2. Inserarea blocurilor 
Blocurile şi alte desene AutoCAD pot fi inserate în desenul 

activ. Funcţie de proprietăţile obiectelor originale ce compun blocul, 
proprietăţile aparente ale blocului pot fi afectate de setările curente. 
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Comanda Insert 
Baza cu instrumente: Draw 

 
 

Meniu: Insert> Block 

 
 
Linia de comandă: Insert 
 
Comportarea blocurilor la inserare 
Când inseraţi un bloc cu obiectele desenate în Layer-ul 0, cu 

culoarea şi tipul de linie setate la BYLAYER, blocul are culoarea şi 
tipul de linie ale layerului curent. 

Puteţi de asemenea crea blocuri din obiecte, desenate în 
layere diferite. Acest lucru vă permite păstrarea informaţiilor de 
layer, culoare şi tip de linie pentru obiectele din bloc. În acest caz, 
fiecare bloc îşi păstrează obiectele în layerul lor original, la aceeaşi 
culoare şi acelaşi tip de linie. 

Un bloc creat din obiecte care au culoarea şi tipul de linie 
setate ca BYBLOCK vor lua culoarea şi tipul de linie active atunci 
când blocul este inserat. 

Comanda Insert este utilizată pentru inserarea blocurilor în 
desen. Prin dialogul comenzii se solicită introducerea următoarelor 
date: numele blocului, punctul de inserare, factorul de scară după 
axele X şi Y şi unghiul de rotire.  
Obiectele din figura alăturată au fost generate prin inserarea 
aceluiaşi bloc, în condiţii diferite, conform tabelului: 
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Următoarele indicaţii sunt aplicate pentru setarea layerelor, 

culorilor şi tipurilor de linie pentru definitiile de bloc: 
 Pentru a seta acelaşi layer, culoare şi tip de linie pentru 

toate inserările blocului, setaţi culoarea şi tipul de linie 
pentru toate obiectele din bloc. 

 Pentru a seta culoarea şi tipul de linie pentru o inserare 
de bloc la culoarea şi tipul de linie a layerului în care îl 
inseraţi, creaţi obiectele care îl formează în layerul 0. 
Setaţi culoarea şi tipul de linie la BYLAYER. 

 Pentru a seta culoarea şi tipul de linie pentru o inserare 
de bloc la setările curente, setaţi culoarea şi tipul de linie 
la BYBLOCK. 

 
Inserarea blocurilor 
Inserarea blocurilor într-un desen: 
1. Setaţi layerul curent Bloc. 

2. În bara cu instrumente Draw selectaţi Insert Block .  
3. În fereastra de dialog Insert selectaţi din lista Name blocul 
Pupitru comandă. 
4. Sub Insertion Point selectaţi Specify On-Screen. 
5. Pentru Scale şi Rotation, asiguraţi-vă că Specify On-Screen 
nu este selectat. 
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6. Selectaţi OK. 
7. Selectaţi un punct de inserţie în stânga descrierii camerei. 

Desenul Pupitru comnadă este inserat ca bloc, ce va lua proprietăţile 
layerului curent. 

 

 
 

8. Apăsaţi pe butonul din dreapta al mouse-ului în fereastra 
de desenare, apoi selectaţi Repeat Insert Block. 

9. Selectaţi OK, apoi selectaţi un punct de inserţie în dreapta 
descrierii camerei. Pupitru comandă este din nou inserat ca un bloc. 
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Comanda MINSERT este o combinaţie între INSERT  şi 

ARRAY rectangular şi permite inserarea multiplă a blocului vizat.  
 

10.3. Redefinirea blocurilor 
 
Redefinirea blocurilor şi reactualizarea tuturor blocurilor cu 

acelaşi nume cu noua definiţie. 
1. Selectaţi blocul de jos din desenul de mai sus. În fereastra 

de dialog Modify selectaţi Explode. 
2. Folosiţi Move şi Delete pentru a reconfigura pupitrul de 

comandă. 
3. În. bara cu instrumente Draw selectaţi Make Block. 
 În fereastra de dialog Block Definition selectaţi Pupitru 

comandă din lista Name. 
 Specificaţi ca Base Point colţul din stânga sus. 
 Selectaţi Select Objects şi selectaţi obiectele ce vor alcătui 

blocul 
 Sub Objects selectaţi Delete. 
 Selectaţi OK. Va apărea un mesaj. 
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4. Selectaţi Yes pentru a redefini blocul. Desenul se 
regenerează şi toate blocurile cu acelaşi nume sunt actualizate cu 
noua definiţie. 

 
 

 
 

Mesajul care apare la redefinirea unui bloc 
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10.4. Exportarea blocurilor şi a obiectelor 
 
Datele şi obiectele din desenele AutoCAD pot fi exportate în 

diferite formate. Blocurile şi obiectele AutoCAD pot fi exportate în 
fişiere cu extensia DWG. Acest lucru duce la crearea unui nou 
fişier-desen dintr-un bloc existent sau din obiectele selectate. 

Comanda Export 
Meniu: File> Export 

 
 

Linia de comandă: Export 
 
Comanda Wblock: permite salvarea blocului vizat într-un 

fişier. În acest mod, blocul devine disponibil  şi pentru alte desene. 
Trebuie indicate numele fişierului şi al blocului, dar pot fi făcute şi 
alte setări prin intermediul casetrei de dialog asociate 

Există trei opţiuni pentru a specifica datele de scris într-un 
fişier. 

Linia de comandă: Wblock . 
Block - exportă un bloc ales. 
Entire Drawing - exportă întreg desenul ca un fişier nou. 
Objects - funcţionează la fel cu fereastra de dialog Block 

Definition. Cere selecţia obiectelor şi precizarea unui punct de bază. 
 
10.5. Scrierea unui bloc intr-un fişier cu extensia DWG: 
 
1. În linia de comandă tastaţi wblock, apoi apăsaţi ENTER. 

Este afişată fereastra de dialog Write Block. 
2. Sub Source selectaţi Block. 
3. Din listă selectaţi blocul Pupitru comandă. 
4. Confirmaţi numele şi destinaţia fişierului. Implicit, numele 

fişierului este acelaşi cu al blocului. 
Observatie: Dacă veţi folosi acest fişier într-un sistem ce nu 

suportă nume lungi de fişiere, folosiţi un nume de cel mult 8 
caractere. 
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5. Selectaţi OK. Blocul, este scris într-un nou fişier-desen: 
Pupitru comandă. dwg. 

 
10.6. Crearea atributelor 
Ca parte constituentă a blocurilor pot fi selectate pe lângă 

entităţile grafice şi atribute. Atributele sunt informaţii textuale 
variabile, în sensul că pot primi valori diferite la inserări succesive. 
Atributele completează flexibilitatea blocurilor şi le fac mai eficiente 
în exploatare. Aspectul  şi comportarea atributelor sunt controlate 
prin intermediul a patru caracteristici asociate în momentul definirii 
entităţii. Fiecare din cele patru caracteristici poate să fie în una din 
stările On/Off sau Yes/No:  

• Invisible – invizibil  
• Constant – cu valoare constantă   
• Verify – cu verificarea valorii introduse în momentul 

inserării blocului  
• Preset – cu valoare prestabilită  

 
Comanda ATTdef creează atribute.   

 
În exemplul de mai jos a fost creat atributul “RUG”. El va fi 

selectat împreună cu semnul de rugozitate ca şi componentă a 
blocului “R”. La inserări succesive ale blocului, pot fi obţinute 
rezultatele din figura de mai jos. 

 

 
 
Exerciţiul 10.1. : Definirea şi inserarea blocurilor 
Definiţi un nou bloc. Înseraţi-l în desen, apoi înseraţi un 

fişier desen în desenul curent ca bloc. 
 
Definirea unui nou bloc 
1. Realizaţi desenul de mai jos. 
2. În bara cu instrumente Standard selectaţi Named Views, 

apoi:  
 În lista Name selectaţi vagon.  
 Selectaţi Set Current.  
 Selectaţi OK. 
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3. Măriţi vagonul. 
4. În bara cu instrumente Draw selectaţi Make Block. 
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5. În fereastra de dialog Block Definition tastaţi vagon în 
câmpul Name. 

6. Selectaţi Pick Point şi specificaţi ca Base Point capătul 
urechii de prindere. 

7. Selectaţi Select Objects şi selectaţi obiectele ce compun 
vagonul. 

8. Apăsaţi pe butonul din dreapta al mouse-ului pentru a vă 
întoarce la fereastra de dialog Block Definition. 

9. Sub Objects selectaţi Delete. 
10. Sub Preview Icon asiguraţi-vă că Create Icon From Block 

Geometry este selectat. 
11. Setaţi Insert Units la Inches.  
12. În câmpul Description tastaţi Vagon transport minereu. 
 

 
 

13. Selectaţi OK. Blocul este salvat, obiectele sunt şterse. 
14. În bara cu instrumente selectaţi Zoom Previous. 
 
Inserarea unui bloc. 
1. În bara cu instrumente Draw selectaţi Insert Block. 
2. În fereastra de dialog Insert selectaţi din lista Name blocul 

cu numele Vagon. 
3. Sub Insertion Point selectaţi Specify On-Screen. 
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4. Asiguraţi-vă că Specify On-Screen nu este selectat pentru 
Scale şi Rotation. 

5. Sub Rotation, în câmpul Angle tastaţi 10. 
6. Sub Scale, în câmpurile X şi Y tastaţi 0.5. 
6. Selectaţi OK. 
 

 
 

7. Ca punct de inserţie selectaţi un obiect de tip punct. 
Desenul vagon este inserat ca bloc. 

8. Apăsaţi pe butonul din dreapta al mouse-ului în fereastra 
de desenare şi apoi selectaţi Repeat Insert Block.  

9. Repetaţi paşii şi plasaţi încă două blocuri. 
 

 
Trei inserări ale blocului vagon. 

  
10. Sfârşit desen. 
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10.7. Inserarea unui fişier desen 
 
1. În bara cu instrumente Insert selectaţi Insert Block. 
2. În fereastra de dialog Insert selectaţi Browse. Este afişată 

fereastra de dialog Select Drawing File. 
3. Selectaţi fişierul Pupitru comandă.dwg reprezentând 

pupitrul de comandă din directorul ACAD2000, apoi selectaţi Open. 
 

 
 
4. Sub Insertion Point selectaţi Specify On-Screen. 
5. Asiguraţi-vă că Specify On-Screen nu este selectat pentru 

Scale şi Rotation. Scalaţi la 0.5. 
6. Selectaţi OK. 
7. Ca punct de inserţie, selectaţi un obiect de tip punct. 

Pupitrul de comandă este inserat ca bloc. 
8. Apăsaţi pe butonul din dreapta al mouse-ului în fereastra 

de desenare şi apoi selectaţi Repeat Insert Block. 
9. Repetaţi paşii 6 şi 7 şi plasaţi încă un bloc. 
10. Repetaţi paşi 1÷10 pentru a plasa patru vagoane. 
10. Salvaţi desenul. 
 
 
10.8. Scrierea obiectelor într-un fişier 
 
1. În linia de comandă tastaţi wblock, apoi apăsaţi ENTER. 

Este afişată fereastra de dialog Write Block. 
2. Sub Source selectaţi Objects, apoi selectaţi Retain. 
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3. Selectaţi Select Objects. 
 Folosiţi o selecţie de tip fereastră prin intersectare pentru 

a selecta obiectele ce compun desenul. 
 Apăsaţi SHIFT şi selectaţi obiectele ce nu aparţin de 

desenul transportorului şi care trebuie îndepărtate din 
setul de selecţie. 

 Apăsaţi ENTER pentru a vă întoarce în fereastra de dialog. 
4. În câmpul File Name tastaţi Transportor minereu nou.dwg. 
5. Din lista Insert Units selectaţi Inches. 
6. Selectaţi OK. Este creat un fişier desen al transportorului. 
Sfârşitul exerciţiului. 
 
 
10.9. Multiple Design Eviroment (MDE) 
 
Cu ajutorul Multiple Design Eviroment (MDE) puteţi: 
 Deschide desene multiple. 
 Prelua cu mouse-ul fişiere din Windows Explorer pentru a 

le plasa în sesiunea curentă de lucru. 
 Copia sau muta rapid obiecte dintr-un desen în altul. 
 Copia proprietăţile unui obiect dintr-un desen în altul. 
 Comuta între desene fără a întrerupe comanda curentă. 
 
Termeni cheie: MDE 
Multiple Document Interface – deschide documente 

multiple într-o singură sesiune. 
Single Document Interface - dacă variabila de sistem SDI 

este setată pe 1 este permis numai un singur desen deschis pe 
sesiune. Valoarea implicită este 0. 

Property Painter - copie proprietăţile unui obiect selectat şi 
le atribuie altor obiecte din desenul activ sau dintr-un alt desen 
deschis. 

Concurrent Comand Execution - în timp ce o comandă este 
activă într-un desen, comutaţi în alt desen şi începeţi o altă 
comandă. 

Active or Current Drawing - desenul în care lucraţi, într-o 
sesiune cu mai multe desene deschise. Dacă nu este maximizat, 
desenul activează bara de titlu albastră. Pentru a activa un desen, 
selectaţi un punct oarecare în interiorul lui sau selectaţi-l din 
meniul Window. 
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Folosirea MDE 
Deschiderea desenelor, multiple într-o sesiune: 
1. În bara cu instrumente Standard, selectaţi Open. 
2. Selectaţi un fişier. Ţineţi apăsată tasta CTRL şi mai 

selectaţi încă două fişiere. Selectaţi OK. 
3. Deschideţi Windows Explorer şi trageţi un desen AutoCAD 

într-o zonă deschisă a ferestrei AutoCAD, dar nu peste un desen 
deschis. 

 
Notă: Dacă daţi drumul unui fişier într-un desen deschis, 

fişierul va fi inserat ca bloc. 
 
4. Selectaţi de două ori un desen în Explorer pentru a-l 

deschide într-o nouă fereastră. 
 
Lucrul cu MDE 
1. Pentru a face un desen activ, selectaţi numele desenului 

din meniul Window. 
2. Pentru a vedea toate desenele deschise, selectaţi Cascade 

în meniul Window. 
3. Pentru a comuta între desenele deschise apăsaţi CTRL- 

TAB. 
 
 
10.10. Folosirea Windows Clipboard 
 
Folosiţi opţiunile Windows cut/copy şi paste în AutoCAD 

pentru a transfera date în interiorul unui desen sau într-un alt 
desen. Datele pot fi plasate ca obiecte individuale sau ca bloc. 
Obiectele sunt trecute in Windows Clipboard şi pot fi copiate într-o 
altă aplicaţie Windows. 

 
Termeni cheie: Opţiunile Windows de editare 
Copy - copie obiectele selectate în Windows Clipboard. 
 
Linia de comandă: copyclip 
Copy Base - copie obiectele în Clipboard şi apoi cere un 

punct de bază, la fel ca definiţia de bloc. 
 
Linia de comandă: copybase 
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Copy Link - copie vederea curentă în Clipboard. 
 
Linia de comandă: copylink 
Cut - şterge obiectele selectate din desen şi le plasează în 

Clipboard. 
 
Linia de comandă: cutclip 
Paste- inserează obiectele din Clipboard în desen. 
 
Linia de comandă: pasteclip 
Paste As Block - inserează obiectele din Clipboard în desen, 

ca bloc. 
 
Linia de comandă: pasteblock 
Paste To Original Coordinates inserează obiectele dintr-un 

desen în altul folosind aceleaşi coordonate ca şi în cel original. 
 
Linia de comandă: pasteorig 
Clipboard - aplicaţie a sistemului de operare Windows care 

conţine obiectele copiate sau tăiate dintr-un desen. 
 
Mutarea datelor dintr-un desen în altul 
Folosirea comenzilor Copy şi Paste pentru a transfera 

obiectele între desene: 
1. Apăsaţi pe butonul din dreapta al mouse-ului în desenul-

sursă şi apoi selectaţi, Copy With Base Point din meniul cursor. 
2. Selectaţi punctul din mijloc orizontale inferioare al figurii 

de bază. 
3. Selectaţi obiectele care definesc figura apoi apăsaţi ENTER. 

Obiectele selectate sunt transferate în Windows Clipboard. 
4. Apăsaţi CTRL+TAB pentru a comuta în desenul-destinaţie. 
5. Apăsaţi pe butonul din dreapta al mouse-ului în desen şi 

apoi selectaţi Paste As Block din meniul cursor. 
6. Selectaţi punctul de inserţie. Obiectele sunt inserate ca 

bloc, AutoCAD atribuie automat un nume, precum A$C069DI580. 
 
Observatie: Folosiţi comanda Rename pentru a schimba 

numele blocului. 
 



Crearea blocurilor 

 212 

Notă: Puteţi de asemenea copia/tăia şi muta informaţii din 
sau în alte aplicaţii Windows. 

 
 
10.11. Copierea proprietăţilor între desene 
 
1. Selectaţi în desenul Layout 1 pentru a-l face desen activ. 
2. În bara cu instrumente Standard selectaţi Match 

Properties. 
3. Selectaţi un obiect sursă ce are anumite proprietăţi. 
4. Selectaţi în desenul Layout 2 pentru a-l face desen activ. 
5. Pentru obiectele destinaţie selectaţi toate liniile. Apăsaţi 

ENTER pentru a încheia comanda. Obiectele din desenul Layout 2 
au acum aceleaşi proprietăţi ca cele din desenul Layout 1. 

 
Copierea obiectelor intre desene 
1. Desenaţi vagonul locomotivă de mai jos. Selectaţi un 

punct oarecare în desen pentru a-l face desen activ. 
 

 
 
2. În meniul File selectati Close. Selectati No pentru a nu 

salva schimbările. 
3. Deschideţi Windows Explorer. 
4. În Explorer, mutaţi-vă în directorul cu desenele de tutorial. 

În mod obişnuit, acesta este L\Aotc\AutoCADLevell. 
5. Ajustaţi mărimea ferestrei Explorer astfel încât şi AutoCAD 

2000 şi Explorer să fie afişate.  
6. Selectaţi şi trageţi desenul din Explorer şi mutaţi-l într-o 

suprafaţă liberă din fereastra AutoCAD, dar nu în desenul deschis. 
Desenul se deschide şi devine fereastră activă. 
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7. În meniul Window selectaţi Cascade. 
8. Apăsaţi pe butonul din dreapta al mouse-ului în desenul-

sursă şi selectaţi Copy With Base Point din meniul cursor. 
9. Selectaţi colţul din stânga jos al vagonului locomotivă ca 

punct de bază. 
10. Selectaţi obiectele ce definesc vagonul locomotivă şi 

apăsaţi ENTER. Obiectele selectate sunt transferate în Windows 
Clipboard. 

11. Apăsaţi CTRL+TAB pentru a comuta în desenul-
destinaţie. 

12. În bara cu instrumente Standard selectaţi Named Views, 
apoi: 

 În lista Name selectaţi Transportor minereu nou. 
 Selectaţi Set Current.  
 

 
 
13. Selectaţi OK. 
14. Apăsaţi pe butonul din dreapta al mouse-ului în desen şi 

selectaţi Paste As Block din meniul cursor. 
15. Ca punct de inserţie selectaţi obiectul de tip punct. 

Vagonul locomotivă este inserat ca bloc. 
16. Salvaţi desenul. Închideţi desenul. 
Sfârşitul exerciţiului. 
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10.12. Desenul de ansamblu 
 
Desenul de ansamblu este reprezentarea ortogonală a unui 

produs complex, compus din mai multe părţi componente – repere 
sau ansambluri de ordin inferior. 

 Scopul elaborării desenelor de ansamblu este acela de a 
prezenta părţile componente ale produsului, modul lor de îmbinare, 
modul de funcţionare a ansamblului, ordinea de montare şi 
demontare a componentelor, condiţiile tehnice pe care produsul le 
îndeplineşte. Desenul de ansamblu este indispensabil pentru 
activitatea de execuţie şi montaj a produsului respectiv, pentru 
proiectarea şi execuţia pieselor componente, pentru prezentarea şi 
comercializarea produsului, pentru exploatare şi întreţinere. 

 Desenul de ansamblu se poate executa ca o schiţă sau ca un 
desen la scară. Din raţiuni comerciale sau didactice el se mai poate 
prezenta: 

- ca o reprezentare 2D, sub forma unui desen de catalog (aşa 
cum se exemplifică în fig. 3) sau cu piesele separate (aşa cum este 
exemplificat în fig. 5); 

- ca o reprezentare 3D, cu componentele demontate. 
Standardul 6134 conţine regulile de bază pentru elaborarea 

desenelor de ansamblu în domeniul mecanic, adică: reguli generale 
de reprezentare şi reguli specifice, reguli de cotare, reguli de 
poziţionare a părţilor ansamblului şi completarea tabelului de 
componenţă. 

 
10.11.1. Reguli de reprezentare 
 
Prin desenul de ansamblu trebuie să se stabilească: 
- forma şi poziţia pieselor componente; 
- modul de asamblare a pieselor între ele; 
- modul de funcţionare a ansamblului; 
- dimensiunile de gabarit, de cuplare, de instalare şi de  
funcţionare. 
Conform standardelor desenelor de ansamblu: 
• Desenul de ansamblu trebuie să conţină un număr minim 

suficient de reprezentări (vederi, secţiuni) ce determină forma şi 
dimensiunile fiecărei piese şi interacţiunea dintre acestea. 
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• Poziţia de reprezentare a ansamblului se alege, de regulă, 
astfel, încât proiecţiaprincipală să corespundă cu poziţia de 
funcţionare. 

• Conturul a două piese alăturate se reprezintă printr-o  
singură linie de contur, comună celor două piese, dacă între piese 
nu există joc rezultat din dimensiunile nominale diferite. 

• Piesele pline (arbori, şuruburi, bolţuri etc.) se reprezintă în 
vedere, chiar dacă planul de secţionare trece prin axa lor de 
simetrie. La astfel de piese, pentru a evidenţia anumite forme 
interioare, se utilizează secţiuni parţiale. 

• Piese care execută deplasări în timpul funcţionării, pot fi 
reprezentate, pe aceeaşi proiecţie, şi în poziţie extremă şi în poziţii 
intermediare de mişcare. În poziţiile intermediare conturul pieselor 
se trasează cu linie două puncte, fără haşurare. 

• Sistemele de etanşare se reprezintă în poziţie de strângere. 
• Pentru reprezentarea mai clară a unor elemente acoperite, 

unele piese se pot considera, în mod convenţional, demontate sau 
îndepărtate, menţionându-se acest lucru pe proiecţia respectivă. 

 
10.11.2. Reguli de poziţionare a elementelor ansamblului 
 
• Fiecare piesă componentă a ansamblului este identificată 

printr-un număr  de poziţie, corespunzător numărului din tabelul  
de componentă. 

• Fiecare număr se înscrie la extremitatea unei linii de 
indicaţie. 

• Liniile de indicaţie se trasează înclinat, fără intersecţii între 
ele la o distanţă egală de conturul reprezentării nu mai mică de 30 
mm. 

• Numerele de poziţie se scriu cu cifre arabe, având 
dimensiunea nominală mai  mare decât  dimensiunile scrierii 
utilizate pentru cifrele de cotă. 

• Piesele componente se poziţionează pe proiecţia pe care ele 
apar mai clar. 

• Numerele de poziţie se înscriu pe desen în ordine 
crescătoare, pentru fiecare proiecţie  în parte,  într-un singur sens 
pe acelaşi desen de ansamblu. 
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10.11.3. Reguli de cotare a desenului de ansamblu 
Pe desenul de ansamblu se cotează: 
• dimensiunile de gabarit ale ansamblului; 
• dimensiunile de legătură cu piesele sau ansamblurile 

învecinate (de cuplare); 
• dimensiunile de instalare a ansamblului; 
• dimensiunile nominale ale pieselor care formează ajustaje. 
 
10.11.4. Tabelul de componenţă 
Desenul de ansamblu este completat cu un tabel în care se 

înscriu piesele şi articolele standard care compun ansamblul 
reprezentat. Acesta este tabelul de componenţă şi se execută 
conform SR ISO 7573:1994 pe formatul  A4 cu indicatorul forma 2 
SR ISO 7200: 1994 pe prima coală  

Tabelul de componenţă se completează de sus în jos şi constă 
din compartimente dispuse în ordinea următoare: documentaţia, 
complexe, unităţi de asamblare, piese, articole standard, alte 
articole, materiale, complete. 

Dacă ansamblul nu conţine  părţi componente referitor la un 
anumit compartiment, atunci acest compartiment în tabel este 
omis. 

Semnificaţia rubricilor tabelului de componenţă este 
următoarea (fig. 9.1): 

1 - formatul pe care este întocmit desenul de execuţie al 
fiecărui element component; 

2 - zona, în cazul în care formatul este împărţit în zone; 
3 - numărul de poziţie al fiecărui element component 

poziţionat pe desen; 
1 - notarea piesei după clasificatorul respectiv; 
2 - denumirea elementului component respectiv; 
3 - numărul de bucăţi ale elementului respectiv; 
4 - date suplimentare ce se consideră a fi indicate (materialul 

din care este executat elementul respectiv). 
În cazul în care reprezentările ansamblului şi tabelul de 

componenţă se încadrează în formatul A4, atunci desenul de 
ansamblu se reprezintă conform fig. 9.2. 
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Tabel de componenţă 

 
10.11.5. Succesiunea etapelor întocmirii desenului de 

ansamblu 
 
În procesul de instruire se admite întocmirea desenului de 

ansamblu după desenele de execuţie ale pieselor componente ale 
ansamblului. În acest caz succesiunea etapelor întocmirii desenului 
este următoarea: 

• studiul desenelor de execuţie ale pieselor componente ale 
ansamblului pentru clasificarea funcţionării lui şi destinaţiei în 
funcţionare a fiecărei piese; 
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• clasificarea elementelor componente în grupe conform 
compartimentelor tabelului de componenţă: piese, articole standard 
etc. 

• stabilirea reprezentărilor necesare (vederi, secţiuni); 
• alegerea formatului şi poziţiei lui în funcţie de mărimea 

ansamblului, de gradul de complexitate şi de numărul de 
reprezentări; 

• pregătirea formatului: trasarea chenarului şi conturului 
indicatorului; 

• reprezentarea piesei de bază (corpul) a ansamblului; 
• reprezentarea celorlalte piese componente în ordinea 

montării acestora; 
• cotarea desenului; 
• poziţionarea elementelor componente ale ansamblului; 
• completarea indicatorului şi a tabelului de componenţă. 
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LUCRAREA 11 
Realizarea unui desen tridimensional cu 
AutoCAD 

 
11.1. Scopul lucrării 
Lucrarea are ca scop însuşirea elementelor de bază în 

proiectarea în trei dimensiuni (3D), utilizând programul AutoCAD. 
 
11.2. Noţiuni teoretice 
11.2.1. Modalităţi de obţinere a desenelor în spaţiul 3D 
În general, sistemul AutoCAD poate fi utilizat pentru 

construirea şi reprezentarea obiectelor tridimensionale în 
următoarele moduri: 

 modelarea prin muchii, numită şi modelarea "wireframe", 
care permite obţinerea unor desene 3D care nu au 
suprafeţe, modelare frecvent utilizată datorită rapidităţii 
de construire, editare şi vizualizare pe ecran; 

 modelarea suprafeţelor, care adaugă suprafeţe reţelelor de 
muchii; 

 modelarea solidelor, care permite descrierea corpurilor şi 
în interior, astfel încât se pot determina informaţii ca: 
volumul, centrul de greutate ş.a. 

 
11.2.2. Construirea unui obiect 3D prin reliefarea unor 

obiecte 2D 
Orice desen realizat în spaţiul bidimensional XY este, de fapt 

un desen tridimensional pentru care coordonata Z a entităţilor 
componente este nulă. 

Cea mai simplă metodă de construire a unui obiect 3 D 
constă în adăugarea celei de-a treia dimensiuni (înălţimea) unui 
obiect 2D, adică prin reliefarea acestuia din urmă. 

Un astfel de obiect 3D este caracterizat prin: 
 înălţime, termenul utilizat fiind "thickness"; stabilirea 

unei înălţimi pentru un obiect permite extrudarea 
(reliefarea) acestuia deasupra sau sub planul de 
construcţie; 

 elevaţie, termenul utilizat fiind "elevation", definită ca 
distanţa obiectului în sus sau în jos faţă de planul de 
construcţie XY, măsurată pe axa Z. 

 Pentru a transforma o entitate 2D existentă într-o entitate 
3D prin adăugarea unei înălţimi (coordonata Z), privită ca 
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distanţa de relief are, se apelează comanda CHPROP, 
opţiunea Thickness, specificându-se înălţimea dorită. 

Pentru a stabili înălţimea şi elevaţia obiectelor grafice ce vor fi 
desenate ulterior, se apelează comanda Elev (Elevation), care 
permite precizarea celor două elemente ca răspuns la cererile: 

New current elevation <val. curentă>: 
New current thickness <val.curentă>: 
Obiectele grafice astfel construite nu dispun de interior. 
 
11.2.3. Instrumente AutoCAD pentru lucrul în spaţiul 3D  
Pentru a obţine desene 3D complexe, utilizatorul pachetului 

de programe AutoCAD are la dispoziţie o serie de facilităţi: 
- utilizarea sistemelor de coordonate ale utilizatorul (UCS) 

folosită deja în lucrările anterioare; 
- utilizarea filtrelor de coordonate .x, .y, .z, .xy, .xz, .yz, .xyz 

pentru specificarea unor puncte, care permit reţinerea 
coordonatelor precizate prin numele filtrului de la un alt punct 
reprezentativ existent, urmând ca celelalte să fie specificate ulterior; 

- utilizarea unor comenzi de desenare şi editare specifice; 
- posibilitatea de inserare în desen a unor obiecte 3D de tipul: 

 Box (paralelipiped) 
 Cone (con) 
 Dome (emisferă superioară)  
 Pyramid (piramidă) 
 Sphere (sferă) 
 Dish (emisferă inferioară) 
 Wedge (plan înclinat) 
 Tarus (tor) 
 Mesh (suprafaţă 3D)  

- afişarea izometrică (plan paralelă) şi în perspectivă a 
imaginilor 3D; 

Definirea şi manipularea coespunzătoare a sistemelor de 
coordonate ale utilizatorului prezintă o importanţă deosebită în 
desenarea în 3D; comanda UCS având opţiuni specifice. 

 
11.2.4. Command: UCS 

Origin/ZAxis/3point/Entity/View/X/Y/Z/Prev/Restore/Save/Del/
?/<World>: 
unde: 
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 opţiunea Origin permite definirea unui nou UCS prin 
translatarea celui curent; 

 opţiunea ZAxis permite definirea unui nou UCS prin 
specificarea unei noi origini şi a unui punct care indică 
direcţia pozitivă a axei Z; 

 opţiunea 3 point permite definirea unui nou UCS prin 
precizarea noii origini şi a două puncte care determină 
direcţiile pozitive ale axelor X şi Y; 

 opţiunea Entity defineşte un nou UCS prin alinierea lui la o 
entitate existentă care va trebui selectată, preluând de la 
aceasta direcţia axei Z; direcţia axei X fiind determinată de 
tipul entităţii şi de poziţia punctului de selecţie; 

 opţiunea View, defineşte un nou UCS care are planul XY 
perpendicular pe direcţia de vizualizare a desenului (axa Z va 
fi paralelă cu direcţia de vizualizare) şi originea aceeaşi cu a 
vechiului UCS; 

 opţiuniile X/Y/Z rotesc UCS-ul curent în jurul axei 
respective cu un unghi care va fi specificat;  

 opţiunea Prev permite resturarea ultimului UCS; 
 opţiunea Restore permite restaurarea unui UCS salvat 

anterior cu un nume dat; 
 opţiunea Save permite salvarea UCS-ului curent cu un nume 

care va fi precizat (maxim 31 de caractere); 
 opţiunea Del permite ştergerea unor UCS-uri dintre cele 

salvate anterior; 
 opţiunea ? permite listarea numelui UCS-ul curent precum şi 

a unor informaţii legate de toate UCS-urile salvate; 
 opţiunea World determină stabilirea ca UCS curent a 

sistemului fix de coordonate al lumii WCS. 
 
Desenarea suprafeţelor plane în spaţiul tridimensional se 

realizează cu comanda 3DFACE. Secvenţa de cereri care apar după 
selecţie este: 

 
Command: 3DFACE 
First point: 
Second point:: 
Third point: 
Fourth point: 
Third point: 
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punctele trebuind să fie specificate în sens trigonometric. 
 
Dacă punctele care definesc suprafaţa 3D sunt coplanare, 

atunci suprafaţa va fi considerată opacă de către operaţia de 
ascundere a muchiilor. 

Alte tipuri de suprafeţe 3D nefiind utilizate în realizarea 
desenului ce face obiectul lucrării, celelalte comenzi de desenare în 
3D nu vor fi folosite. 

Sistemul AutoCAD oferă posibilitatea vizualizării desenelor, 
din orice punct de vedere în spaţiul de desenare numit şi spaţiu 
model. 

O posibilitate simplă de a vizualiza un obiect 3D în spaţiul 
model, din orice punct de referinţă, este utilizarea comenzii VPOINT 
(ViewPOlNT). Comanda permite specificarea unghiului de vedere; 
adică a direcţiei dreptei imaginare care uneşte punctul de vedere cu 
punctul de coordonate (0,0,0), dar nu şi a distanţei de la care este 
observat desenul, acesta fiind scalat astfel încât să ocupe tot 
ecranul. După apelul comenzii, apar opţiunile: 

 
11.2.5. Studiul unor comenzi pentru vizualizarea 

modelelor 3D  
 
 Termenul de vizualizare spaţială este aplicat oricărei 

probleme de vizualizare, care nu este complet rezolvabilă printr-o 
singură vizualizare plană. Suportul software pentru realizarea 
funcţiilor de vizualizare îl constituie implementarea conceptelor 
sisteme de coordonate şi transformări. În plus, sunt incluse 
programe pentru eliminarea de linii  şi suprafeţe ascunse (în cazul 
solidelor netransparente), umbrire şi colorare.  

 Toate aceste programe permit o vedere realistă a modelelor, 
contribuind la îmbunătăţirea procesului de proiectare.  Metoda 
utilizată pentru a genera imagini ale unui obiect 3D constă în 
transformarea punctului de vedere determinat de vectorul liniei de 
vedere (figura 11.1). 
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Figura 11.1.     Figura 11.2. 

 
VPOINT (View POINT) – Comanda permite definirea poziţiei 

punctului de vedere din care este privit sistemul de axe. Iniţial, 
acest punct de vedere este amplasat în poziţia (0,0,1), deci la 
înălţimea de o unitate pe axa OZ. Înălţimea de la care se priveşte 
este neimportantă, deoarece proiecţia este paralelă.  
 

 
 

Command: vpoint  
Rotate/<View point><0.00,0.00,1.00>: 
 

Răspunzând prin valorile coordonatelor x, y, z, cerem ca 
punctul din care privim axele să fie plasat în poziţia dată de cele trei 
coordonate. Originea (0,0,0) şi punctul introdus determină linia de 
vedere. Opţiunea „Rotate” permite specificarea noului punct de 
vedere în termenii a două unghiuri, pe care linia de vedere le face cu 
axele (fig. 11.1).  
  α1 – unghiul făcut cu axa X în planul XOY;  
  α2 – unghiul făcut cu planul XOY.  
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Cea mai comodă cale de indicare a punctului de vedere se 
face răspunzând prin <R> la prima cerere. În acest caz, ecranul se 
şterge şi sunt prezentate dinamic axele, potrivit cu mişcarea 
cursorului ca în fig. 11.2. Imaginea prezentată în dreapta-sus pe 
ecran este reprezentarea bi-dimensională a unui glob: centrul său 
este polul nord (0,0,1), cercul interior este ecuatorul (n,n,0) iar 
cercul exterior este polul sud (0,0,–1). Liniile reprezintă axele X  şi 
Y. Prin mişcarea cursorului în interiorul acestui glob se poate 
selecta punctul de vedere dorit.  

Pentru a obţine o proiecţie ortogonală pe unul din planurile 
sistemului de referinţă sau o vedere izometrică a obiectelor desenate  
în AutoCAD 14, se poate folosi opţiunea 3D Viewpoint din meniul 
desfăşurabil View. O cale mai rapidă, este prin acţionarea barei de 
instrumente asociate. Aceasta conţine o serie de butoane asociate 
principalelor puncte de vedere utilizate în desenul tehnic (fig. 10.6). 
 

11.2.5. Command: VPOINT 
 
Rotate/<View point> <val.curentă> 
Există astfel trei metode de specificare a punctului de vedere: 
1)- specificând coordonatele relative la UCS-ul curent sau la 

WCS; 
2)- selectând opţiunea Rotate, care presupune indicarea 

punctului de vedere prin specificarea a două unghiuri : 
- unul, măsurat în planul XY faţă de axa X, ca răspuns la 

cererea „ Enter angle în XY plane from X axis <0>”:  
- celălalt, măsurat faţă de planul XY ca răspuns la cererea, „ 

Enter angle from XY plane <0>": 
3) - selectând opţiunea implicită View point prin furnizarea 

unui răspuns nul, caz în care este permisă specificarea dinamică a 
punctului de vedere prin afişarea unui compas şi a unui reper XYZ; 

Compasul este o reprezentarea 3D a unui glob, centrul său 
fiind polul nord, cercul interior ecuatorul, iar cercul exterior polul 
sud. Liniile reprezintă axele x şi y. Astfel: 

-alegând un punct înăuntrul cercului interior, punctul de 
vedere va fi situat deasupra planului XY; 

-alegând un punct între cele două cercuri punctul de vedere 
va fi situat sub planul XY; 

Odată cu deplasarea dispozitivului indicator în zona 
compasului, se va deplasa corespunzător un cursor în formă de 
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cruce, poziţia axelor reperului XYZ urmărind poziţia cursorului. 
Vizualizarea se realizează întotdeauna privind înapoi spre origine 
din punctul de vedere specificat. 

Deşi comanda VPOINT afişează desenul în 3D, acestuia îi 
lipseşte perspectiva entităţile fiind afişate în proiecţie plan paralelă 
(obiectele mai îndepărtate nu apar ca fiind mai mici). Această 
metodă de vizualizare este însă uşor de utilizat. 

Pentru că lucrul în trei dimensiuni poate duce la situaţii 
confuze, mai ales în cazul desenelor complexe există posibilitatea 
eliminării liniilor ascunse în spatelele altor obiecte. În acest scop se 
apelează comanda HIDE care este capabilă să decidă ce porţiuni 
sunt vizibile în vederea aleasă şi ce porţiuni sunt ascunse şi deci 
trebuie omise în reprezentare. În timpul procesului de ascundere, 
prin intermediul unor mesaje sistemul AutoCAD raportează 
procentul din operaţia de ascundere efectuat, în incremente de 
10%. 

Sistemul AutoCAD oferă şi posibilitatea de "umbrire" a 
desenului; înţelegând prin aceasta umplerea suprafeţelor 3D cu 
culoarea cu care au fost desenate. Se dă astfel obiectelor un aspect 
solid, în acest scop, se apelează comanda SHADE, care determină 
ştergerea temporară a desenului de pe ecran, regenarea si 
reafişarea acestuia raportându-se procentul de realizare a operaţiei. 

 
Exerciţiul 11.1. 
Se va realiza, desenul 3D de mai jos; urmărindu-se 

vizualizarea acestuia din mai multe puncte de vedere. 
1. Lansaţi în execuţie programul AutoCAD, apoi deschideţi 

un fişier model. 
2. Apelând comanda polygon, se trasează suprafaţa de bază 

a piesei (reprezintă un triunghi echilateral cu colţurile rotunjite): 
 În bara cu instrumente Draw selectaţi Polygon; 
 În linia de comandă tastaţi 3 apoi apăsaţi ENTER pentru a 

specifica numărul de laturi; 
 Specificaţi punctul de centru al poligonului de coordonate 

140,100 şi apoi apăsaţi ENTER; 
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 În linia de comandă tastaţi c apoi apăsaţi ENTER pentru a 
specifica un poligon circumscris; 

 În linia de comandă tastaţi 30 pentru a specifica raza apoi 
apăsaţi ENTER; 

 În bara cu instrumente Modify selectaţi Fillet, apoi; 
 Apăsaţi pe butonul din dreapta al mouse-ului în fereastra 

de desenare, apoi selectaţi Radius. 
 În linia de comandă tastaţi 10, apoi apăsaţi ENTER. 
 Repetaţi comanda Fillet, apoi selectaţi polyline şi colţurile  

triunghiului vor fi racordate cu o rază de 10 unităţi; 
3. Desenaţi cele trei găuri cu raza de 6 unităţi: 

 În bara cu instrumente Draw selectaţi Circle. 
 Activaţi comanda OSNAP pentru a pune în evidenţă 

punctele importante; 
 Selectaţi centrul arcului de record stânga jos pentru a 

specifica centrul cercului. 
 În linia de comandă tastaţi 6 şi apoi apăsaţi ENTER 

pentru a specifica raza. 
Repetaţi aceste operaţii pentru a desena şi celălalte două 
cercuri; 
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4. Se adaugă cea de-a treia dimensiune (înălţimea) 
pătratului. Pentru aceasta, se apelează comanda CHPROP, se 
selectează laturile triunghiului, apoi opţiunea Thickness şi se 
specifică 30 unităţi de desenare pentru înălţime. 

5. Se apelează comanda de vizualizare VPOINT, specificând 
coordonatele 1,1,1 pentru direcţia de vizualizare. 

6. Pentru că vederea va ocupa tot ecranul, se modifică 
factorul de zoom cu comanda ZOOM, specificând 0.4x . 
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7. Se realizează operaţia de ascundere a liniilor, apelând 
comanda HIDE. 

 

 
 

8. Apelând comanda 3DFACE se trasează suprafaţa plană a 
capacului suprafeţei triunghiulare, specificând colţurile acestuia, în 
sens trigonometric, prin utilizarea modului INTersection al 
mecanismului OSNAP. 

9. Se stabileşte elevaţia curentă de 30 şi înălţimea curentă de 
20 apelând comanda ELEV.  

10. Se desenează cilindrul mare cu înălţimea de 20 apelând 
comanda circle şi specificând  

 În bara cu instrumente Draw selectaţi Circle. 
 Selectaţi centrul specificând coordonatele 140,100,30; 
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 În linia de comandă tastaţi 25 şi apoi apăsaţi ENTER 
pentru a specifica raza. 

 

 
 

11. Cu comanda ELEV, se modifică elevaţia curentă la 
valoarea 50 şi înălţimea curentă de 50. 

12. Se desenează al doilea cilindru cu înălţimea de 50 
apelând comanda circle şi specificând: 

 În bara cu instrumente Draw selectaţi Circle. 
 Selectaţi centrul specificând coordonatele 140,100,50; 
 În linia de comandă tastaţi 15 şi apoi apăsaţi ENTER 

pentru a specifica raza. 
13. Apelând comanda 

HIDE, se realizează operaţia 
de ascundere a liniilor. 
14. Cu comanda VPOINT se 
vizualizează desenul din 
punctul de vedere 
(140,100,150). 
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Vederea desenului realizat până acum, din punctul de vedere 

determinat de punctul de coordonate (1,1,l) va fi: 
 

 
 

15. Pentru desenarea suprafaţei de sus a piesei se stabileşte 
un sistem nou de coordonate al utilizatorului. În acest scop, se 
apelează UCS, opţiune ZAxis, la cererea „Origin point” <0,0,0>:" 
specifîcându-se punctul de coordonate (140,100,100) iar la cererea 
„Point of positive portion of the Z axis <val. curentă>”  specifîcându-
se @ 1,0,0. Sensul pozitiv al axei Z va fi sensul pozitiv al axei X din 
sistemul fix WCS.  

16. Cu comanda ELEV, se stabileşte elevaţia curentă de -30 
şi înălţimea curentă de 60. 
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16. Apelând comanda line, se trasează suprafaţa de sus a 
piesei specificând pe rând coordonatele (20;20), (-20;20), (-20;-20), 
(20;-20), iar în final Close. 

17. Cu comanda HIDE, se ascund liniile din spatele feţelor; 
 

 
 

18. Cu comanda 3DFACE, se desenează capacul 
paralelipipedului după direcţia pozitivă a axei Z. Pentru indicarea 
celor patru puncte se poate utiliza mecanismul OSNAP 
INTersection. 

17. Cu comanda HIDE, se ascund liniile din spate; 
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Vederea desenului realizat din punctul de vedere determinat 
de coordonatele (-1,-1,-l) va fi: 

 
 

 
 

 
Exerciţiul 11.2. 
După parcurgerea acestui exerciţiu vom recapitula şi putea 

face urmatoarele: 
 Să convertim un  obiect bidimensional in polilinii 
 Să folosim comenda Extrude pentru a crea corpuri solide cu 

ajutorul unei entităţi alcătuită din polilinii 
 Să folosim comenzile Revolve, Subtract pentru a crea corpuri 

solide cu ajutorul unei entităţi alcătuită din polilinii 
In imaginea de mai jos se afla o vedere preliminara a 

modelului pe care-l vom construi cu componentele identificate. 
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Figura 1 
 

Pentru a incepe lecţia deschideţi fisierul template creat 
anterior. 

Acum salvaţi fisierul sub denumirea Flansa. După care 
selectaţi Model de pe tab-ul din partea de jos a ecranului, figura 2. 

 

 
 

Figura 2 
 

Pentru a construi modelul, vom crea o serie de elemente 
bidimensionale, care pot fi convertite în solid pentru a forma prima 
parte a modelului, placa de bază. Primul element de care avem 
nevoie este un cerc. Vom poziţiona centrul cercului in punctul 0,0. 
Vom fiza raza de 80mm. Vezi figura 3. 
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Figura3 
 

După ce am desenat acest cerc, se adaugă un cerc cu rază 
5mm pe verticală, care este aliniat cu centrul cercului mai mare şi 
la 65mm deasupra acestuia, figura 4. 

 

Figura 4. 
Folosind cercul nou creat, veţi activa comanda Array, pentru 

a face mai multe copii ale cercului. Există două comenzi de matrice 
în AutoCAD, una pentru elemente 2D şi una pentru solide. Fiecare 
comanda Array este capabilă să producă două tipuri de matrice, 
dreptunghiulare şi polare. Pentru a accesa această comandă 
selectaţi Array în meniul Modify. Uită-te la figura 5, care oferă o 
vizualizare a casetei de dialog Array, care va apărea după ce Polar 
Array este selectat. Elementele din această casetă de dialog de care 
aveţi nevoie pentru sunt numerotate pentru a se potrivi indicaţiilor. 
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Figura 5 
 

În caseta de dialog Array, selectaţi butonul Polar 
2. Apoi, faceţi clic pe butonul Select an object. AutoCAD vă 

întoarce la desen, astfel încât să puteţi selecta elementul sau 
elementele pe care doriţi să le folosiţi în matrice. Faceţi clic pe 
marginea cercului mai mic adaugat şi apăsaţi Enter. Va reveni la 
caseta de dialog Array. 

3. Pe caseta de dialog, apăsaţi butonul din dreptul a ferestrei 
de selecţie a punctului Center:. Din nou, va reveni la desen. De 
această dată utilizaţi Osnap Center pentru a selecta centrul cercului 
mare ca centrul de la matrice. 

4. Acum, localizaţi fereastra cu eticheta: Number Items: şi 
scrieţi 20 în fereastră. Lăsaţi Angle to fill - unghi de umplere - la 
360,. Faceţi clic pe OK pentru a finaliza matricea şi ieşiţi din caseta 
de dialog. Matricea completă va arăta figura 6. 
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Figura 6. 
Salvaţi desenul. 
Cu matricea completă, vom folosi comanda Extrude pentru a 

converti cercurile in solide cilindrice. 
Comanda Extrude pot fi utilizate numai cu polilinii obiecte 

care au o contur închis condiţie care în cazul nostru este 
îndeplinită. 

Folosind comanda Extrude vom da o grosime elementelor 
create. Putem face acest lucru pentru mai multe polilinii odata atât 
timp cât înalţimea (grosimea) acestora este la fel de mare. 

Apasaţi butonul Extrude  de pe bara de instrumente Solids, 
sau scrieţi în bara de comandă Extrude,  

 
după care selectaţi toate obiectele (cercurile)  

 Tastaţi 10 pentru înălţimea extrudării 
 Tastaţi Enter pentru a pastra direcţia perpendiculară 
Desenul nu va arăta diferit pe ecran. Pentru a se vedea 

extrudarea trebuie schimbat punctul de observaţie (view point) prin 
comanda Vpoint 

 Tastaţi Vpoint apoi Enter: 
 Apasaţi R pentru Rotate 
 Tastaţi 300 
 Tastaţi 30 

Acum imaginea trebuie să arate ca cea din figura7 
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Figura 7. 

 
Pentru completarea plăcii de bază trebuie folosită operaţia 

Subtract pentru a extrage conturul găurilor din placă. In modul de 
vizualizare wireframe (cel din fig. 7) nu se observă modificările în 
urma operaţiei Subtract, de accea trebuie sa încercăm diferite tipuri 
de vizualizări Hide sau Render. Pentru Hide tastaţi hide sau hi iar 
feţele vor deveni opace, muchiile ascunse vor dispărea din cadru. 

De pe bara Solids editing selectaţi Subtract. 

 
 Selectaţi o muchie exterioară a plăcii de bază (cercul mare) 

apoi Enter 
 Selectaţi muchiile tuturor cilindrilor mici care au fos creaţi 

(2o) apoi Enter 
 Din placa de baza vor fi extraşi cei 20 de cilindri iar figura va 

arăta ca mai jos. 
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Figura 8 

 
Placa de bază este acum completă. 
 
Partea a doua a modelului este suportul rulmentului. Inainte 

de a începe lucrul efectiv la această parte trebuie modificat Vpoint 
astfel: 270 grade in planul XY and 90 grade fata de planul XY  

Desenul va arăta la fel ca la primii paşi. 
Suportul rulmentului va fi creat ca şi placa de bază, pornind 

de la un obiect 2D pe care apoi îl vom extruda însă vom acţiona 
diferit, adică vom converti elemente in polilinie cu comanda Pline 
pentru a avea un contur închis. 

Incepem prin a ne muta zona de construcţie pe o parte liberă 
a desenului, în partea stângă a desenului. 

Construim un cerc cu raza de 10 mm. Apoi faceţi o copie a 
acestui cerc în partea stângă a primului cerc, aliniat pe orizontală, 
la distanţa de 96 mm. Va rezulta imaginea alăturată. 

 
Figura 8 

Construiţi o linie care să unească centrele celor două cercuri, 
linie ce vă va ajuta să desenaţi un cerc cu centrul pe mijlocul ei şi 
cu raza de 25 mm. (figura 9) 
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Figura 9 

 
Păstraţi lina creată anterior pentru a plasa suportul 

rulmentului pe placa de bază deja creată. 
Acum duceţi tangentele la cele două cercuri pentru a realiza 

figura de mai jos, fig. 10. 

 
Figura 10 

 
Folosiţi comanda Trim pentru a tăia şi realiza desenul de mai 

jos, fig. 11. 
 

 
Figura 11 

Acum trebuie să creăm o polilinie inchisă din elementele pe 
care le-am desenat. Vom face acest lucru cu ajutorul opţiunii Join 
din comanda Polyline. 
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 Tastaţi comanda Pedit în bara de instrumente. 
 Selectaţi arcul din stânga, apoi Enter – convertirea în 

polilinie 
 Tastaţi J 
 Selectaţi element cu element până se ajunge la primul arc 

selectat apoi apăsaţi Enter. 
 Figura apare exact la fel însă se poate selecta în întregime cu 

un singur click pe orice element. 
 

 
Atenţie: nu includeţi şi segmentul ce uneşte centrele celor două 
cercuri. 
 

Urmează extrudarea profilului anterior creat. 
Înainte de a face acestă operaţie trebuie modificat modul de 

vizualizare. 
 Tastaţi vpoint şi apoi introduceţi 300 grade în planul XYşi 30 

grade faţă de planul XY. Veţi obţine această orientare.(fig. 12) 

 
Figura 12 

 
 Folosiţi comanda Extrude cu o înălţime pozitivă de 20, fară 
înclinare pentru a crea corpul solid al suportului rulmentului. Va 
rezulta corpul din figura 13. 
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Figura 13 

 

 
Observaţie: In cazul în care comanda Extrude nu realizează 

corpul solid propus verificaţi fiecare conexiune între elementele 
poliliniei. Orice întrerupere, oricât de mică în continuitatea poliliniei 
duce la imposibilitatea executării comenzii. Aşadar, identificaţi şi 
reparaţi întreruperile dintre linii şi apoi executaţi din nou comanda 
Extrude. 
 Folosiţi comanda Move pentru a muta corpul nou costruit 
peste mijlocul plăcii de bază existentă.Folosiţi mijlocul segmentului 
de pe baza suportului rulmentului şi centrul cercului superior al 
placii de bază. (fig.14) 

După această operaţie putem şerge segmentul de pe baza 
suportului rulmentului (element auxiliar ce poate fi şters). 
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Figura 14 

 
Pentru ultima parte a modelului, vom crea un cilindru cu o 

gaura teşită. Vom aplica comanda Revolve unei polilinii 2D pentru a 
forma un corp solid. Comanda Revolve poate fi folosită pentru a 
crea forme circulare sau pe un arc de cerc, din orice polilinie 
închisă. 

Pentru început trebuie definit prin comanda UCS planul de 
lucru pe planul Front. 

 Activaţi UCS 
 Tastaţi g pentru ortografic 
 Tastaţi f pentru front 
Planul de lucru s-a modificat (se observă şi modificarea formei 

cursorului, firele reticulare orientate dupa planul vertical, front, de 
lucru) 

Vom începe construcţia cilindrului găurit în aceleşi fel ca şi 
corpul anterior, ca o serie de linii pe care apoi le vom converti în 
polilinii. 

Schimbăm punctul de observaţie vpoint: 270 grade in planul XY 
şi 0 grade faţă de planul XY. 

Realizaţi într-un spaţiu liber de pe ecran desenul de mai jos. 
Acesta va fi mai târziu mutat pe suportul de rulment. 
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Figura 15 

 
Observaţie: În partea dreaptă a desenului se observă că 

apare o linie ajutătoare, o linie de construcţie. Aceasta va fi axa de 
rotaţie in jurul careia se va construi solidul, si va fi ştearsă după 
construcţie. 

După ce aţi construit desenul, realizaţi conturul închis 
folosind comanda Pedit si opţiunea Join. 

Realizăm corpul solid cu ajutorul comenzii Revolve astfel: 
 Apăsăm butonul Revolve din bara de instrumente Solids. 

 
 Selectăm polilinia creată anterior apoi Enter 
 Selectăm cele două capete ale liniei de construcţie creată 

anterior ca fiind axă de revoluţie. 
 Specificaţi unghiul de revoluţie – implicit 360 

Acum desenul trebuie să arate ca în figura 16: 
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Figura 16 

 
Pentru a vedea desenul tridimensional trebuie modificat punctul de 

observaţie vpoint: 300 grade în planul XYşi 30 grade faţă de planul XY. 

 
3D wireframe   Hidden 

Figura 17. 
 

Etapa următoare va fi combinarea corpului nou creat cu cele 
anterioare, adică deplasarea corpului nou creat deasupra suportului de 
rulment. 

Când aşezăm cilindrul creat pe partea superioară a suportului de 
rulment, va trebui să fim siguri că selectăm punctele de referinţă corecte pe 
solide astfel încăt acestea să fie corect aliniate. 

Folosim comanda Move şi selectăm centru cercului de bază al 
cilindrului ca şi punct de bază al mutării. La specificarea poziţiei secundare 
selectăm unul din centrele arcelor de cerc mare de pe suprafaţa de sus a 
suportului rulment. 
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 Observaţie: Pentru a selecta centrul acestor elemente trebuie 
să poziţionăm cursorul mai întâi pe linia cercului corespunzător. 
Atenţie la selectarea corectă a cercului deoarece modul de 
vizualizare Wreframe uneori este înşelător. Putem folosi în schimb 
modul de vizualizare Hide pentru a ascunde liniile ce sunt în 
spatele suprafaţelor. 

 
Figura 18 

 
 Pentru a verifica poziţionarea cilindrului schimbaţi punctul 
de observaţie Vpoint: 270 grade in planul XY şi 0 grade faţă de 
planul XY. Dacă cilindrul nu este corect poziţionat ar trebui să 
vedeţi că se află deasupra sau dedesubtul suprafeţei superioare a 
suportului de rulment. In figura 19 este prezentat modelul corect. 

 
Figura 19. 
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Dacă după verificare se constată că nu sunt greşeli, se 
modifică punctul de observaţie din nou; vpoint: 300 grade în planul 
XYşi 30 grade faţă de planul XY. 

Acum avem trei corpuri solide separate: 
 Placa de bază 
 Suportul rulmentului 
 Cilindrul cu gaură 
Pentru a crea un singur corp solid din aceste trei corpuri folosiţi 

comanda Union. 

 
Observaţie: Unirea solidelor s-a facut doar după ce am 

construit în totalitate corpurile componente. Dacă am făcut operaţii 
Union sau Subtract şi descoperim că s-a greşit la poziţionare foarte 
greu pot fi corectate. Păstraţi corpurile ca şi entităţi separate şi doar 
când sunteţi sigur că toate elementele modelului sunt corect 
construite şi poziţionate aplicaţi operaţiile de Union sau Subtract. 
Acum avem un singur solid cu care lucrăm: 

La aceasta vom crea găurile de pe capetele suportului de 
rulment. 

Schimbăm UCS-ul (planul de desenare şi originea) la cel 
iniţial World.Folosim comada Cylinder pentru a crea doi cilindri cu 
raza de 5 mm şi inalţi de 20 mm, concentrici cu arcele mici ale 
suportului de rulment. 

 Apăsăm butonul Cylinder de pe bara Solids: 

 
 Selectăm centrul arcului de cerc de pe faţa superioară a 

suportului de rulment 
 Tastaţi 5 ; raza cilindrului 
 Tastaţi -20 ;înalţimea cilindrului 
După ce cilindrul a fost creat puteţi face la fel pentru cel de-al 

doilea cilindru sau puteţi să-l copiaţi folosind ca punct de referinţă 
centru cecului feţei superioare a cilindrului şi apoi cu funcţia 
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Pasteclip aduceţi din memorie şi inseraţi al doilea cilindrul în partea 
diametral opusă. 

Aplicaţi operaţia Subtract pentru a extrage cilindrii din corpul 
piesei. 

Vom obţine modelul 3D din figură: 

 
Figura 20 

 
Pentru a finaliza piesa adăugaţi un cilindru care să continue 

gaura din cilindrul superior şi prin placa suport rulment, cât şi prin 
placa de bază, astfel încât piesa să capete rol funcţional. 

Cilindrul trebuie să fie poziţionat pe faţa superioară a 
suportului de rulment şi să aibă o înălţime suficientă încât să 
strapungă atât suportul de rulment cât şi placa de bază. Acestea 
însumate au grosimea de 30 mm, deci înălţimea minimă trebuie să 
fie de 30 mm. 

După construirea cilindrului piesa arată ca în figura: 

 
Figura 21 
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Apoi folosiţi comanda Subtract  pentru a extrage cilindrul 
din corpul piesei. 

Acum piesa este finalizată. 
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LUCRAREA 12 BREVIAR DE COMENZI. FUNCŢII PE TASTE 

 
1. Terminologie AutoCAD 
 
Vom explica în continuare câţiva termeni de bază necesari 

pentru demararea unui desen în AutoCAD. 
 

Acad.dwt  Acesta este un format implicit care se încarcă 
automat atunci când pornim să desenăm în 
AutoCAD.  

Backup 
file  

AutoCAD-ul poate salva automat un backup al 
desenului. Boate fi considerat la un moment dat ca 
fiind un fisier de rezervă atunci când fişierul current 
este afectat şi nu mai poate fi accesat. Acesta se 
salvează cu extensia .bak. 

Crosshairs Colimatorul. Cursorul îşi schimbă aspectul atunci 
când este în spaţiul de desenare.  

Dialog box  AutoCAD utilizează numeroase  ferestre de dialog.  
Drawing 
template 
file  

Este fişierul ce conţine cele mai frecvente şabloane. 
AKA un desen prototip. Extensia fişierului este DWT.  

Grid  Reţea de puncte amplasată pe ecran. Aceasta ajută 
uneori la trasarea liniilor. Poate fi activă sau inactivă 
(on/off) prin apasarea tastei funcţionale F7.  

Grips  Puncte de selecţie sau selectori care apar în anumite 
poziţii atunci când un obiect este selectat. Ele permit 
modificarea entităţilor sau obiectelor prin deformare.  

Layer  Toate entităţile sau obiectele sunt desenate cu 
ajutorul layer-elor. Se pot grupa entităţi sau obiecte 
(cum ar fi electronice, cablări, etc.) pe un singur 
Layer şi permite o anumită organizare a desenelor pe 
grupuri de utilizare.  

Layout 
Tabs  

Spaţiu utilizat pentru plotarea desenului denumit şi  
Paper Space.  

Limits Presupune o limitare a zonei de desenare curentă. 
Linetype  Majoritatea obiectelor sunt desenate cu un anume tip 

de linie. Exemplu linie continuă, linie punct, etc.  
Model 
space  

Spaţiul în care desenam sau modelăm 3D.  
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Modify  Termen generic utilizat pentru modificarea entitaţilor 
sau obiectelor. 

Object  Orice element geometric cunoscut deasemenea şi sub 
denumirea de entitate.  

Origin  Punctul de coordonate (0,0).  
Ortho 
mode  

Reprezintă un mod de desenare în care putem trasa 
lini doar perpendiculare (pe orizontală şi pe verticală). 
Poate fi activ sau inactiv (on/off) prin apasarea tastei 
funcţionale F8. 

Osnap - 
Object 
Snap  

Permite selectarea precisă a punctelor pe entităţi. 
Poate fi activă sau inactivă (on/off) prin apasarea 
tastei funcţionale F3. 

Pick  Selecţia unei entităţi prin 'click-stanga' direct pe ea.  
Plot  Cunoscut sub numele de  print. Reproduce o copie a 

desenului pe hartie.  
Property  Specifică caracteristicile unui obiect  cum ar fi layer, 

scale, linetype, start point, etc.  
Selection 
set  

Grup curent de entităţi selectate.  

Snap  Reprezintă un mod de desenare în care putem „sări” 
din punct în punct pe o reţea de puncte grid. Poate fi 
activă sau inactivă (on/off) prin apăsarea tastei 
funcţionale F9. 

Styles  Defineşte un stil de scriere: text, dimensiuni, etc.  
Units  Stabileşte unităţile curente pentru desenul 

dumneavoastră. De exemplu, putem folosi incii sau 
millimetrii. 

User co-
ordinate 
system 
(UCS)  

Modificarea World Co-ordinate System (WCS) are ca 
efect User Co-ordinate System (UCS) sistemul de 
coordonate al utilizatorului. 

Zoom  Mărirea unei zone din desen (zoom in) sau micşorarea 
unei zone din desen (zoom out). 

 
2. Codificarea tipurilor de comenzi este următoarea: 
 

D = Desenare 
E = Editare 
S = Setare 
B = Blocuri 
e = Dimensionare 
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# = Comenzi de lucru cu UCS  
A = Afişare {Display) 
I = Informare 
T = Obţinerea copiilor hard ("plot", „prplot")  
F = Fişiere 
3 = 3D 
  = Utilitare 
D 3DFACE: creeaza entităţi în formă de triunghi sau patrulater 
plane sau strâmbe 
3 3DFACE: defineşte entităţi poligonale cu 3 sau cu 4 laturi, plane 
sau spaţiale 
B 3DLINE: desenează segmente de dreaptă între orice 2 puncte 3D 
3 3DMESH:. permite definirea unei entităţi de tip reţea spaţială de 
patrulatere, dispusă după două direcţii de generare 
3 3DPOLY: defineşte polilinii compuse din segmente 3D 
S APERTURE: setează dimensiunea pătrăţelului selector utilizat la 
modurile Osnap  
D ARC crează entităţi plane de tip arc de cerc  
I .AREA: calculează arii de suprafeţe plane 
E ARRAY: multiplică polar sau rectangular un set de entităţi 
B ATTDEF: permite definirea entităţilor negeometrice simple de tip 
atribut 
A ATTDISP: stabileşte modul de afişare a atributelor în desen 
E ATTEDIT: editează atribute 
  ATTEXT: permite extragerea atributelor dintr-un desen într-un 
fişier separat, dupa un şablon specificat 
S AXIS: permite afişarea pe ecran a unui sistem de axe 
D BASE: defineşte sau modifică punctul de referinţă al desenului 
curent pentru viitoarele inserări ale acestuia în alte desene 
S BLIPS: activează/dezactivează blips-urile (marcatorii) la selecţia 
punctuală, la introducerea coordonatelor unor puncte aflate în zona 
vizibilă 
B BLOCK: permite crearea (definirea) unor entităţi complexe de tip 
bloc-utilizator 
E BREAK: rupe o entitate în alte două entităţi 
E CHAMFER: realizează teşiri 
E CHANGE: modifică puncte de referinţă sau proprietăţi ale unui 
set de entităţi 
E CHPROP: permite modificarea proprietăţilor unui set de entităţi 
D CIRCLE: trasează cercuri în planul X- Y current 
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S COLOR: permite stabilirea culorii pentru entităţile ce urmează a fi 
create 
E COPY: crează noi entităţi prin copierea unora existente 
I DBLIST: listează toate entităţile din desen 
E: DDATTE: activează caseta de dialog pentru editarea atributelor 
S DDEMODES: activează caseta de dialog pentru entităţi 
S DDRMODES: activează caseta de dialog pentru ajutoare grafice 
# DDUCS: asemănătoare cu "UCS” dar deschide pe ecran o casetă 
de dialog 
DELAY: într-un fişier *.scr, crează o întârziere în execuţia comenzii 
următoare 
e DIM: permite înscrierea cotelor pe desen, comutând editorul de 
desenare din modul de lucru obişnuit, sub prompterul "Command”; 
în modul de lucru "Dim" 
e DIM: forma scurtă a comenzii de dimensionare, care permite 
înscrierea unei singure dimensiuni şi apoi comută automat 
prompterul de lucru în „Command" 
I DIST: determină distanţa dintre două puncte indicate, din spaţiul 
desenului  
E DIVIDE: plasează pe o entitate marcatorii necesari pentru 
divizarea acesteia într-un anumit număr de părţi egale 
D DONUT: crează entităţi plane de tip coroană circulară 
S DRAGMOD: permite activarea/dezactivarea "tragerii dinamice" 
D DTEXT: crează entităţi plane de tip text, permiţând scrierea mai 
multor rânduri 
A DVIEW: permite definirea unor imagini de perspectivă paralelă 
sau punctuală 
  DXBIN: permite încărcarea unui fişier în format binar în desenul 
curent 
  DXFIN: permite importul de informaţii în format DXF 
  DXFOUT: permite exportul de informaţii din desenul curent în 
format DXF 
3 EDGESURF: defineşte o suprafaţă bordată de 4 curbe ce se ating 
două câte două pe capete 
S ELEV: permite stabilirea elevaţiei şi a grosimii entităţilor ce 
urmează a fi create 
D ELLIPSE: crează entităţi plane de tip elipsă sau izocerc 
  END: permite închiderera desenului curent, cu salvarea sa 
E ERASE: şterge un set de entităţi din desen 
E EXPLODE: desface o entitate de tip "Block”, "Mesh”, "Polyline”, în 
entităţile componente 
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E EXTEND: extinde entităţi până la o entitate limită 
F FILE: oferă utilizatorului un meniu specific, din care poate selecta 
operaţia dorită: listarea tuturor fişierelor-desen dintr-un director; 
listarea fişierelor cu o anumită specificaţie, ştergerea, redenumirea, 
copierea unui fişier. Este identică cu opţiunea 6 din „Main Menu” 
doar ca lucrează sub editorul de desenare 
E FILLET: realizează racordări 
A GRAPHSCR: comută display-ul din mod text în mod graphic 
S GRID: permite activarea/dezactivarea grilei (reţelei de puncte de 
orientare în spaţiu/vizibil al desenului) si spaţierea convenabilă a 
acesteia 
S HANDLES: activează "numerotarea entităţilor" prin ataşarea unei 
etichete în format hexazecimal fiecarei entităţi create, etichetă care 
se salvează împreună cu desenul si ramâne în permanenţă ataşată 
obiectului respectiv 
D HATCH: hasurează suprafeţe plane închise 
I HELP(sau ?): afişează un text explicativ privitor la utilizarea 
comenzilor AutoCAD; introdusă transparent, lucrează în context, 
referindu-se la comanda de bază 
A HIDE: permite afişarea imaginii cu eliminarea muchiilor nevizibile 
I ID: afişează coordonatele unui punct indicat de utilizator, în UCS-
ul curent 
  IGESIN: permite importul desenelor descrise în format ASCII 
  IGESOUT: permite exportul desenului curent în format ASCII 
  INSERT: permite inserarea în desen a unor blocuri-utilizator 
definite deja sau a unor desene independente (fişiere *.dwg) 
S ISOPLANE: permite comutarea izoplanului curent de lucru 
S LIMITS: permite declararea şi activarea/dezactivarea limitelor 
desenului 
D LINE: crează entităţi de tip segmente de dreapta 2D sau 3D 
S LINETYPE: selectează tipul de linie cu care vor fi create 
următoarele entităţi 
I LIST: listează un set de entităţi selectate din desen 
T LOAD: permite încărcarea în desenul curent a unor fişiere de 
forme predesenate (".shx, cu excepţia fonturilor de text) 
S LTSCALE: setează valoarea factorului de scală pentru liniile 
discontinue 
E MEASURE: măsoară o entitate cu o anumită unitate de lungime, 
prin plasarea unor marcatori pe ea 
  .MENU: permite schimbarea meniului current 
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B MINSERT: similară cu "INSERT” afişează un nou bloc sub forma 
unei reţele rectangulare de apariţii ale blocului inserat 
E: MIRROR: crează noi entităţi, prin oglindirea fata de o axa a unui 
set existent de entităţi  
E MOVE: mută un set de entităţi în desen 
  MSLIDE: crează ''poze'' (slide-uri) ale imaginii curente de pe 
display, sub forma unor fişiere *.sld 
  .MULTIPLE: este o formă specială de comandă, care determină 
editorul de desenare să repete următoarea comandă plină la 
introducerea unui "Cancel" 
E OFFSET: crează entităţi paralele cu altele existente deja 
E OOPS: restaurează în desen entităţile şterse cu ERASE sau 
incluse în blocuri prin BLOCK, WBLOCK folosită însă imediat după 
comenzile menţionate 
S ORTHO: activează/dezactivează modul de lucru "Ortho"  
S OSNAP: permite declararea unor moduri Osnap în permanenţă 
valabilă în desen, astfel încât, la punctarea pe o entitate, AutoCAD 
să poziţioneze punctul curent de lucru direct pe punctul ce 
corespunde modului Osnap declarat, fără că utilizatorul să mai 
menţioneze de fiecare dată despre ce tip de interceptare geometrică 
este vorba 
A PAN: permite "deplasarea" desenului sub rama de afişare, pentru 
a aduce în zona vizibilă diferite porţiuni ale acestuia; nu modifică 
amplificarea imaginii 
E PEDIT: modifică o polilinie 
A PLAN: afişează desenul privit perpendicular pe un anumit plan X- 
Y 
D PLINE: crează o linie complexă (polilinia), ce poate conţine a 
succesiune de arce de cerc si de segmente de dreaptă, în orice 
număr si în orice ordine, având lăţime 0, chiar variabilă. 
T PLOT: permite obţinerea unor copii hard la plotter 
D POINT: crează entităţi de tip punct 
D POLYGON: crează contururi poligonale regulate cu 3-1014 laturi 
T PRPLOT: permite obţinerea unor copii hard la imprimantă 
  PURGE: ca primă comandă sub editorul de desenare, elimină din 
desen blocurile, stilurile, formele, tipurile de linii, straturile definite 
si nefolosite 
S QTEXT: activează/dezactivează dreptunghiurile înlocuitoare de 
text, care măresc viteza de regenerare a desenului  
  QUIT: permite închiderea desenului curent, fără salvarea sa 
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 REDEFINE: redefineşte o comandă AutoCAD, dacă definiţia ei a 
fost anulată cu comanda "UNDEFINE:" 
E REDO: reface în desen operaţiile anulate cu ultima comandă 
"UNDO:" ("U:”) 
A REDRAW: determină redesenarea ecranului în fereastra curentă 
de lucru, eliminând "resturile” (marcatorii) si refăcând vizibilitatea 
unor entităţi în aparenţă deteriorate datorită unor editări anterioare 
A REDRAWALL: similară cu "REDRAW:'; dar acţionează în toate 
ferestrele-ecran  
A REGEN: determină programul să reconsidere desenul, 
actualizându-l în conformitate cu valorile actuale ale variabilelor de 
sistem  
A REGENALL: similară cu "REGEN” cu efecte în toata ferestrele –
ecran 
A REGENAUTO: afişează/dezactivează regenerarea automată a 
desenului, atunci când anumite modificări impun o regenerare 
 RENAME: permite redenumirea unor blocuri, stiluri de text, 
straturi, vederi, sisteme de coordonate UCS, configuraţii de 
viewporturi salvate 
3 REVSURF: defineşte o suprafaţă de revoluţie 
E: ROTATE: roteşte un set de entităţi în planul curent de lucru 
  RSCRIPT: permite repetarea unui fişier de comenzi de tip *.scr 
încărcat în desenul curent 
3 RULSURF: defineşte o suprafaţă obţinută prin rularea unui 
segment generator pe două curbe directoare 
E SCALE: scalează un set de entităţi faţă de un punct cu un factor  
  SCRIPT: apelează un fişier de comenzi de dip*.scr spre a fi 
executat în desenul curent 
E SELECT: selectează un set de entităţi în vederea unei operaţii de 
editare 
S SETVAR: permite setarea de către utilizator a valorii acelor 
variabile de sistem AutoCAD care pot fi modificate opţional 
  SH: forma scurtă a comenzii "SHELL:" 
D SHAPE: crează entitaţi de tip "Shape" (forma), pe baza unor 
modele existente 
 SHELL: permite accesul la prompterul sistemului de operare 
D SKETCH: permite schiţarea "cu mâna liberă" a unor linii 
S SNAP: permite setarea pasului de snap si activarea/dezactivarea 
acestuia precum si selecţia stilului "Standard" sau "Isometric" 
D SOLID: crează entităţi plane de lip "Solid” poligoane definite ca 
suprafeţe  
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I STATUS: afişează informaţii generale privind desenul 
E STRETCH: „întinde" sau "comprimă" un set de entităţi cuprinse 
într-o fereastră 
S STYLE: crează si modifică stilurile de scrierea textului 
S TABLET: activează/dezactivează tableta grafică 
3 TABSURF: descrie o suprafaţă tabulată; definită prin deplasarea 
unui vector generator de-a lungul unei curbe directoare 
D TEXT: crează entităţi plane de tip text 
A TEXTSCR: comută display-ul din mod grafic în mod text 
I TIME: oferă informaţii de natură temporală asociate desenului 
D TRACE: crează entităţi plane de tip “Trace" (urme), linii 2D de 
lăţime constantă 
E TRIME: „tunde" entitaţi până la o "graniţă de tundere" 
E U: similar cu „UNDO” dar anulează numai ultima comandă 
# UCS: este comanda de bază care defineşte, salvează, restaurează, 
anulează sisteme de coordonate proprii utilizatorului 
# UCSlCON: permite afişare/dezactivarea simbolului pentru 
sistemul de coordonate prezent de obicei în colţul din stânga-jos al 
ecranului 
  UNDEFINE: anulează definiţia unei comenzi AutoCAD; aceasta 
poate fi totuşi executată, dacă este introdusă pe prompterul de 
comandă precedată de caracterul „.”(punct) 
E UNDO: anulează comenzi anterioare 
S UNITS: modifică sistemul de unităţi de măsură, sensul de 
măsurare şi originea pentru unghiuri, numărul de zecimale cu care 
sunt afişate coordonatele pe linia de star, sistemul de multipli şi de 
submultipli utilizat pentru ele 
A VIEW: defineşte şi manipulează "vederi" ale desenului, imagini 
importante, de care utilizatorul are nevoie în mod repetat 
A VIEWRES: stabileşte condiţii privind afişarea contururilor 
circulare şi comportarea AutoCAD-ului la comanda „ZOOM:" 
A VPOINT: stabileşte punctul din spaţiu din care este privit desenul 
în perspectiva paralelă  
S VPORTS: configurează ecranul în ferestre-ecran  
  VSLIDE: permite afişarea pe ecran, peste desenul curent a unei 
„poze" (slide) 
B WBLOCK: permite salvarea unor părţi din desen ca desene 
independente (*.dwg)  
A ZOOM: permite afişarea întregului desen sau a unui detaliu din 
acesta, modificând amplificarea cu care se realizează afişarea (NU 
dimensiunile desenului) 



Breviar de comenzi. Funcţii pe taste 

 257

 
COMENZI DE INTERFAŢĂ CU AUXILIARUL "ASHADE" 
Comenzile de acest tip pregătesc imagini utilizabile în aplicaţia 
(externă pentru v.10) „ASHADE" 
 
numai în AutoCAD 11 si 12 
comenzi "AME": care permit lucrul cu entităţi de tip "corp solid"  

- comenzi de definire a ferestrelor-ecran din spaţiul hârtie; 
- comenzi de apelare a utilitarelor în AutoLISP 
- comenzi de randara 

numai în AutoCAD 12 
- comenzi de interfaţă, cu baze de date (ASE) 

 
Funcţii pe taste 

- <FI> FLIP SCREEN, comută alternativ din mod de lucru 
grafic în mod text şi invers  

- <F6> = <^D> COORDS ON/OFF permite 
activarea/dezactivarea afişării dinamice a coordonatelor; fie 
în format polar, fie rectangular 

- <F7> = <^G> GRID ON/OFF activează/dezactivează afişarea 
grilei pe ecran 

- <F8> = <^O> ORTHO ON/OFF activează/dezactivează modul 
de lucru ORTHO 

- <F9> = <^B> SNAP ON/OFF activează/dezactivează pasul de 
snap 

- <F10>= <^T> TABLET ON/OFF activează/dezactivează 
tableta grafică 

- <Insert> trece cursorul-ecran în zona de meniu-ecran 
- <Home> activează manipularea cursorului-ecran cu săgeţile 
- <End> activează manipularea cursorului-ecran cu mouse-ul 
- <Page Up> măreşte de 10 ori (1 tastare) sau de 100 de ori (2 

tastări) viteza cursorului-ecran în zona grafică 
- <Page Down> anulează efectul tastei <Page Up> 
- <Ctrl Q> activează/dezactivează ecoul la imprimantă 
- <Ctrl E> comută circular izoplanul curent (Left, Top, Right) 
- <Ctrl X> şterge conţinutul liniei de comandă 
- <Ctrl H> Backspace şterge ultimul character 
- <Ctrl C> Cancel forţează întreruperea comenzii curente 
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3. Comenzile AutoCAD şi sintaxa acestora 
 

1. Introducerea comenzilor se face la apariţia prompterului 
"Command:"-în bara de jos. Pentru repetarea ultimei comenzi, se va 
apasa Enter.  
 
2. Introducerea punctelor sau coordonatelor  
 

Se poate face în oricare din modurile:  
Absolut:  x,y  
Relativ:  @deltax,deltay  
Polar:     @dist<unghi  
Pentru comenzile care accepta puncte 3D, se pot include 

coordonate în format absolut sau  
relativ:  

Absolut:  x,y,z  
Relativ:  @deltax,deltay,deltaz  

Daca omiteti coordonata Z, se utilizeaza elevatia curenta.  
 
2. Filtre coordonate: 
 

.X,.Y,.Z,.XY,.YZ,.X -  cand la o cerere de coordonate se dă o 
astfel de combinaţie, apare prompterul "of". Prin acesta ni se solicita 
introducerea unui element geometric de tip punct, de la care 
AutoCAD sa-si ia coordonatele ce urmeaza dupa punct (de ex. la .XZ  
va prelua coordonatele X si Z ale punctului selectat). Odata furnizat 
punctul care oferă aceste informatii, ni se va prezenta cererea "need 
a" sau "need ab", unde a si b sunt una dintre literele x,y sau z, mai 
exact acele litere care au lipsit din indicarea filtrului.  

3.Selectarea obiectelor:  ("Select objects:")  
   (punct)  =  Un obiect  
   M =  Mai multe obiecte  
   L =  Ultimul obiect  
   W =  Obiectele continute in intregime in fereastra specificata  
   C =  Obiectele care trec prin fereastra  
   A =  Adauga obiectele urmatoare  
   R =  Elimina (din multimea de selectie) obiectele urmatoare  
   U =  Elimina ultimul obiect  
(începând cu Release 11 au fost introduse si alte optiuni).  
Daca multimea selectata va satisface, apasati Enter.  
 APERTURE  
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"APERTURE" inseamna "deschidere". Se asteapta introducerea 
marimii patratelului selector in modul OSNAP, in pixeli. Sintaxa:   
APERTURE  
Object snap target height (1-50 pixels) <default>: (numar) Puteti 
opta intre a introduce o valoare (cuprinsa intre 1 si 50 pixeli) si a 
apasa pur si simplu Enter, in cazul in care ati vrut doar sa vedeti 
care este setarea "aperture" curenta, fara a o modifica. Cu cat latura 
patratelului este mai mica, punctul este localizat mai repede (mai 
usor pentru calculator, mai greu pentru operator). Valoarea este 
pastrata in variabila de sistem "APERTURE".  
 
4.ARC  

 
Comanda ARC serveste la trasarea arcelor de cerc. Iata 

variantele de introducere a  
arcului:  

-trei puncte de pe arc  
-punctul de inceput, centrul, punctul final  
-punctul de inceput, centrul, marimea arcului in grade  
-punctul de inceput, centrul, lungimea coardei  
-punctul de inceput, punctul final, raza  
-punctul de inceput, punctul final, marimea arcului in grade  
-punctul de inceput, punctul final, directia de trasare  
-continuarea liniei sau arcului precedent  

Format 3 puncte: ARC  Center/<Start point>:  (punct)  
   Center/End/<Second point>:  (punct)  
   End point:  (punct)  
Optiuni:  A = unghiul inclus intre laturile (radiale) care marginesc 
arcul  
  D = directia unghiulara masurata in sens trigonometric de la 
punctul de start  
  L = lungimea coardei  
  C = punctul din centrul arcului  
  E = punctul de sfarsit al arcului  
  R = raza  
  Pentru a continua linia sau arcul precedent, raspundeti la primul 
prompter cu Enter (vezi  
variabila LASTANGLE).  
 O dreapta nu este recunoscuta ca un arc cu raza infinita, deci trei 
puncte coliniare nu vor  
fi acceptate pentru definirea arcului.  
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5.AREA  

 
Cu comanda AREA se pot calcula ariile si perimetrele unor 

spatii inchise.  
Sintaxa:     AREA  <First point>/Entity/ Add/ Subtract:  (primul 
punct)  
     (ADD mode) Next point:  (urmatorul punct)  
     (ADD mode) Next point:  (urmatorul punct)  
     (ADD mode) Next point:  ...Enter pt. a incheia introducerea pct.  
     Area = nnnn  Perimeter = nnnn  
     Total area = nnnn  
     <First point>/Entity/Subtract:  ...Enter pt. abandonarea 
comenzii. Comanda incepe in modul "add".  Optiunile sunt:  
    Add         - Trece in modul "add" (adaugare).  
    Subtract  - Trece in modul "subtract" (extragere).  
    Entity      - Compune aria din cercurile sau poliliniile selectate.  
    Enter       - Paraseste comanda.  
 Valoarea ariei este pastrata in variabila de sistem AREA, iar 
perimetrul in variabila  

 
6. PERIMETER. 

 
 Conturul este inchis automat - nu trebuie introdus primul 

punct si la sfarsit.  
 

7. ARRAY  
 

Comanda ARRAY permite multiplicarea unor entitati selectate , 
dupa un "tablou" dreptunghiular sau circular (polar).  
Sintaxa:    ARRAY  Select objects: (Selectati entitatile de multiplicat)  
     Rectangular/Polar array (R/P):  
 Pentru tablou rectangular introduceti numarul de randuri, 
numarul de coloane, distanta dintre randuri si distanta dintre 
coloane. Distantele intre randuri/coloane pot fi introduse cu semn. 
Daca semnul e pozitiv, atunci dezvoltarea se face in sensul axelor, 
iar daca e negativ, in sens invers.  
 Pentru un ARRAY polar (circular), trebuie sa indicati centrul 
tabloului circular, apoi numarul de articole, apoi unghiul de 
acoperit si in final optati pentru rotirea obiectelor.  
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8. ATTDEF  
 
Folosind comanda ATTDEF (ATTribute DEFine) puteti crea 

atribute. Ele trebuie sa primeasca un nume ("tag") si contin una sau 
mai multe particularitati, exprimate textual sau numeric, ce 
insotesc (eventual) un bloc. Ele pot fi utilizate si independent, in 
afara conceptului de bloc (sunt entitati de sine statatoare).  
 Atributele pot avea una sau mai multe dintre caracteristicile 
(modurile) bivalente (exprimate prin "Y"=DA si "N"=NU): Invisible, 
Constant, Verify si Preset, unde:  
   Invisible   - exista, dar nu e afisat.  
   Constant    - toate aparitiile atributului au aceeasi valoare.  
   Verify      - emite un prompter suplimentar pt. confirmarea valorii 
date.  
   Preset      - nu cere valoare la inserarea blocului.  
Sintaxa:    ATTDEF  Attribute modes  --  Invisible:N  Constant:N  
Verify:N  Preset:N  
     Enter (ICVP) to change, RETURN when done:  
     Attribute tag: (up to 31 chars; letters, digits, $, -, _)  
     Attribute prompt:  
     Default attribute value:  
     Start point or Align/Center/Fit/Middle/Right/Style:      Height 
<implicit>:  
     Rotation angle <implicit>:  
Putem crea pe ecran un "tag" (un text) asociat atributului ce se 
defineste (ca o eticheta), care sa poata fi selectat apoi ca facand 
parte dintre entitatile unui bloc, impreuna cu entitatile geometrice 
care-l vor constitui.  
 
 9. ATTDISP  

 
Comanda ATTDISP (ATTribute DISPlay) controleaza 

vizibilitatea atributelor. Le facem  
vizibile atunci cand dorim ca valoarea lor curenta sa apara in desen.  
Sintaxa:     ATTDISP  Normal/ON/OFF <val. curenta>:  
   Normal  - atributele vizibile se vad, cele invizibile nu  
   On      - toate atributele se vad  
   Off     - Nu se vede nici un atribut  
 
 10. ATTEDIT  
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Comanda ATTEDIT (ATTribute EDIT) permite editarea 
atributelor, adica modificarea lor.  
Atat individual, cat si global, pot fi alese selectiv atributele de editat, 
selectia facandu-se  
dupa tag-uri, nume de bloc sau vizibilitate.  
Sintaxa:     ATTEDIT  Edit Attributes one by one? <Y>  (N = global)  
    Block name specification <*>:  
    Attribute tag specification <*>:  
    Attribute value specification <*>:  
 Ultimul atribut selectat este primul editat (atributul editat este 
marcat cu X).  
 Apare prompterul:  
 Value/ Position/ Height/ Angle/ Style/ Layer/ Color/ Next 
<implicit>:  
 
11. ATTEXT  

 
Pentru a extrage atributele blocurilor care se afla la un 

moment dat intr-un desen se  
foloseste comanda ATTEXT (de la "ATTribute EXTraction").  
Sintaxa:   ATTEXT  CDF, SDF, or DXF attribute extract (or 
Entities)? <C>:  
Daca raspundeti cu "CDF", "SDF", "DXF", se extrag inregistrari 
pentru toate blocurile  
din desen. Optiunea "E" va cere (cu "Select objects") indicarea 
entitatilor pentru care sa  
fie scoase informatiile din baza de date, dupa care va afisa linia:  
   CDF, SDF or DXF Attribute extract? <C>: Formatele de extractie 
sunt:  
   CDF - Comma Delimited Format       - delimitarea campurilor prin 
virgule  
   SDF - Fixed-field format                     - delimitarea prin spatii  
   DXF - Drawing interchange format  - format DXF  
 
 12. AUDIT  

 
Comanda AUDIT determina validitatea fisierului ".DWG".  

Sintaxa:  AUDIT  
 Fix any errors detected? <implicit>:  
 0 Blocks audited  
 Pass 1    0 entities audited  
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 Pass 2 0 entities audited  
 Total errors found 0 fixed 0  
 Aceasta comanda este disponibila numai incepand cu AutoCAD 
Release 11. Incepand cu  
aceasta versiune, fisierele "DWG" contin informatii redundante, 
folosite de comanda  
AUDIT pentru repararea fisierelor defecte. Raspunsul "Y" determina 
corectarea erorilor  
gasite; "N" determina afisarea erorilor, fara corectare. Raspunsul 
comenzii (raportul) este  
salvat pe disc intr-un fisier cu numele desenului si extensia ".ADT".  
 
13. AXIS  
 

Comanda AXIS serveste la trasarea unor axe gradate care 
ajuta la identificarea de pozitiei pe ecran.  
Sintaxa:     AXIS  Tick spacing(X) or ON/OFF/Snap/Aspect 
<implicit>:  
   Optiuni:  
 - o valoare numerica = spatiul dintre marcaje; daca se adauga un 
"X", atunci valoarea  
reprezinta factorul cu care se inmulteste distanta Snap.  
 - ON = activarea axelor  
 - OFF = dezactivarea axelor  
 - S = preluarea spatiului intre marcaje de la Snap  
 - A = posibilitatea alegerii de spatii diferite pe orizontala fata de 
verticala (Aspect).  
 
14. BASE  
 

Comanda BASE defineste punctul de referinta pentru 
inserarea si rotirea unui desen.  
Sintaxa:     BASE  Base point <implicit>:  (introduceti un punct)  

 
15. BLIPMODE 

 
Pune markerul in modul blip (palpaie) sau il scoate de acolo.  

Sintaxa:     BLIPMODE  ON/OFF <implicit>:  
 Nu sunt afectate desenele (baza de date).  
 
16. BLOCK  
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Orice ansamblu de entitati poate fi constituit intr-un bloc... 

Pentru a vedea direct cum se comporta, creati cateva entitati (linii, 
arce, etc.) si dati comanda BLOCK, urmand traseul:  
     BLOCK  Block name (or ?):  (numele blocului)  
     Insertion base point:   (indicati un punct)  
     Select objects:  (selectati entitatile create)  
Punctul indicat se va asocia obiectului, servind ca punct de inserare 
al blocului la viitoarele sale inserari. Dupa ce ati terminat de 
selectat entitatile, apasati Enter. Entitatile selectate dispar de pe 
ecran! Ele formeaza "blocul". Pentru a le restaura, folositi comanda  
OOPS. Daca la comanda BLOCK raspundeti cu "?" (la prima 
intrebare), ecranul trece in mod text si se listeaza toate blocurile 
deja definite.  
 
 17. BREAK  

 
Comanda BREAK permite sectionarea unei entitati in alte 

doua entitati de acelasi tip.  
Sintaxa:    BREAK  Select object: (selectati un obiect)  
     Enter first point: (punct)  
     Enter second point: (punct)  
Dupa selectarea unei linii (continue), prin indicarea unui al doilea 
punct segmentul dintre  
ele dispare. Precizia indicarii este destul de redusa. Daca doriti sa 
sectionati entitatea  
incepand dintr-un punct exact (de exemplu intersectia cu alta 
entitate), selectati-o unde va  
vine mai bine, dupa care continuati astfel:  
     Enter second point (or F for first point): F  
     Enter first point: (indicaţi punctul exact)  
     Enter second point: (al doilea punct).  
   
18. CHAMFER  
 

Comanda CHAMFER permite realizarea de tesituri, trasand o 
linie care reteaza coltul format de doua entitati la distante 
prestabilite.  
Sintaxa:    CHAMFER  Polyline/Distances/<select first line>:  
   D - Introduceti, pe rand, distantele la care sa se faca tesirea  
   P - Teseste intreaga polilinie  
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Daca raspundeti cu D, apare dialogul:  
   Enter first chamfer distance <0.0000>: (prima dist. de tesire)  
   Enter second chamfer distance <prima>: (a doua dist. de tesire)  
 Acum reluati comanda CHAMFER.  
19.CHANGE  
 

Comanda CHANGE serveste la modificarea caracteristicilor 
unei (unor) entitati deja existente in desen.  
Sintaxa:     CHANGE   Select objects:  (select)  
      Properties/<Change point>:  
In continuare, Change Point se noteaza CP.  
   Line   - Capatul liniei este mutat prin CP in punctul indicat.     
(Atentie la ORTHO !)  
   Circle - Raza se schimba astfel incat punctul indicat sa fie pe 
circumferinta.  
   Block  - Se schimba punctul de insertie. Trebuie specificat noul 
unghi.  
   Text   - Se schimba punctul de start, stilul, inaltimea, unghiul, si 
textul.  
   Attribute Definition - Ca la text, in plus se schimba definitia 
atributului.  
Optiunea "Properties" a comenzii CHANGE permite schimbarea 
uneia sau mai multor proprietati ale entitatilor selectate. Aceste 
proprietati pot fi:  
   -  layer (strat)  
   -  color (culoare)  
   -  linetype (tipul liniei)  
   -  elevation (ADE-3) (elevatie = coordonata Z)  
   -  thickness (ADE-3) (grosime)  
Sintaxa:     CHANGE  Selects objects:  (select)  
      Properties/<Change point>:  P  
      Change what property (Color/Elev/LAyer/LType/Thickness)?  
Se introduce litera mare (sau literele mari) din numele proprietatii 
ce trebuie schimbata.   
 
20. CHPROP  

 
Ca si comanda CHANGE fara optiunea Change Point. 

Schimba proprietatile unei entitati.  
 

21.CIRCLE  
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Comanda CIRCLE este folosita pentru trasarea de cercuri.  

Sintaxa:     CIRCLE  3P/2P/TTR/<Center point>:  (punctul de 
centru)  
      Diameter/<Radius>:  (valoarea razei)  

Daca se incepe prin introducerea unui punct, acesta este 
considerat centru si apare cererea  "Diameter/<Radius>:"  
Se poate raspunde cu un numar (considerat raza) sau cu litera D, 
care va produce textul "Diameter:" asteptandu-se un numar 
(considerat diametru). In ambele cazuri raspunsul numeric duce la 
trasarea cercului precizat.  

Daca la primele optiuni nu se da un punct, ci se alege 
optiunea 3P, atunci apare "First point:" si se asteapta un prim 
punct de pe circumferinta viitorului cerc. Odata introdus, se cer al 
doilea si al treilea punct care vor defini cercul.Daca se alege 
optiunea 2P, sunt  
cerute doua puncte diametral opuse care vor defini cercul dorit.  

Daca, in sfarsit, se alege TTR, atunci in zona de dialog apare: 
"Enter Tangent spec:", iar pe ecran va apare colimatorul pe care este 
centrat un patratel "selector". Este ceruta astfel selectarea unui  
obiect la care sa fie dus tangent cercul. Cand am cuprins in 
interiorul patratelului macar un singur pixel al obiectului tangent 
apasam Enter. Va apare "Enter second Tangent spec:", fiind 
asteptat al doilea obiect de tangenta. Dupa selectarea acestuia, 
apare textul "Radius:", asteptandu-se raza cercului, dupa care 
acesta este trasat efectiv.  
 
22. COLOR  
 

Paleta disponibila este:  
 1 - Red (rosu), 2 - Yellow (galben), 3 - Green (verde), 4 - Cyan (bleu),  
 5 - Blue (albastru), 6 - Magenta (violet), 7 - White (alb)  
Daca doriti sa schimbati culoarea (cea implicita este afisata intre 
paranteze), introduceti numele (in engleza) sau numarul din lista de 
mai sus.  
Sintaxa:    COLOR  New entity color <implicit>:  
 
23. COORDINATES  
 

In linia de sus a ecranului sunt afisate coordonatele curente 
ale cursorului. Apasand tasta F6 sau combinatia Ctrl-D, vor 
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ramane afisate ultimele valori (din momentul apasarii tastei), fara 
sa mai fie actualizate la deplasarea cursorului. Apasand din nou F6, 
se revine la afisarea dinamica a coordonatelor. Sintaxa: Ctrl-D (sau 
F6)  
 <Coords On> (sau <Coords Off>)  
24. COPY  
 

Aceasta comanda serveste la multiplicarea unei portiuni din 
desen, prin copierea ei succesiva in alte zone ale desenului.  
Sintaxa:     COPY  Select objects:  (select)  
      <Base point or displacement>/Multiple:  
      Second point of displacement:  

Daca facem o singura copie, raspundem simplu, indicand un 
punct. Acesta va fi asociat din punct de vedere pozitional entitatilor 
selectate, in vederea precizarii locului unde se va face copierea.  

Daca dorim sa facem mai multe copii, raspundem prin "M". 
In cazul copierii simple urmeaza sa introducem punctul care va 
corespunde in copie punctului precizat anterior. In cazul copierii 
multiple, abia acum se va cere punctul de baza al deplasarii, urmat 
de cel de-al doilea punct. Cererea celui de-al doilea punct se repeta 
pana la apasarea lui Enter, adaugandu-se cate o copie in fiecare 
punct precizat.  

 
25. DBLIST  
 

Dati aceasta comanda (DBLIST) daca doriti sa vedeti formele 
canonice ale tuturor  
entitatilor aflate curent in baza de date a AutoCAD-ului.  
Sintaxa:     DBLIST  
Daca lista este lunga, puteti intrerupe afisarea ei cu CTRL-S. Cu 
CTRL-C se abandoneaza afisarea. Cu CTRL-P, se tipareste lista.  
 
26. DDATTE  
 

Aceasta comanda a fost introdusa (ca toate comenzile care au 
prefixul "DD") incepand cu  
Release 11. DDATTE este prescurtarea de la Dynamic Dialog 
ATTribute Editor, deci comanda DDATTE permite editarea 
atributelor folosind ferestre de dialog. Sintaxa: DDATTE  
 Select block:  
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27. DDEDIT  
 

DDEDIT inseamna Dynamic Dialog EDITor, deci foloseste tot 
ferestrele de dialog (ca DDATTE). DDEDIT permite editarea unei linii 
de text. Astfel se pot modifica texte  
(entitati de tip "TEXT" sau "ATTDEF"), fara a mai fi nevoie sa le 
rescriem in intregime. Sintaxa: DDEDIT  <Select a TEXT or ATTDEF 
object>/ Undo:  
 
28. DDEMODES  
 

Comanda DDEMODES (Dynamic Dialog Entity creation 
MODES) permite schimbarea proprietatilor entitatilor prin ferestre 
de dialog. Sunt modificate variabilele de sistem care controleaza 
proprietatile entitatilor ce vor fi create ulterior (culoarea, tipul de 
linie, layerul, elevatia, grosimea). Sintaxa: DDEMODES    
Poate fi folosita ca si comanda transparenta ('Ddemodes).  
 
29. DDLMODES  
 
DDLMODES permite modificarea proprietatilor straturilor prin 
ferestre de dialog  
(Dynamic Dialog Layer MODES).  
Sintaxa:  DDLMODES  
Ca si DDEMODES, poate fi folosita ca comanda transparenta 
('Ddlmodes).  
 
30.DDRMODES  
 
Comanda DDRMODES (Dynamic Dialog dRawing MODES) permite 
setarea unor variabile care controleaza modul de lucru, similar 
comenzilor SNAP, GRID, AXIS, ORTHO, BLIPMODE, ISOPLANE.  
Sintaxa: DDRMODES  
Poate fi folosita ca comanda transparenta ('Ddrmodes). Variabilele 
de sistem afectate: AXISMODE, AXISUNIT, BLIPMODE, COORDS, 
GRIDMODE, GRIDUNIT, ORTHOMODE, SNAPANG, SNAPBASE, 
SNAPMODE, SNAPUNIT.  
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31. DDUCS 
  

Comanda DDUCS (Dynamic Dialog User Coordinate System) 
controleaza sistemul de coordonate folosit (ca si comanda UCS) prin 
ferestre de dialog.  
Sintaxa: DDUCS  
 
32. DELAY  
 

DELAY inseamna intarziere. Comanda DELAY se utilizeaza in 
special in fisierele Script, pentru a mentine afisarea unei imagini pe 
ecran un timp dat. Sintaxa: DELAY  Delay time in milliseconds:  
(numar) Numarul introdus reprezinta timpul de intarziere, in 
milisecunde.  

 
33. DIM  
 

Comanda DIM ne introduce in modul de lucru "Dimmension:"  
Aceasta inseamna ca de acum putem desena cote, folosind 
urmatoarele comenzi de cotare:  
   ALIgned - Cotare liniara, aliniata cu originile liniilor de extensie  
   ANGular - Cotarea unghiurilor  
   BASeline - Continua cotarea liniara de la prima linie de extensie 
a cotei precedente  
   CENter  - Marcheaza centrul unui arc sau cerc  
   CONtinue - Continua o cotare liniara de la a doua linie de 
extensie a cotei precedente  
   DIAmeter - Cotarea diametrelor  
   EXIt  - Revine in modul de lucru normal ("Command:")  
   HORizontal- Cotare liniara, cu linia de cota orizontala  
   LEAder - Deseneaza o sageata insotita de linii de control spre 
textul cotei  
   RADius - Cotarea razelor  
   REDraw - Redeseneaza ecranul  
   ROTated - Cotare liniara inclinata cu unghiul specificat  
   STAtus - Listeaza starea variabilelor de cotare  
   STYle - Comuta pe un alt stil de text  
   UNDo - Anuleaza ultima operatie de cotare  
   VERtical - Cotare liniara, cu linia de cota verticala  
In Release 11 au fost adaugate si comenzile de cotare:  
   OBLique - inclina liniile de extensie ale cotei selectate  
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   ORDinate - inscrie pe desen coordonatele punctului selectat  
   OVErride  - modifica setarea veriabilelor de cotare pentru cotele 
selectate  
   REStore - seteaza stilul de cotare  
   SAVe - salveaza starea variabilelor => un nou stil de cotare  
   TEDit - editarea textului cotei  
   TROtate - roteste textul cotei  
Daca variabila DIMASO este ON, se lucreaza in modul de cotare 
"asociativa"; aceasta inseamna ca vom avea cate o singura entitate 
pentru fiecare cota (un bloc de tip "DIMENSION"). Urmatoarele 
operatii se pot efectua asupra entitatilor obtinute astfel.  
   UPDate       - Redeseneaza cotele selectate, respectand noile valori 
ale variabilelor de cotare.  
   HOMetext  - Muta textul unei cote selectate inapoi in pozitia sa 
implicita.  
   NEWtext    - Modifica textul cotelor selectate.  DIM1  
Comanda DIM1 permite trasarea unei singure cote, dupa care 
revine in modul de lucru "Command:".  
Sintaxa:     DIM1  Dim:   (introduceti o comanda de cotare)  
 
34. DIST  
 

Comanda DIST afiseaza distanta dintre doua puncte 
selectate, unghiul de inclinare al  
dreptei care trece prin aceste puncte, si variatia coordonatelor X si 
Y.  
Sintaxa:     DIST  First point:  (punct)  
      Second point:  (punct)  
Daca la cererea "First point:" raspundeti cu un numar, DIST 
afiseaza acest numar in unitatile curente (setate cu UNITS).  
 
35. DIVIDE  
 

Comanda DIVIDE permite marcarea unei entitati cu puncte 
sau blocuri, la distante egale.  
Sintaxa :    DIVIDE  Select object to divide:  (punct)  

<Number of segments>/Block:  
Puteti selecta o singura entitate de tip linie, arc, cerc sau polilinie. 
Pe entitatea selectata  
vor apare unul sau mai multe puncte situate la distante egale, cu 
unul mai putin decat  
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numarul de segmente in care va fi impartita entitatea. Numarul de 
segmente trebuie sa fie cuprins intre 2 si 32767. Daca ati selectat 
marcarea prin blocuri (optiunea "Block"), va urma dialogul:  

Block name to insert: (numele unui bloc anterior definit)  
Align block with object? <Y> (blocul tangent la obiect sau nu)  
Number of segments: (numarul de segmente)  
 

36. DOUGHNUT  
37 DONUT  
 

Comanda DONUT (sau DOUGHNUT) deseneaza o coroana 
circulara plina (daca este plina sau nu, se poate stabili prin 
comanda FILL).  

Sintaxa:     DOUGHNUT  Inside diameter <ultima val.>:  (val. 
sau 2 puncte)  

Outside diameter <ultima val.>:  (val. sau 2 puncte)  
Center of doughnut:  (punct) La "Inside diameter" se 

introduce diametrul interior al inelului, iar la "Outside diameter"  
diametrul exterior. Dupa ce se da diametrul exterior, inelul deja 
apare, centrat pe cursorul  
grafic. Acum poate fi plasat oriunde (prin precizarea centrului).  
 
38 DRAGMODE  
 

DRAGMODE este o comanda de setare, care permite crearea 
facilitatii de prezentare dinamica a obiectelor care vor fi mutate, 
rotite etc. De obicei aceasta facilitate este activata. Este necesar sa 
fie dezactivata doar daca se lucreaza pe un calculator foarte lent.  
Sintaxa:     DRAGMODE  ON/OFF/Auto <starea curenta>:  
 
39. DTEXT  
 
Vezi comanda TEXT. Diferentele constau in:  
   
 - pe ecran apare un dreptunghi de marime egala cu marimea 
curenta a caracterelor. Pe  
masura ce se scrie textul, acesta apare efectiv pe ecran.  
 - apasarea lui Enter face trecerea la linia urmatoare. Pentru a 
incheia comanda trebuie dat  
Enter pe prompterul "Text:".  
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 - optiunile Center, Middle, etc. sunt respectate abia la incheierea 
comenzii, cand textul  
este rescris pe ecran.  
 
40. DVIEW  
 

Se defineste, dinamic, o proiectie paralela sau perspectiva a 
unui desen 3D (Dynamic View).  
Sintaxa: DVIEW  
 Select objects:  
 CAmera/ TArget/ Distance/ POints/ PAn/ Zoom/ TWist/ CLip/ 
Hide/ Undo/ <eXit>:  
 La "Select objects:" se creeaza (prin comanda SELECT) un set de 
obiecte ce vor fi afisate dinamic pe durata executarii comenzii. Se 
alege un set de obiecte reprezentativ; daca alegem intregul desen, 
timpul de executie ar putea sa fie foarte mare.  
Optiuni:  
 - CA - alege unghiul camerei; camera se roteste in jurul obiectului 
vizualizat  
 - CL - stabileste planele inainte de care sau dupa care nu se mai 
vede nimic  
 - D - stabileste distanta dintre camera si tinta (obiectul privit); 
aceasta optiune determina  
trecerea la proiectia perspectiva  
 - H - sterge liniile invizibile (ascunse)  
 - OFF - trece la proiectia paralela (din perspectiva)  
 - PA - ca si PAN (PAN obisnuit nu poate fi folosit in DVIEW)  
 - PO - punctele in care se afla camera si tinta  - TA - tinta (obiectele 
privite)  
 - TW - roteste proiectia in jurul liniei de vedere (determinata de 
amplasarea camerei)  
 - U - anuleaza efectul optiunii anterioare  
 - X - paraseste comanda  
 - Z - Zoom pentru DVIEW  
 
41. DXBIN  
 

Comanda DXBIN foloseste la incarcarea fisierelor ".dxb" 
("drawing interchange binary")  
intr-un desen AutoCAD. Aceste fisiere au un format foarte compact, 
si sunt utilizate in unele subprograme interne.  
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Sintaxa:     DXBIN  DXB file:  (nume fisier)  
Extensia nu trebuie specificata, pentru ca este implicita.  
 
42. DXFIN  
 

Comanda DXFIN permite citirea unui "Drawing Interchange 
File" si crearea unui desen pe baza acestui fisier. Setarea AutoCAD-
ului (a variabilelor) nu se modifica decat daca lansam comanda 
DXFIN inaintea oricarei alte comenzi (intr-un desen nou).  
Sintaxa:     DXFIN  File name: (nume fisier)  
Daca desenul curent nu este gol, apare mesajul  

Not a new drawing -- only ENTITIES section will be input.  
si se ignora toate sectiunile din fisierul ".DXF" pana la sectiunea 
ENTITIES (care contine  
lista entitatilor ce vor fi desenate).  
 
43. DXFOUT  
 
Comanda DXFOUT creeaza un "Drawing Interchange File" (un fisier 
".DXF"), corespunzator desenului curent sau entitatilor selectate din 
acesta.  
Sintaxa:     DXFOUT  File name: (nume fisier DXF)  

Enter decimal places of accuracy (0 to 16) (or Entities) <6>:  
Daca raspundeti "E", apare prompterul "Select objects:", adica se 
trece prin comanda SELECT pentru a se crea o multime de selectie. 
Mai apare apoi:  

Enter decimal places of accuracy (0 to 16) <6>: (precizia 
numerelor reale)  

 
44. EDGESURF  
 

Folosind comanda EDGESURF se poate construi o suprafata, 
pornind de la patru linii (curbe) care o marginesc (EDGE - 
constrained SURFace).  
Sintaxa: EDGESURF  
 Select edge 1:  
 Select edge 2:  
 Select edge 3:  
 Select edge 4:  
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 Conturul determinat de cele patru curbe trebuie sa fie perfect 
inchis. Suprafata obtinuta este de tip "mesh"; rezolutia pe directiile 
M si N este data de valorile variabilelor  
SURFTAB1 si SURFTAB2.  
 
45. ELEV  
 

Comanda ELEV este o cale de a lucra in spatiu. ELEV vine de 
la elevation, adica altitudine. Initial, elevatia este 0. Se poate defini 
o noua elevatie, dupa care se va lucra normal (ca in 2D), fara a 
introduce coordonata Z, care va fi egala tot timpul cu elevatia 
curenta.  
Sintaxa:     ELEV  

New current elevation <val. curenta>:  (Enter sau numar)  
New current thickness <val. curenta>:  (Enter sau numar)  

"Thickness" este grosimea entitatii (pe directia Z).  
 
46. ELLIPSE  
 

Cu ELLIPSE se pot desena elipse. Acestea vor fi de fapt niste 
polilinii.  
Sintaxa:     ELLIPSE  <Axis endpoint 1>/Center:  (punct)  

Axis endpoint 2:  (punct)  
<Other axis distance>/Rotation:  

Primul raspuns marcheaza capatul primei axe a elipsei, iar al doilea 
celalalt capat al acesteia. Dupa acesta din urma, pe ecran apare o 
linie elastica ce incepe din centrul elipsei (adica mijlocul primei axe) 
si se termina la colimator. Deplasarea cursorului o lungeste sau o 
scurteaza, configurand si elipsa trasata dinamic. Indicarea unui 
punct fixeaza elipsa in forma curenta.  
Daca la ultima cerere raspundem cu "R", apare:  

Rotation around major axis:     - se cere unghiul de rotire in 
spatiu (in jurul primei axe) al cercului care are diametrul  
egal cu prima axa si se vede in plan ca elipsa.  
Daca la prima cerere se raspunde cu "C", atunci apare:  

Center of ellipse:  
- punctul dat aici este considerat centrul elipsei. In 

continuare se cer:    
Axis endpoint: (unul din capetele primei axe)  
<Other axis distance>/Rotation: (unul din capetele celeilalte 

axe)  
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47. END  
Comanda END salveaza desenul curent si paraseste editorul 

de desenare.  
Sintaxa:    END  
 
48. ERASE  

 
Comanda ERASE sterge obiectele selectate.  

Sintaxa:    ERASE  Select objects:  (selectati obiectele)  
Puteti sterge ultimul obiect folosind optiunea "L" (raspundeti "L" 
cand vi se cere sa selectati obiectele).  
 
49. EXPLODE  
 

EXPLODE permite "explodarea" unei entitati de tip Block, 
Polyline, Dimension, Hatch sau Mesh in subentitatile componente.  
Sintaxa:     EXPLODE  Select block reference, polyline, or 
dimension.  
Efectul vizibil este ca entitatea selectata se redeseneaza. De fapt, se 
redeseneaza subentitatile componente. Acestea vor putea fi de acum 
selectate separat.  
 
50. EXTEND  
 

Comanda EXTEND permite prelungirea unei entitati pana la 
intalnirea cu alta, data in prealabil ca margine (in engleza "edge").  
Sintaxa:     EXTEND  Select boundary edges(s)...  

Select objects:  
Acum puteti selecta marginile. Acestea pot fi linii, arce, cercuri sau 
polilinii. Urmeaza cererea: 

Select object to extend:  
Acum selectati entitatile ce trebuiesc prelungite.  
 
51. FILES  
 

Comanda FILES permite accesul la fisiere si directoare.  
Sintaxa:     FILES  
Se apeleaza meniul "File Utility", care consta intr-o lista de 
subprograme. Folosind acest meniu, se pot lista fisierele specificate 
din directorul specificat, se pot sterge, redenumi fisiere sau se pot 
copia intr-un alt director. Se pot folosi caracterele "*" sau "?" pentru  
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selectarea fisierelor.  
 
52. FILL  
 

FILL se foloseste pentru controlul umplerii obiectelor cu 
latime (solid, polilinie, trace, donut).  
Sintaxa:    FILL ON    - Solid, Trace, si Polyline umplute  
   FILL OFF   - Solid, Trace, si Polyline goale  
 
53. FILLET  
 

Comanda FILLET foloseste la racordarea a doua linii, arce 
sau cercuri printr-un arc de raza specificata. Lungimile entitatilor 
racordate se modifica in functie de valoarea razei  
de racordare.  
Sintaxa:     FILLET  Polyline/Radius/<select two objects>:  

P - Racordeaza o polilinie intreaga  
R - Alege raza de racordare  
 

54. FILMROLL  
 

Genereaza un fisier ".FLM" folosit de AutoShade.  
Sintaxa: FILMROLL  
 Enter filmroll file name <implicit>:  
 Creating the filmroll file  
 Processing face: xx  
 Filmroll file created  
 
55. GRAPHSCR  
 

 TEXTSCR Comenzile GRAPHSCR si TEXTSCR fac trecerea 
din ecranul text in cel grafic si invers.  
Sintaxa:     GRAPHSCR   sau   TEXTSCR  
 
56. GRID  
 

Comanda GRID controleaza dispunerea pe ecran a retelei de 
puncte care asista operatorul la plasarea obiectelor (entitatilor) in 
desen.  
Sintaxa:     GRID  Grid spacing(X) or ON/OFF/Snap/Aspect 
<current>:  
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Optiunile sunt urmatoarele:  
Spacing(X)  - Un numar simplu arata distanta dintre punctele 

retelei (in unitati de desenare - vezi UNITS). Un numar urmat de "X" 
(ex. "2X") seteaza distanta dintre puncte ca multiplu al pasului 
stabilit cu SNAP. Valoarea "0"  stabileste distanta la valoarea SNAP-
ului.  

ON - Vizualizeaza reteaua cu pasul stabilit anterior.  
OFF - Sterge reteaua de pe ecran.  
Snap - Stabileste distanta dintre puncte la pasul setat prin 

SNAP (ca si val. 0 de la Spacing).  
Aspect   - (ADE-2) Permite rezolutie diferita a retelei pe 

orizontala si verticala.  
 

57. HANDLES  
 

Comanda HANDLES permite controlul identificatorilor de 
entitati.  
Sintaxa: HANDLES  
 Handles are disabled.  
 ON/ DESTROY:  
 Handles are enabled. Next handle: 4A  
 AutoCAD foloseste un "handle" pentru a identifica fiecare entitate 
din desen. Starea implicita este ON. Optiunea DESTROY determina 
stergerea identificatorilor tuturor entitatilor; cand se alege 
DESTROY, apare un mesaj de avertisment. In baza de date, 
identificatorii apar, pentru fiecare entitate, in sublistele cu codul 5.  
 
58. HATCH  
 

HATCH permite acoperirea unei suprafete delimitate cu un 
model de hasurare ales.  
Sintaxa:     HATCH  Pattern (? or name/U,style) <model implicit>:  
Stiluri: N - Normal  

O - Outermost  
I - ignora conturul interior  
Modul normal hasureaza spatiul dintre doua contururi. Daca 

in interiorul conturului interior mai exista unul, se hasureaza si 
suprafata din interiorul acestuia. 

 Outermost hasureaza numai spatiul dintre primul si al 
doilea contur. Al treilea (daca exista) este ignorat.  

 Ignore nu tine seama decat de conturul exterior.  



Lucrarea 12 

 278

Angle for crosshatch lines <implicit>: (unghiul la care sunt 
inclinate liniile de hasura)  

Spacing between lines <implicit>: (spatiul dintre linii)  
Double hatch area (Y/N) <implicit>: (hasurare dubla)  
 

59. HELP  
60. ?  
 

Comanda HELP (sau "?") afiseaza informatii ajutatoare 
referitoare la comanda AutoCAD specificata. Sintaxa:    HELP (sau 
?)  

Command name (RETURN for list):  
Daca raspundeti cu un nume de comanda, vor fi afisate informatii 
despre aceasta  
comanda. Altfel, raspunsul consta intr-o lista ce cuprinde numele 
comenzilor cunoscute  
de AutoCAD si modul de specificare a punctelor.Daca informatiile 
nu incap pe un ecran,  
va apare mesajul:  

Press RETURN for further help.; adica trebuie sa apasati 
Enter pentru a trece la pagina urmatoare. Se poate abandona 
afisarea cu CTRL-C.  

 
61. HIDE  
 

Comanda HIDE se refera la desenele 3D. Cu ajutorul ei se pot 
elimina de pe ecran liniile invizibile. Daca desenul 3D este de tip 
"wire frame" (cadru de sarma), HIDE nu are efect. Liniile sunt 
invizibile daca desenul este alcatuit din fatete 3D (3DFACE). 
Executarea comenzii HIDE presupune regenerarea desenului, 
operatie care necesita f. mult timp.  
Sintaxa:     HIDE  
 
62 ID  

Comanda ID afiseaza coordonatele unui punct desemnat.  
Sintaxa:     ID  Point:  (punctul)  
 
63 IGESIN 

 
Comanda IGESIN (IGES INput) citeste fisiere in format IGES 

ASCII (Initial Graphics Exchange Standard) si creeaza un desen 
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plecand de la acestea. Se foloseste optiunea 1 din meniul principal 
(creeaza un desen nou) si se da comanda IGESIN inaintea oricarei 
alte comenzi.  
Sintaxa:     IGESIN  File name: (nume fisier)  
 
64. IGESOUT  
 

Comanda IGESOUT creeaza un fisier in format IGES ASCII 
plecand de la desenul curent.  
Sintaxa:     IGESOUT  File name: (nume fisier)  
 
65. INSERT  
 

Comanda INSERT se foloseste pentru inserarea in desen a 
unor blocuri definite anterior cu comanda BLOCK, sau a unor 
desene de pe disc (fisiere DWG). Daca exista un bloc si un fisier 
DWG cu acelasi nume, va fi inserat blocul.  
Sintaxa:     INSERT  Block name (or ?) <nume implicit>:  

Insertion point:  
X scale factor <1> / Corner / XYZ:  
Y scale factor (default = X):  
Rotation angle <0>:  

Scara pe X/Y poate fi specificata folosindu-se punctul de inserare 
ca punct de baza (coltul inferior stang) si un punct introdus pentru 
coltul opus (dreapta-sus). Noul punct se introduce ca raspuns la 
cererea "X scale factor". Normal, blocul este inserat ca o singura 
entitate (entitate complexa). Un bloc poate fi inserat ca un grup de 
entitati independente (explodat) prin introducerea caracterului "*" 
inaintea numelui sau (la "Block name"). In acest caz, va fi ceruta o 
singura scara (valabila atat pentru X, cat si pentru Y).  

Optiunea "XYZ" la cererea "X scale factor" va fi urmata de 
cererea a trei factori de scara:  
pentru X, Y si Z.  
Sintaxa:     INSERT  Block name (or ?) <nume implicit>:  

Insertion point:  
X scale factor <1> / Corner / XYZ:  XYZ  
X scale factor <1> / Corner:  
Y scale factor (default = X):  
Z scale factor (default = X):  
Rotation angle <0>:  
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66. ISOPLANE  
 

Comanda ISOPLANE permite selectarea planului de desenare 
curent (vedere de sus, laterala sau din fata).  
Sintaxa:     ISOPLANE  Left/Top/Right/(Toggle):  

Left - Plan definit de unghiuri intre axe de 150 si 90 de grade  
Top- Plan definit de unghiuri intre axe de 30 si 150 de grade  
Right - Plan definit de unghiuri intre axe de 30 si 90 de grade  
RETURN  - Trece la planul urmator (planele de mai sus sunt 

selectate prin rotatie)  
 

67. LAYER  
 

Un desen poate fi realizat in mai multe straturi suprapuse (ca 
si cand am avea mai multe desene pe calc, pe care le suprapunem). 
Gestionarea acestor straturi se face cu comanda LAYER.  
Sintaxa:     LAYER ?/Set/New/ON/OFF/Color/Ltype/Freeze/Thaw:  

?                     -  Listeaza straturile definite, cu tipurile de 
linii si culorile respective  

MAKE - Creeaza un nou strat, care devine strat de lucru  
SET - Stabileste stratul in care vom lucra in continuare  
NEW - Creeaza un strat nou  
ON - Face un strat vizibil (daca e invizibil)  
OFF - Face un strat invizibil  
COLOR - Atribuie stratului culoarea specificata  
LTYPE  - Atribuie stratului tipul de linie specificat  
FREEZE - Ignora stratul in timpul regenerarilor  
THAW  - Anuleaza com. FREEZE  
LTYPE ? - Listeaza tipurile de linie incarcate  
 

68. LIMITS  
 

Comanda LIMITS stabileste limitele desenului.  
Sintaxa:     LIMITS  

ON/OFF/Lower left corner <coltul implicit>:  
Upper right corner <implicit>:  
 

69. LINE  
 

Comanda LINE permite desenarea liniilor drepte.  
Sintaxa:     LINE  From point:  (se cere primul punct al liniei)  
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To point:  (urmatorul punct)  
To point:  (urmatorul punct)  
To point:  ...Enter la sfarsitul secventei de linii.  La "From 

point:" se asteapta introducerea primului punct al liniei. Fiind vorba 
de un punct, acesta poate fi indicat prin oricare din metodele 
cunoscute. Odata precizat primul punct, in zona de comenzi apare 
textul "To point:" Deplasarea colimatorului (in vederea "ochirii" celui 
de-al doilea punct) va fi insotita de trasarea unei linii elastice care 
sugereaza viitoarea linie. Precizand punctul, linia se traseaza ferm 
si este cerut: "To point:", care permite continuarea trasarii altor 
linii, conectate la prima. Incheierea acestui proces se face apasand 
Enter. Daca se apasa tasta "U", este stearsa ultima  
linie. Daca se introduce textul "CLOSE" (sau "C"), atunci se traseaza 
o linie din ultimul  
punct pana in primul, deci se inchide aria poligonala.  
 
70. LINETYPE  
 
Sintaxa :     LINETYPE  ?/Create/Load/Set:  

? - Listeaza tipurile de linii definite in fisierul specificat.  
Create - Se cer elementele necesare pentru a crea un fisier 

nou, cu definitii personale.  
Load - Precizati tipurile de linie pe care doriti sa le incarcati 

in memorie din diverse  
fisiere definite anterior.  

Set - Alegeti tipul de linie cu care veti lucra in continuare.  
Optiunea implicita BYLAYER se refera la tipul de linie definit in 
stratul respectiv. Se poate vedea cu comanda LAYER/?.  
Daca raspundeti BYBLOCK, noile obiecte vor fi desenate cu linie 
continua, pana cand vor fi grupate intr-un bloc. Cand va fi inserat 
blocul, tipul liniilor va fi cel definit inaintea crearii blocului.  
 
71. LIST  
 

Comanda LIST extrage din baza de date informatiile despre 
obiectele selectate, si le afiseaza pe ecran.  
Sintaxa:     LIST  Select objects:  (selecteaza)  
Daca lista e lunga, poate fi oprita cu CTRL-S ,sau abandonata cu 
CTRL-C. Pentru a o  
tipari utilizati CTRL-P.  
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72.  LOAD  
 

Comanda LOAD este folosita pentru a incarca un "shape" 
definit intr-o bibliotecã.  
Sintaxa:     LOAD  Name of shape file to load (or ?):  (nume fisier)  
Extensia implicita este ".shx". Daca se raspunde cu "?", va fi afisata 
lista fisierelor-bibliotecã incarcate in momentul  
respectiv.  
 
73.  LTSCALE  
 

Liniile intrerupte sunt formate din linii mai mici cu spatii 
intre ele. Cu comanda LTSCALE (Line Type SCALE) putem modifica 
lungimile liniilor si ale spatiilor.  
Sintaxa:     LTSCALE  New scale factor <factor curent>: noul factor 
de scara  

 
 

LISTA VARIABILELOR DE SISTEM AutoCAD CU EFECT ÎN 
COTARE 

 
Variabila Valoarea Funcţia 

DIMALT Off Permite folosirea unităţilor alternate 

DIMALTD1 2 Stabileşte numărul de zecimale al unităţilor alternate 

DIMALTF1 25.4 Indică factorul de conversie al dimensiunii liniare din 
unitatea de bază în cea alternată 

DIMAPOST1 - Memorează sufixul implicit pentru unitatea alternată 

DIMASO On Activează modificarea valorii cotei la modificarea 
dimensiunii elementului cotat 

DIMASZ 4.0 
, 

Determină dimensiunea săgeţii sau a blocului de capăt al 
liniei de cotă 

DIMBLK --- Indică numele blocului de capăt al liniei de cota (implicit, 
acest bloc este săgeata) 

DIMSlK12 - 
Indică numele blocului de la primul capăt al liniei de cotă, 
în cazul folosirii a 2 blocuri diferite la cele 2 capete ale 
acesteia 
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DIMBLK22 --.. 
Indică numele blocului de la al doilea capăt al liniei de 
cotă; în cazul folosirii a 2 blocuri diferite la cele 2 capete 
ale acesteia 

DIMCEN 2.0 

Memorează mărimea marcatorului de centru, pentru 
cercuri sau arce de cerc (semilungimea celor două linii 
perpendiculare plasate de AutoCAD în centrul cercului 
sau al arcului la folosirea opţiunii "center") 

DIMDLE 0.0 Indică lungimea cu care linia de cotă trece peste linia de 
extensie, (ajutătoare) 

DIMDLI 7.5 Memorează incrementul de distanţare a liniilor de cotă 
succesive la cotarea faţă de aceeaşi bază de referinţă 

DIMEXE 2.0 Stochează lungimea in u.d. cu care linia de extensie 
ajutătoare) depaşeşte linia de cotă 

DIMEXO 0.0 Stabileşte distanţa faţă de elementul cotat la care începe 
linia de extensie 

DIMLFAC 1.0 Memorează factorul de scală cu care AutoCAD 
înmulţeşte dimensiunile liniare măsurate 

DIMLIM3 Off Activă, permite scrierea concomitentă a valorii maxime şi 
minime a cotei 

DIMPOST - 

Memorează sufixul implicit pentru textul cotei; permite 
scrierea unor unităţi de măsură după valoarea cotelor, 
exceptând cotele unghiulare, la care programul scrie 
singur" unitatea de măsură pentru unghiuri setată prin 
comanda "UNITS:" 

DIMRND 0.0. Rotunjeşte la valoarea specificată dimensiunile 

DlMSAH Off Permite folosirea blocurilor diferite la cele două capete 
ale liniei de cotă pentru cotele liniare 

DIMSCALE 1.0000 Memorează un factor de scală care se aplică acelor 
elemente ale cotări ce au dimensiuni liniare 

DIMSE1 Off Suprimă desenarea primei linii de extensie (ajutătoare) 

DIMSE2 Off Suprimă desenarea celei de-a două linii de extensie  
ajutătoare) 

DIMSHO Off Activată, actualizează cotele în timpul tragerii dinamice 

DIMSOXC4 Off Suprimă săgeţile sau blocurile de capăt ale liniei de cotă 
plasate în exteriorul liniilor de extensie 

DIMTAD On Activată, plasează textul cotei deasupra liniei de cotă; 
dacă e dezactivată, linia de cotă este întreruptă pentru a 
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scrie textul cotei 

DIMTIH Off 
Activată, forţează scrierea orizontală a textului cotelor 
liniare de rază si de diametru; atunci când acesta este 
plasată în interiorul liniilor de extensie 

DIMTIX Off Activată, forţează plasarea textului în interiorul liniilor de 
extensie indiferent de spaţiul disponibil 

DIMTM5 0.0 Stochează valoarea abaterii inferioare la înscrierea 
toleranţelor dimensionale ale cotelor 

DIMTOFL On Activată, forţează trasarea liniilor de cotă în interiorul 
liniilor de extensie 

DIMTOH Off. Când este activată, forţeaza scrierea orizontală a textului, 
plasat in afară liniilor de extensie 

DIMTOL Off Permite scrierea toleranţelor după valoarea cotei 

DIMTP2 0.0 Stochează valoarea abaterii superioare la înscrierea în 
desen a toleanţelor dimensionale 

DIMTSZ 0.0 
La folosirea unor linii oblice delimitatoare, la intersecţia 
dintre, cea de extensie şi cea de cotă, indică mărimea în 
unităţi de desenare a liniei oblice delimitatoare 

DIMTVP6 0.0000 
Memorează, distanţa la care este plasat textul cotei faţă de 
linia de cotă dacă valoarea este negativă, textul cotei se va 
găsi, sub nivelul liniei de cotă 

DIMTXT 3.5 
Memorează înălţimea caracterelor cu care este scris texul 
cotei dacă nu a fost stabilită o valoare fixă la definirea 
stilului de scriere 

DIMZIN ,,' O Stabileşte detalii de afişare ale cotelor date în inch 

 
1 Activă numai când "dimalt” este activată 
2 Are efect numai când "dimsah" a fost activată 
3 Este in opoziţie cu "dimtol” 
4 Are efect numai când "dimtix" a fost activată 
5 Are efect numai dacă una din variabilele "dimtol" sau "dimlim" e 
activată 
6 Are efect numai dacă "dimtad" este dezactivată (Off) 
 
3. Să se realizeze în AutoCAD desenul  piesei de mai jos: 

Modul de lucru 
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1. Se lansează în execuţie sistemul AutoCAD şi se specifică 
numele noului desen care va fi realizat procedând aşa cum s-a 
arătat în lucrările anterioare. 

2. Apelând comanda LIMITS se stabilesc limitele spaţiului 
alocat prin perechile (0,0) şi respective (400,250), 

3: Cu comanda UCS, opţiunea Origin se stabileşte un sistem 
de coordanate ale utilizatorului, având originea în punctul de 
coordonate (90,100). 

Obs: Desenul fiind simetric pentru simplitate, se va realiza 
întâi partea de deasupra axei de simetrie şi apoi se va oglindi 
această faţă de axă. 

Ştiind că în desenul tehnic conturul exterior al unei flanşe de 
forma celei din figură se realizează racordând prin tangente comune 
arcele de rotunjire cu cercul de dimensiune maximă trasat în 
centrul geometric al flanşei pentru desenarea acesteia, se fac 
următoarele calcule: 
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Pentru simplitate se 

desenează mai întâi un sfert din 
flanşă urmând să fie obţinută 
prin oglindirea acesteia. 

 
 
 
4. Pentru a trasa conturul 

cu linie groasă, se foloseşte comanda PLINE cu care se trasează 
polilinii. Astfel: 

- se specifică punctul iniţial de coordonate (0,70), grosimea 
poliliniei de 0.4 (opţiunea Width) şi se comută polilinia în modul arc 
(opţiunea Arc); 

- pentru trasarea arcului AB, se mai specifică în continuare 
centrul (opţiunea CEnter) şi unghiul inclus (opţiunea Angle); 

- pentru trasarea segmentului de dreapta BC, tangent la 
arcul AB în punctul B, se comută polilinia in modul linie (opţiunea 
Line) şi se selectează opţiunea Lenght specificând lungimea h a 
segmentului; 

- trasarea arcului CD se realizează comutând din nou 
polilinia în modul arc (opţiunea Arc), specificând coordonatele 
centrului cercului din care face parte (opţiunea CE) şi punctul final 
(opţiunea End point of arc) prin coordonatele punctului D; 

- se încheie comanda PLINE. 
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5. Apelând comanda MIRROR, se oglindeşte desenul realizat 

la punctul anterior faţă de o axă verticală ce trece prin originea 
sistemului de coordonate utilizator, răspunzând negativ la cererea 
de ştergere a vechiului desen Delete old object<N>: 

6. Pentru a trasa gaura de fixare a flanşei ovale, cu Φ = 20, 
de aceeaşi grosime cu poliliniile anterioare, se poate folosi comanda 
DONUT, specificând pe rând diametrele 19.8 şi 20.2 şi centrul de 
coordonate (0,50). 

 

 
7. Cu comanda UCS, opţiunea Origin, se stabileşte un nou 

sistem de coordonate al utilizatorului, cu originea în punctul de 
coordonate (110,0), relativ la UCS-ul anterior. 

8. Apelând din nou comanda PLINE în modul linie, se 
trasează cele trei linii de deasupra axei de simetrie orizontale ale 
flanşei pătrate, neglijând arcele de racordare. 
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9. Pentru realizarea racordurilor, se apelează comanda 
FILLET; se specifică raza de racordare şi se repetă comanda" 
opţiunea Polyline, specificând polilinia de racordat. 

 
10. Tot cu comanda PLINE apelată de două ori, în modul 

linie, se realizează şi contururile laterale situate deasupra axei de 
simetrie ale ramificaţiei pe flanşe. 

11. Pentru a obţine liniile ce unesc capetele cu flanşele şi 
flanşele între ele, se trasează cu comanda PLINE o linie continuă 
groasă între punctele de coordonate:, (-170, 40) şi (60,40). 
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12. Cu comanda TRIM; se elimină segmentele care nu 
trebuie să aparţină desenului, din linia trasată anterior. 

 

 
 

13. Cu comanda MIRROR, se oglindeşte tot desenul realizat 
până în acest moment faţa de axa de simetrie orizontală. 

14. Cu comanda DONUT se trasează şi gaura cu Φ = 50 
pentru flanşa ovală, specificând pe rând diametrele 49.8 şi 50.2 şi 
centrul de coordonate (0,0). 

 



Lucrarea 12 

 290

 
Obs.: Pentru că nu se cunosc coordonatele centrelor găurilor 

de fixare ale flanşei pătrate, dar se cunoaşte raza cercului pe care 
sunt dispuse (45); se desenează o astfel de gaură pe axa Ox şi apoi 
se roteşte cu 450. 

 
15. Se repetă comanda DONUT specificând, pe rând, 

diametrele 19.9 şi 20.1 şi centrul în punctul de coordonate (57.5,0). 
16. Se realizează rotirea inelului plin cu unghiul de 450 faţă 

de origine, cu comanda ROTATE. 
17. Apelând comanda ARRAY, opţiunea POLAR, se 

realizează multiplicarea găurii de fixare prin dispunerea pe un cerc. 
Astfel, la cererea Center point of array: se specifică (0,0), la cererea 
Number of items. se specifică 4, iar la Angle to fill se specifică 360: 

18. Pentru trasarea arcelor de simetrie se setează tipul de 
linie numit DASHDOT, apelând comanda LINETYPE opţiunea LOAD 
şi apoi SET. 

19. Se repetă comanda LINE de trei ori pentru a trasa axele 
de simetrie orizontale, între limitele contururilor, pentru celelalte 
trei găuri de deasupra axei de simetrie generale. 

20. Cu comanda CIRCLE,- se trasează şi cercul pe care sunt 
dispuse găurile de fixare ale flanşei pătrate. 

21. Pentru a adapta tipul de linie DASHDOT la scara 
desenului, se apelează comanda. LTSCALE specificând valoarea 15 
pentru noul factor de scală. 
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22. Pentru fiecare din cele 4 axe de simetrie orizontale 

trasate, se modifică factorii de scală în raport cu punctele de mijloc, 
pentru a obţine o aceaşi depăşire a contururilor de către axele de 
simetrie. În acest scop, se apelează de 4 ori comanda SCALE, 
specificând de fiecare dată, ca punct de bază, mijlocul segmentului 
respectiv (cu modulul OSNAP MIDpoint), selectând opţiunea 
Reference. Se vor indica pentru lungimile de referinţă şi pentru 
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noile distanţe valori astfel încât, noua lungime să fie egală cu cea de 
referinţă plus 8 unităţi. 

23. Cu comanda MIRROR, se oglindesc cele trei axe ale 
găurilor faţă de axă de axa Ox. 

24.Cu comanda LINE se trasează şi axele de simetrie 
verticale ale celor două flanşe. 

25. Se realizează scalarea celor două axe, ca la punctul 22. 

 
26. Se realizează cotarea întregului desen. 

 
27. Se salvează desenul cu comanda END. 
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LUCRAREA 13 EXERCIŢII RECAPITULATIVE 

 
 
 

13.1. Exerciţii recapitulative 
 
Exerciţiul 13.1. 
Să se realizeze desenul piesei din figura 13.1., folosind 

comenzile de desenare şi editare AutoCAD, cu gruparea diferitele 
informaţii grafice pe layere. 

 
Fig. 13.1 Flanşa elipsoidală 

 
1. Se începe un desen nou selectând New, şi la apariţia 

ferestrei Create New Drawing se optează pentru Use a Wizards cu 
varianta Quick Setup. Se va alege Decimal pentru unităţile de 
măsură şi dimensiunile corespunzătoare unui format A3 (420 x 
297) pentru limitele desenului. 
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2. Folosind comanda Layer, diferitele elemente ale desenului 

vor fi grupate pe straturi. Fiecărui strat (layer) creat i se poate 
asocia o anumită culoare, un anumit tip de linie şi o anumită 
grosime a liniei. Astfel, pentru realizarea următorului desen 2D se 
vor defini următoarele layere (fig. 13.2). 

 
Command: layer  
 

 
 

Fig. 13.2. Caseta de dialog pentru definirea layer-lor 
 
3. Cu comanda Ucs şi opţiunea O(rigin), se va defini un nou 

UCS, cu originea în punctul unde va fi amplasat desenul în cadrul 
formatului ales, astfel: 

Command: ucs 
Enter an option [New/Move/.../?/World/] <World>: n  
Specify new origin point <0, 0, 0>: (punct la alegere cu click) 
 
4. Setând layerul Contur ca layer curent, se trasează, pentru 

început, cele două elipse ce definesc conturul geometric al piesei. 
De la prompter-ul "Command:", se lansează comanda Ellipse sau se 
acţionează butonul specific din toolbar-ul Draw. 

Command: ellipse 
Specify axis endpoint of ellipse or [Arc/Center]: c 
Specify center of ellipse: 0,0 
Specify endpoint of axis: 100,0 (semiaxa mare) 
Specify distance to other axis or [Rotation]: 0,70 (semiaxa 

mică). 
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5. Pentru trasarea elipsei ce formează conturul interior al 
piesei se foloseşte succesiunea de comenzi anterioară . 

6. Se setează stratul Axe ca layer curent şi folosind comanda 
Line, cu ajutorul modurilor Grid [F7] şi Snap [F9], se trasează axele 
de simetrie ale piesei. Se revine ca layer curent, la Contur. 

7. În continuare vom desena cercurile, succesiunea de 
comenzi fiind: 

Command: circle (sau c) 
Spec. center p. for circle or [3P/2P/Ttr (tan tan radius)]: 0,0 
Spec. radius of circle or [Diameter]: 15 (raza cercului) 
Enter  
(se repetă comanda, pentru a trasa cercurile de rază 25 şi 30)  
Enter  
Spec. center p. for circle or [3P/2P/Ttr (tan tan radius)]: 65,0  
Specify radius of circle or [Diameter]: 10 
Enter 
(se repetă comanda, pentru a trasa cercurile de rază 15) 
Enter  
(se repetă comanda, pentru a trasa cercurile din stânga,) 
Enter 
Spec. center p. for circle or [3P/2P/Ttr (tan tan radius)]: 0,-40 
Specify radius of circle or [Diameter]: 5 (raza cercului) 
Enter 

 
Spec. center p. for circle or [3P/2P/Ttr (tan tan radius)]: 0,-40  
Specify radius of circle or [Diameter]: 8 
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Enter  
(se repetă comanda, pentru a trasa cercul de sus) 

 
 
8. Se desenează grosimea braţelor de sus şi de jos. Se va 

folosi comanda Offset după cum urmează: 
Command: offset 
Specify offset distance or [Through] <15.0000> : 8 
Select object to offset or <exit>: (se selectează axa verticală 

care trece prin originea UCS-ului) 
Specify point on side to offset: (se selectează un punct în 

partea dreaptă a axei) 
Enter (se repetă comanda pentru cealaltă jumătate, din 

partea stângă.) 
 

 
Observaţie: Cele două segmente anterior create se află ca şi 

axa pe care am folosit-o ca referinţă pe layerul “Axe”. Modificăm 
layer-ul pe care am desenat segmentele prin selectarea lor şi 
alegerea din meniul Object Properties a layer-ului “Contur”. 
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8. Pentru realizarea racordărilor dintre muchiile conturului 
interior, se lansează în execuţie comanda Fillet. Se stabileşte mai 
întâi raza de racordare şi variabila No trim apoi, prin repetarea 
comenzii, se indică elementele care vor fi racordate, după cum 
urmează: 

Command: fillet 
Select first object or [Polyline/Radius/Trim]: r 
Enter fillet radius <0.000>: 10 
Select first object or [Polyline/Radius/Trim]: (se selectează 

primul element)  
Select second object: (se selectează al doilea element) 
Enter (se repetă comanda pentru restul racordărilor) 

 
9. În continuare, se vor elimina anumite porţiuni din 

elementele desenate. Se va folosi comanda Trim. 
Command: trim 
Select cutting edges...Select objects: (se selectează toate  

muchiile ca elemente tăietoare apăsând Enter) 
Select objects to trim or [Project/Edge/Undo]: (se selectează 

elementul care va fi tăiat)  
Enter (se repetă comanda pentru toate elementele în plus 

ajugându-se la desenul de mai jos) 
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10. Finalizarea desenului se face prin adăugarea cotelor şi 

dimensiunilor pe desen. 
 
Exerciţiul 13.2.  

 
Fig. 13.3. Modelul virtual secţionat, spre a vizualiza configuraţia geometrică 

interioară şi desenul piesei pentru aplicaţia rezolvată 
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Să se realizeze desenul piesei din fig. 13.3. (reprezentată în 

trei proiecţii ortogonale - vedere din faţă, vedere de sus şi secţiune 
laterală), folosind comenzile de desenare şi editare AutoCAD, cu 
gruparea diferitelor informaţii grafice pe layere. 

1. Se începe un desen nou selectînd New, şi la apariţia 
ferestrei Create New Drawing se optează pentru Use a Wizards cu 
varianta Quick Setup. Se va alege Decimal pentru unităţile de 
măsură şi dimensiunile corespunzătoare unui format A3 (420 x 
297) pentru limitele desenului. 

2. Folosind comanda Layer, diferitele elemente ale desenului 
vor fi grupate pe straturi (fig. 13.4.), astfel: 

 

 
 

Fig. 13.4. Caseta de dialog pentru definirea 1ayer-1or 
 
3. Cu comanda Ucs şi opţiunea O(rigin), se va defini un nou 

UCS, cu originea în centrul cercurilor concentrice, astfel: 
Command: ucs 
Enter an option [New/Move/.../?/World/] <World>: n  
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Specify new origin point <0, 0, 0>: 100,130 
 
4. În continuare vom desena cercurile. După ce setăm stratul 

Contur ca strat curent succesiunea de comenzi ca fi: 
Command: circle (sau c) 
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 

0,0 
Specify radius of circle or [Diameter]: 15 (raza cercului) 
Enter  
(se repetă comanda, pentru a trasa cercurile de rază 20 şi 30)  
Enter  
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 

0,5  
Specify radius of circle or [Diameter]: 35 
 
5. Se trasează dreptunghiul piesei.  
Command: rectangle  
Specify first corner point or [...]: -70,-45 şi apoi Enter 
Specify other corner point or [Dimensions]: 70,-20 (colţul 

opus) şi apoi Enter 

 
 
6. Se rotunjesc colţurile dreptunghiului cu comanda Fillet 
Select first object or [Polyline/Radius/Trim]: r 
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Enter fillet radius <0.000>: 10 
Repeat comanda Fillet: 
Select first object or [Polyline/Radius/Trim]: (se selectează 

primul element)  
Select second object: (se selectează al doilea element) 
Enter (se repetă comanda pentru al doilea colţ cu valoarea 

R10) 
7. În continuare, se vor elimina porţiunile din cercul exterior 

şi dreptunghi. Se va folosi comanda Trim. 
Command: trim 
Select cutting edges...Select objects: (se selectează elementele 

tăietoare) şi apoi Enter  
Select objects to trim or [Project/Edge/Undo]: (se selectează 

elementele care vor fi tăiate din cerc şi dreptunghi)  
Enter (se repetă comanda pentru toate elementele ce trebuie 

eliminate ajugându-se la desenul de mai jos). 
8. Pentru realizarea racordărilor dintre cercul exterior şi 

dreptunghi, se lansează în execuţie comanda Fillet. Se stabileşte 
mai întâi raza de racordare şi apoi, prin repetarea comenzii, se 
indică elementele care vor fi racordate, după cum urmează: 

Command: fillet 
Select first object or [Polyline/Radius/Trim]: r 
Enter fillet radius <0.000>: 5 
Select first object or [Polyline/Radius/Trim]: (se selectează 

cercul exterior)  
Select second object: (se selectează dreptungiul) 
Enter (se repetă comanda pentru al doilea  colţ ) 
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9. În continuare, se trasează ruptura şi gaura cu comanda 

Line. 
Folosind comanda Offset (faţă de liniile existente), se trasează 

toate elementele ce definesc conturul găurii din ruptură. 
Command: offset 
Specify offset distance or [Through]<l.000>: 47 
Select object to offset or <exit>: (axa principală a piesei)  
Specify point on side to offset: (se indică un punct în stânga 

axei)  
Se redimensionează axa găurii folosind manipulatoarele şi cu 

OTrack activat (în bara de jos). 
Specify offset distance or [Through]<l.000>: 8 
Select object to offset or <exit>: (se selectează axa găurii)  
Specify point on side to offset: (se indică un punct în stânga 

axei)  
Select object to offset or <exit>: Enter 
Enter 
Specify offset distance or [Through]<8.000>: Enter 
Select object to offset or <exit>: (se selectează axa găurii)  
Specify point on side to offset: (se indică un punct în dreapta 

axei)  
Select object to offset or <exit>: Enter 
Enter (se repetă operaţiile modificând offset distance la 6 şi 

apoi 4 pentru a trasa liniile verticale) 
Enter 
Specify offset distance or [Through]<8.000>: 3 
Select object to offset or <exit>: (se selectează linia inferioară 

a dreptunghiului)  
Specify point on side to offset: (se indică un punct în 

interiorul dreptunghiului )  
Select object to offset or <exit>: Enter 
Enter (se repetă operaţiile modificând păstrând offset distance 

la 3 pentru a trasa linia orizontală superioară). 
Toate elementele create în această etapă (mai puţin axa 

găurii) se vor trece pe layer-ul contur. 
După această etapă desenul va fi ca cel de mai jos. 
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10. În continuare, se vor elimina segmentele inutile pentru a 

contura gaura. Se va folosi comanda Trim. 
Command: trim 
Select cutting edges...Select objects: (se selectează elementele 

tăietoare toate segmentele de dreaptă) şi apoi Enter  
Select objects to trim or [Project/Edge/Undo]: (se selectează 

segmentele care va fi şterse; se foloseşte Zoom Window şi Zoom 
Previous)  
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11. Cu comanda spline se trasează o curbă corespunzătoare 
rupturii (o curba serpuită fără dimensionare exactă). 

12. Se realizează haşura rupturii. 
Command: Hatch 
În fereastra Boundary Hatch selectăm tipul de haşură ANSI 

31. 
Selectăm cu Pick Point suprafaţa ce va fi haşurată şi apoi 

Enter  şi OK. 
Repetăm comanda pentru cea de a doua suprafaţă. 

 
 
13. Cu comanda line şi folosind comanda OSNAP şi Offset 

vom trasa toate celelalte axe de simetrie pe care le vom trece în 
layerul Axe. 

 
14. Pentru o mai bună vizualiyare a axelor vom modifica 

scalarea liniilor punct cu comanda Ltscale setată pe 0.4. 
 
15. Pentru atrasa vederea de sus vom folosi filtrele de 

coordonate .x, .z, .xz, .yz, etc. 
Command: line 
Specify first point: .x 
of: end (punctul stânga jos al vederii din faţă, îi preia 

coordonata x) 
of (need YZ): un punct oarecare sub desenul anterior 
Specify next point or [Undo]: .x 
of: end (punctul dreapta jos, îi preia coordonata x) 
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of (need YZ): un punct oarecare pe linia trasată cu comanda 
ORTHO activă 

Specify next point or [Undo]:@ 0,25 
Specify next point or [Undo]: .x 
of: end (punctul stânga jos, îi preia coordonata x) 
of (need YZ): un punct oarecare pe linia trasată cu comanda 

ORTHO activă 
Specify next point or [Undo]: c (se închide conturul cu 

comanda close). 
 
16. Se trasează segmentele verticale şi axele de simetrie 

preluând coordonatele cu filtrele de coordonate. 
 
17. Se desenează cercurile din stânga cu razele de 8, 6 şi 4 şi 

apoi cu comanda Mirror le desenăm şi în dreapta. 
 
18. Pentru atrasa vederea laterală vom folosi filtrele de 

coordonate .x, .z, .xz, .yz, etc. 
Command: line 
Specify first point: .y 
of: end (punctul dreapta jos al vederii din faţă, îi preia 

coordonata y) 
of (need XZ): un punct oarecare 
Specify next point or [Undo]: @ 25,0 
Specify next point or [Undo]: .y 
of: end (punctulextrem de sus al piesei, îi preia coordonata y) 
of (need XZ): un punct oarecare pe linia trasată cu comanda 

ORTHO activă 
Specify next point or [Undo]:@ -25,0 
Specify next point or [Undo]: c (se închide conturul cu 

comanda close). 
 
29. Se trasează segmentele orizontale şi axele de simetrie 

preluând coordonatele cu filtrele de coordonate. 
 
20. Cu comanda Offset trasăm toate liniile la offset distance 

corespunzătoare desenului apoi cu comanda Trim ştergem toate 
segmentele în plus. 
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21. Se selectează layer-ul Haşuri. Urmează haşurarea 
suprafeţelor rezultate în urma secţionării piesei. Haşurarea constă 
în umplerea cu un anumit model a unui contur închis şi se 
realizează folosind comanda Bhatch. Comanda permite atât 
stabilirea parametrilor de haşurare (prin opţiunile Pattern, Angle şi 
Scale) cît şi specificarea conturului supus haşurării (prin opţiunea 
Pick Points), totul prin intermediul unei casete de dialog. 

 
Command: bhatch  
 

 
 
22. Ultima etapă a reprezentării secţiunii prin piesă este 

indicarea traseului de secţionare. Acesta se termină prin două 
segmente groase, situate în afara conturului proiecţiei. Pe fiecare 
din segmente se sprijină o săgeată ce indică direcţia privirii, iar 
notarea traseului se face cu litere majuscule scrise lîngă săgeată şi 
deasupra proiecţiei. Pentru trasare se folosesc comenzile Pline şi 
Dtext. 

 
23. Odată definit stilul de cotare, se poate trece la înscrierea 

efectivă a cotelor, operaţie efectuată pe layer-ul Cote. 
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13. 2. Exerciţii propuse pentru testarea cunoştinţelor 
accumulate 

Exerciţiul 13.2.1. 
 

 
 

Exerciţiul 13.2.2. 
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Exerciţiul 13.2.3. 

 
 

Exerciţiul 13.2.4. 
 

 



Exerciţii recapitulative 

 309 

Exerciţiul 13.2.5. 

 
 
Exerciţiul 13.2.6. 
 
Desenaţi tija de centrare cu mânere drepte din figurile de mai jos. 
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Exerciţiul 13.2.7. 
 
Desenaţi flanşa cu element de legătură din figurile de mai jos. 
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Exerciţiul 13.2.8. 
 
Desenaţi flanşa din figurile de mai jos. 
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Exerciţiul 13.2.9. 
 
 
Desenaţi roata dinţată din figurile de mai jos. 
 

 
 
 
 

 
 
 
 
 
 
 
 



Exerciţii recapitulative 

 313 

Exerciţiul 13.2.10. 
 

Desenaţi braţul cu element de legătură din figurile de mai jos. 
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Exerciţiul 13.2.11. 
 
Desenaţi bucşa de centrare ovală din imaginea de mai jos 
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Exerciţiul 13.2.12. 
Desenaţi brida în formă de L în două vederi, ca mai jos. 
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